IBM Application Discovery for IBM Z Analyze
V5.1.0

User Guide
## Contents

**Chapter 1. Accessibility Features for IBM Application Discovery for IBM Z**

- IBM AD High-Level Architecture Overview .................................................. 4
- Terms And Conventions.................................................................................. 5

**Chapter 2. Introduction**

- Terms And Conventions.............................................................................. 5

**Chapter 3. Preferences**

- Environment Settings.................................................................................. 7
- Eclipse Settings............................................................................................. 8
- Local Settings............................................................................................... 8
  - Annotation Settings.................................................................................. 8
  - Cross Analysis......................................................................................... 8
  - External Libraries..................................................................................... 9
  - Explorer for z/OS..................................................................................... 9
  - General Settings....................................................................................... 9
  - Imports Analysis Options......................................................................... 11
  - License Agreement.................................................................................... 11
  - Limits and Restrictions............................................................................ 11
  - Local Database Settings......................................................................... 21
  - Reports Settings....................................................................................... 21
  - Rules Based Analysis Settings................................................................. 22

**Chapter 4. IBM AD Analyze Client Reference**

- AD Perspectives Common Elements............................................................. 23
- Application Discovery Analysis Perspective............................................... 26
- Application Discovery Browser Perspective............................................... 28
  - AD Explore Tab........................................................................................ 29
  - AD Graphs Tab......................................................................................... 39
  - AD Usage Analysis Tab............................................................................ 42
  - AD Reports Tab....................................................................................... 44
- Annotations................................................................................................. 45
  - Annotations Overview.............................................................................. 45
  - Adding an Annotation............................................................................... 46
  - View Annotations..................................................................................... 47

**Chapter 5. Using IBM AD Analyze Client**

- Overview..................................................................................................... 49
- Projects, Folders, and Files......................................................................... 49
- Tasks............................................................................................................ 49
  - Creating an AD Java Project................................................................... 50
  - Creating a Mainframe Project.................................................................. 55
  - Importing a Shared Project from AD Analyze Server............................... 55
  - Working With Resources From Remote Systems...................................... 57
  - Checking the Connection to the Project Database.................................... 61
  - Building an AD Java Project................................................................... 62
  - Analyzing a Project.................................................................................. 62

**Chapter 6. Graphs**

- Mainframe Graphs and Layouts................................................................. 63
- A-AUTO Graph........................................................................................... 63
Chapter 1. Accessibility Features for IBM Application Discovery for IBM Z

Accessibility features assist users who have a disability, such as restricted mobility or limited vision, to use information technology content successfully.

Overview
IBM® Application Discovery for IBM Z® includes the following major accessibility features:

- Keyboard-only operation
- Operations that use a screen reader

IBM Application Discovery for IBM Z uses the latest W3C Standard, WAI-ARIA 1.0 (www.w3.org/TR/wai-aria/), to ensure compliance with US Section 508 (www.access-board.gov/guidelines-and-standards/communications-and-its/about-the-section-508-standards/section-508-standards) and Web Content Accessibility Guidelines (WCAG) 2.0 (www.w3.org/TR/WCAG20/). To take advantage of accessibility features, use the latest release of your screen reader and the latest web browser that is supported by IBM Application Discovery for IBM Z.

The IBM Application Discovery for IBM Z online product documentation in IBM Knowledge Center is enabled for accessibility. The accessibility features of IBM Knowledge Center are described in the Accessibility section of the IBM Knowledge Center help (https://www.ibm.com/support/knowledgecenter/en/about/releasenotes.html).

Keyboard navigation
This product uses standard navigation keys.

Interface information
For alternative installation using Command Line Installation (CLI), refer to section Alternative Installation for ADDI Using CLI in IBM AD Installation and Configuration Guide.

The IBM Application Discovery for IBM Z user interfaces do not have content that flashes 2 - 55 times per second.

The IBM Application Discovery for IBM Z web user interface relies on cascading style sheets to render content properly and to provide a usable experience. The application provides an equivalent way for low-vision users to use system display settings, including high-contrast mode. You can control font size by using the device or web browser settings.

The IBM Application Discovery for IBM Z web user interface includes WAI-ARIA navigational landmarks that you can use to quickly navigate to functional areas in the application.

Related accessibility information
In addition to standard IBM help desk and support websites, IBM has a TTY telephone service for use by deaf or hard of hearing customers to access sales and support services:

TTY service
800-IBM-3383 (800-426-3383)
(within North America)

For more information about the commitment that IBM has to accessibility, see IBM Accessibility (www.ibm.com/able).
Chapter 2. Introduction

This section provides a high level description of **IBM Application Discovery for IBM Z (AD) Analyze** product, presents the structure of the user guide and provides reference to the location of the installation info.

**Background**

Much of the world’s software is legacy code that, for the most part, is stable and reliable and still supports the core business functions for which it was originally developed. Insofar as these programs refer to business-related processing, they are still relevant but require change in accordance with ongoing requirements.

Moreover, with the development of the Internet, e-commerce, and new hardware and operating systems, the need has arisen to modernize business applications by implementing new interface standards, online transaction processing over the Web, and improved database handling methods. Some legacy systems need to be replaced by new applications that use the latest design methodologies and languages.

To support the activities described above, software tools have been developed which are able to analyze the legacy system and aid in maintaining existing programs. At the same time these tools provide critical information needed in order to generate new programs that are architecturally sound and which utilize modern design methods. Furthermore, they capitalize on the fact that, for the most part, the business processing functions of the legacy system - the business rules - will still be valid for the new application.

**IBM Application Discovery for IBM Z Analyze**

**IBM Application Discovery for IBM Z Analyze** or simply **IBM AD Analyze** is an application portfolio management product for legacy applications, which provides understanding capabilities, impact analysis, control and data flow analysis, graphical and alphanumeric reports along with a database repository. Its main functions include the following:

- Analysis of all components of a system to determine its structure and the relationships between, among and within program entities and the system and its components. The results of this analysis are stored in a data repository and can be examined by means of graphical displays and textual reports. Data in this repository serves as a basis for further analysis and synthesis.
- Mining of the code to discover business rules of the application.

The standard edition of **IBM AD Analyze** can process projects developed in the following languages: ADS, ADS/O, Assembler, COBOL dialects (Cobol II, VSE Cobol, Cobol 400®, Fujitsu Cobol, DT Cobol etc.), CL, DDCL, JAVA®, Natural, PL/I and SCL.

**IBM AD Analyze** has a client component and a server component.

**IBM AD Analyze** is part of **IBM AD** suite of products. For details on IBM Application Discovery for IBM Z architecture, see **IBM Application Discovery for IBM Z High Level Architecture Overview**.

**Requirements**

For a complete list of requirements and supported environments please see **IBM AD Installation Prerequisites** document.

**About this guide**

The objective of this guide is to provide the information needed to use **IBM AD Analyze** and to understand its capabilities.

This guide includes a description of the sequence of steps and procedures typically followed in **IBM AD Analyze Client** to set up and analyze a system and to view the results. It also contains a detailed description of the interface as well as a presentation of the **Server Manager** application.
Installation
For instructions on how to install IBM AD Analyze, see the IBM AD Installation and Configuration Guide.

IBM AD High-Level Architecture Overview

The following diagram illustrates IBM Application Discovery for IBM Z high-level architecture and the relationships among the different components of the suite.

Figure 1: IBM AD high-level architecture

Following is a brief description of the relationships among the different components of IBM AD.

**IBM AD Configuration Server** ensures the consistency of the installation parameters throughout an installation and allows the system administrator to manage user access to workspaces.

**IBM AD Build** - uses data from mainframe systems to build projects.

**IBM AD Build** - uses project sources that are brought from z/OS®. Performs a compilation/build process and stores the analysis data to the repository.

**IBM AD Validation Service** - works with ChangeMan SCM only. Provides coding rule enforcement via synchronization with ChangeMan and upon member staging.

**IBM AD GraphDB Service** - starts the OrientDB server so that IBM AD Analyze can connect to OrientDB repository and use the data found there to generate the graphs.

**IBM AD Batch Server** - imports data from the relational database repository into the GraphDB (OrientDB) repository. It also automates processes such as report generation and indexing. Manages several critical clients' configurations such as the creation of the annotations database and the reports configuration, which must be performed before starting IBM AD Analyze Client.
IBM AD Analyze - analyzes mainframe projects (from IBM AD Build) and other types of projects (Java™, C, etc.) and displays the results of the analysis in graphs, in reports, or in Usage analyses.

IBM AD Analyze Client - runs as a plug-in on Eclipse or IDz and provides project analysis via graphs reports and usage views. When the analyzed application sources are coming from Endevor, it allows viewing source code per user based on Endevor permissions that are checked via z/OS Explorer/CARMA interface.

IBM AD Web Service - collects the data that is provided by Web Service Metrics component and prepares it for delivery.

Web Service Metrics - component generates input data for IBM AD Web Service.

IBM AD REST API - provides IBM AD data for IBM ADI Business Rule Discovery (BRD).

Terms And Conventions

The following terms and conventions are used:

• Commands are printed as shown.
• Chapter references are indicated as shown. For page numbers, refer to the Table of Contents.
• File references are printed as shown.
• Button names and options/functions within a dialog box are printed as shown.
Chapter 3. Preferences

To customize the way IBM AD Analyze works, use the options available under Application Discovery in the Preferences dialog window of your Eclipse client.

To access these settings, go to IBM AD Analyze Client and then select Window > Preferences > Application Discovery.

In the Preferences dialog window, under Application Discovery, two main sections are available:

• **Environment settings**, which are global settings specified in IBM AD Configuration Server, from a Web interface. These settings affect all users of IBM AD Analyze and can be modified at any time from IBM AD Configuration Server. All the global parameters have their local counterparts. The local parameters are only taken into account if Allow Overwrite option is checked in IBM AD Configuration Server. See the following sections for details.

• **Local settings**, which allow the user to customize the way different areas of the product (Graphs, Reports, Usage, and so on) work on the local machine.

**Note:** Certain parameters from the Local settings section will only be taken into account if Allow overwrite option is selected in IBM AD Configuration Server. For details, see IBM AD Configuration Server User Guide.

**Note:** The parameters available in the Preferences section depend on the version of IBM AD purchased.

The settings available in these sections are described in the following chapters.

Environment Settings

When dealing with a suite of applications that work together over a network, a problem that arises often is how to identify applications that belong to separate installations. Simply deploying every parallel installation to separate networks is not always possible, therefore, the applications from an installation must be able to locate each other and the shared resources without interfering with applications from other installations. In the context of IBM AD such an installation is called "environment".

An "environment" is defined in IBM AD Configuration Server. For each environment a default workspace and a default blank configuration are created and then automatically attached. A workspace is a collection of projects to which the administrator can grant access to the users of IBM AD. A configuration holds the installation parameters for the server components and the databases that IBM AD uses. It also stores global parameters for Reports and Rule based reports.

In order to work correctly with the rest of the components from the same installation, IBM AD Analyze needs to access the environment information. It is automatically made available to IBM AD Analyze by IBM AD Configuration Server.

To access the Environment settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Environment settings.

The following information is available:

• **Host**, displays the host name or the IP address of the computer where IBM AD Configuration Server is installed.

• **Port**, displays the communications port for IBM AD Configuration Server.

• **Unique id**, displays the unique id assigned by IBM AD Configuration Server to the current environment.

• **Name**, displays the name of current environment, as defined in IBM AD Configuration Server.

**Note:** Make sure that the hostname or IP address, and the communications port displayed here are the ones set when you installed IBM AD Configuration Server. Also, make sure that the environment name
and the unique ID displayed here are the ones associated to the environment you defined in IBM AD Configuration Server.

A list of links to the global settings for each IBM AD component is available. Click these links to view the global settings for each component.

## Eclipse Settings

Eclipse has two available settings: **Global Settings** and **Local Settings**:

1. **The Global Settings** are the settings that come from **Configuration Server** (set by the user in Environment > Configurations). To use the **Global Settings**, enter the **Environment ID** in Global Settings and restart **Eclipse**. After restart a pop-up window is displayed informing you that fields under **Global Settings** are updated. Click OK and restart **Eclipse** again. All the fields under **Global Settings** will be populated with the information from **Configuration Server**.

2. To use the **Local Settings**, first verify in **Configuration Server** if this action is allowed or not. In order to do this goto **Configuration Server**, and under each menu from **Configurations**, click the **Allow Overwrite** checkbox.

**Note:**

- If **Allow Overwrite** is not checked in **Configuration Server Web Admin**: the values set in **Configuration Server** are displayed in **Eclipse** under **Global Settings**. If the user sets up some values for the **Local Settings**, they are not taken into consideration.

- If **Allow Overwrite** is checked in **Configuration Server Web Admin**: the values set in **Configuration Server** are displayed in **Eclipse** under **Global Settings** (if configured). If the user sets up some values for the **Local Settings**, they are taken into consideration and used in **Analyze Client**.

If **Allow Overwrite** checkbox allows you to use the local settings, you can set them under **Eclipse**.

## Local Settings

Use these settings to customize the way **IBM AD Analyze** works on the local computer.

### Annotation Settings

**Note:** These settings are only relevant for Java projects.

Use **Annotations Settings** to configure the way annotations are managed in Java projects.

To access **Annotations Settings**, go to **IBM AD Analyze Client** and select Window > Preferences > Application Discovery > Local settings > Annotations settings. The following options are available, both are selected by default.

- **Automatically manage orphan annotations**, select this option to allow **IBM AD Analyze Client** to manage annotations that are no longer attached to a resource. If this option is selected, if a **Clean and Build Project** is performed, the user can recover all annotations for all project resources. If this option is disabled, if a **Clean and Build Project** is performed, annotations can no longer be recovered.

**Note:** To view orphan annotations, goto **Application Discovery** and select **Annotations > Orphan Annotations**.

- **Show replies in annotation report**, select this check box to include in **Annotations Report** the replies that were made to annotations.

### Cross Analysis

**Note:** This setting is only relevant for **Cross Applications Analysis** graphs, which are generated starting from Java projects.

Use **Cross Analysis preferences** to customize the way the **Cross Analysis** graphs are generated.
To access Cross Analysis options, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Cross Analysis. The WSBind Mapping option is available. For more information, see “WSBind Mapping” on page 9.

**WSBind Mapping**

Use WSBind Mapping preferences to select the storage location for WSBind files.

**Note:** This setting is only relevant for Cross Applications Analysis graphs, which are generated starting from Java projects.

To access WSBind Mapping options, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Cross Analysis > WSBind Mapping.

The WSBind Mapping option is available. A list of locations where WSBind files are stored is displayed.

**Note:** This setting is relevant for the cases where the cross analysis is performed by using the Web Services option. This setting specifies the location where WSBind files are stored.

Use Add to set a folder where the WSBind files are stored, use Remove to delete the selected location. Click Restore defaults to go back to the default settings. Make sure to click Apply after changing the parameters.

**External Libraries**

Use External Libraries to set the path to the external libraries, which are needed to generate the cross analysis.

To access the External libraries options, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > External libraries.

In External libraries tab, click Browse to set the paths to each of the external libraries.

**Explorer for z/OS**

Use Explorer for z/OS to set the option for displaying the Application Discovery Browser perspective when an Application Discovery analysis is generated.

To access the Explore for z/OS options, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Explorer for z/OS.

In the Explorer for z/OS tab, the option Prompt is selected by default.

**General Settings**

Use General Settings to set the connection parameters for the IBM AD Analyze Client and Server and OrientDB components. Several other parameters can also be set.

To access the general settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > General Settings. The following general settings are available:

- **Log folder**, the default path to the log folder is displayed. Use Browse to set the path to the folder where the IBM AD Analyze Client log files are saved.
- **Temporary folder**, the default path to temporary folder is displayed. Use Browse to set path to the folder where the IBM AD Analyze Client temporary files are saved.
- **Enable easy log4j configuration syntax**, this option is selected by default and it determines Reload log configuration to use LogConfigurator.properties file instead of the default log4j.properties. When editing the default log4j.properties file, make sure that you use log4j syntax. For more information on LogConfigurator.properties and log4j.properties files, see Appendix 3: Log Configuration Files Examples.

Click Reload Log Configuration to reload the log configuration file, from where you set the level of detail you want to generate about errors.

For more information about General Settings, see the next paragraphs.
Catalog Settings
Use the Catalog Settings page to override the settings for the connection to AD Catalog Web Service set into CCS environment.

To access the Catalog Settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > General Settings > Catalog Settings.

Allow overwrite: if left unchecked, the global settings will be used. If checked, the following parameters must be manually configured:

- Host.
- Port.
- Protocol.
- Authentication.

Client Settings
Use Client Settings to set the IP and communications port of the computer where the IBM AD Analyze Client is installed.

To access the Client settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > General Settings > Client Settings.

IBM AD Analyze Client automatically detects all IP addresses. From the available choices, select the IP of the client you want to use for client/server communication. Select the check-box to manually enter the client IP. If you install IBM AD Analyze Client on a notebook, use the local host IP address, 127.0.0.1.

Port field displays the default value for communications port.

OrientDB Settings
Use OrientDB Settings to view or set the details of the connection with the graph database.

Note: These settings are only relevant if an OrientDB is installed.

OrientDB or the graph database is a container of control flow information that is used for control flow analysis and the management of dynamic calls resolution. The resolution mechanism is used for showing existing dynamic calls and their solutions (whether manual or automatic).

To access the OrientDB settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > General settings > OrientDB settings.

If Allow overwrite option is checked in IBM AD Configuration Server for the OrientDB (GraphDB) settings, IBM AD Analyze users can select Overwrite global configuration and proceed to change the OrientDB settings for their local workstations.

If Allow overwrite option is not checked in IBM AD Configuration Server, only the global settings are taken into account.

Test connection allows the user to test the connection with the OrientDB database.

Server Settings
Use Server settings to view or select the IBM AD Analyze Server that the current IBM AD Analyze Client uses. Several servers can be added.

To access the Server settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > General settings > Server Settings.

By default, a list of Analyze servers is displayed as configured in IBM AD Configuration Server at installation time.

If Allow overwrite option was checked in IBM AD Configuration Server for the Analyze Servers settings, IBM AD Analyze users can select Overwrite global configuration and proceed to change the Analyze Servers settings for their local workstations.
If Allow overwrite option is not checked in IBM AD Configuration Server, only the Global settings are taken into account.

Test connection allows the user to test the connection with the graph database.

To select the server you want to work with, put a mark in the corresponding check-box. If you want to test the connection with any of the servers in the list, click anywhere in the associated line then press Test connection.

To add a server to the list, click Add and enter the IP of the server and the port then click OK.

Imports Analysis Options

Note: This setting is only relevant for Java and NetWeaver projects.

Use Imports Analysis options to determine which graph components are included in the Import Analysis Graph (for Java and NetWeaver projects).

To access the Imports Analysis parameters, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Imports Analysis.

By default, all the options are selected (imported, inherited, and implemented).

License Agreement

Use License Agreement to read the terms of the license agreement.

To read the License Agreement, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > License Agreement.

Limits and Restrictions

Use Limits and Restrictions to limit the number of elements that are displayed in the analyses that are generated in IBM AD Analyze Client.

To set specific limits and restrictions for the various analyses that are generated with IBM AD Analyze client, go to IBM AD Analyze client and select Window > Preferences > Application Discovery > Local settings > Limits and Restrictions.

For more information about Limits and Restrictions, see the next paragraphs.

Analysis Expansion Limits

Use Analysis Expansion Limits to set global limits for the analyses that are generated in IBM AD Analyze Client.

To access Analysis Expansion Limits settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Analysis Expansion Limits.

The following parameters are available:

- Limit Expansion, this option is selected by default and it limits the expansion of analyses that are generated with IBM AD Analyze Client to X levels.

- Threshold, enter the maximum number of levels to be processed by the analysis. The default value is "3" levels.

- highlight results that are cut short by the threshold, this option is selected by default and it highlights the nodes for which further analysis results are not displayed due to the imposed threshold. For details, see the corresponding sections on each graph for which this option is available.

Note: This option can be set only for the following graphs: Program Call Graph, AAUTO® Graph, Screen Call Graph, Job Call Graph, Transaction Call Graph, and Dataset Flow. This option can be set for the following reports: Backward Call Chains, Forward Call Chains, SQL Backward Call Chains, A-AUTO Network Dependency Report, and Data Flow Through Datasets.
• **Adjacent levels to zoom**, enter a value in this field to set the graph levels to be included in the zoom operation when a component from the graph inventory is chosen. For example, if you enter the value "3" in this field, when you double-click a component in the graph inventory, that component within the graph together with three adjacent components are displayed. Select **Display indirect links** to include the indirect links in the graph.

• **Nodes threshold**, enter the maximum number of nodes to be displayed in the graph. When this limit is reached, a notification appears asking the user whether or not the application should display graph nodes beyond this limit or not.

**Call Graph Restrictions**

Use **Call Graph Restrictions** to restrict the number of elements that are displayed in a call graph that is generated in **IBM AD Analyze Client**.

To access **Call Graph Restrictions** settings, go to **IBM AD Analyze Client** and select **Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Call Graph restrictions**.

Use the available options to specify a list of programs for which subsequent calls (the subtree below the specified programs) must not be displayed in the callgraph. If for example, you generate a forward analysis, calls starting FROM a restricted node are not be displayed but calls TO the restricted node are displayed. The same principle applies for the backward analysis. The restricted nodes appear in the callgraph clearly marked: When you work with the graph database, restricted graph nodes' names are displayed in red and also marked with a specific icon - a funnel. When you work with SQL database, restricted nodes's names are displayed in red.

Restrictions can be defined for the following call graphs: Program Call Graph, Screen Call Graph, Transaction Call Graph, and Job Call Graph.

These restrictions also apply to the following reports: Backward Call Chains, Forward Call Chains, and SQL Backward Call Chains. In the reports, a restricted node is marked with an exclamation mark, "!".

Supported patterns include *AB, AB*, *AB*.

Check the **Stop nodes will not be visible in graph** box to trigger whether the restricted nodes will be visible or not in the graph or report.

**Note:** If the display of further results for a graph node is limited by both a restriction set in this tab and the Nodes threshold parameter (**Call Graph limits** from the wizard), the restriction takes precedence. See the respective graphs sections for details on the icons that indicate the restrictions.

**Expand Callgraphs to Other Projects**

The option to expand callgraphs through APIs to resources from other projects is available for all callgraph types: API callgraphs, program callgraphs, transaction callgraphs, and screen callgraphs. To enable the expansion, click **Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Callgraph restrictions** and select the **Expand Callgraph to other projects** check box.

• If the check box is not selected, which is the default setting, resources from other projects are displayed as nodes that are prefixed with the project names or CICS® region names in the generated callgraph.

• If the check box is selected, the generated callgraph is expanded with callgraphs that start from the related resource nodes of other projects.

**Note:** To enable the callgraph expansion of a project, you must define the "location" element for the location of another AD project or CICS region in the resolution configuration file of the project. For more information about the file, see section **JSON File Example Used for API/Macro Call Extensibility in IBM AD Build User Guide**.

**Miscellaneous**

Use **Miscellaneous** to set various display settings for the graphs that are generated in **IBM AD Analyze Client**.
To access Miscellaneous restrictions settings, go to **IBM AD Analyze Client** and select **Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Miscellaneous**.

The following options are available:

- **Display SCL standard procedures**, select this option if you want the SCL standard procedures to be displayed in the graphs.
- **Full text for statements in Flow chart**, select this option to display the complete text of the statements in the **Flow Chart**.
- **Display temporary datasets**, select this option if you want to display the temporary data sets in the **Results** area of **Usage** tabs, in the listed data sets from **Explore** project and in the wizards for graphs and reports.

**Shared Resources Graph Settings**

Use Shared Resources graph settings to set the limits for the Shared Resources graph.

To access the Shared Resources graph settings, go to **IBM AD Analyze Client** and select **Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Shared Resources**.

The following option is available:

**Threshold to group nodes of the same type** - the default value for this parameter is "5" and it indicates that if a graph contains more than five nodes of the same resource type. These nodes are grouped in a single resource-group node. Setting up this threshold allows the graph to be kept simple and easy to understand even if many shared resources of a same type exist in the graph.

**TWS Settings**

Use TWS settings (Tivoli® Web Services) to limit the number of elements that are displayed in the TWS graph.

To access the TWS settings, go to **IBM AD Analyze Client** and select **Window > Preferences > Application Discovery > Local settings > Limits and restrictions > TWS settings**.

The following option is available:

**Applications limit** - use this field to limit the number of applications to be displayed in the TWS graph.

**Usage Settings**

Use **Usage Settings** to limit the number of elements that are presented in the **Results** area of **Usage** tabs in **IBM AD Analyze Client**.

The type of element to be limited depends on the type of analysis. The default maximum value for all analyses is "200", but in each **Usage** tab this limit can be set to a lower value.

To access **Usage Settings**, go to **IBM AD Analyze Client** and select **Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings**.

The following option is available:

**Use levels limit**, this option is selected by default and activates the limits set in each subsequent Usage Settings dialog. If this option is not selected, the number of elements that presented in the Results area of the **Usage** tab can be controlled by the values set in the Limit column in the Attributes filters area. If neither this option nor the **Enable levels limit** option in **Usage** tabs is selected, the Results area of **Usage** tabs displays the complete results of the search.

**Adabas Usage Settings**

Use Adabas Usage settings to limit the number of search results that are displayed in the **Adabas Usage** tab.

To access Adabas Usage settings, go to **IBM AD Analyze Client** and select **Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > Adabas Usage Settings**.
In **Adabas Usage Settings** tab you can set display limits for: Adabas, Adabas Views, Programs, and Statement types. You can use the default values or you can customize them according to the needs of your project.

**Remember:** Click **Apply** to save the changes.

**Assembler Program Structure Settings**

Use Assembler Program Structure settings to limit the number of search results that are displayed in the **Assembler Program Structure** tab.

To access Assembler Program Structure settings, go to **IBM AD Analyze Client** and select **Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > Assembler Program Structure Settings**.

In the **Assembler Program Structure Settings** tab, you can set display limits for Programs. You can use the default value or you can customize it according to the needs of your project.

**Remember:** Click **Apply** to save the changes.

**Assembler Variable Usage Settings**

Use Assembler Variable Usage settings to limit the number of search results that are displayed in the **Assembler Variable Usage** tab.

To access Assembler Variable Usage Settings, go to **IBM AD Analyze Client** and select **Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > Assembler Variable Usage Settings**.

In **Assembler Variable Usage Settings** tab, you can set display limits for Programs. You can use the default value or you can customize it according to the needs of your project.

**Remember:** Click **Apply** to save the changes.

**Cobol Program Structure Settings**

Use Cobol Program Structure settings to limit the number of search results that are displayed in the **Cobol Program Structure** tab.

To access Cobol Program Structure settings, go to **IBM AD Analyze Client** and select **Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > Cobol Program Structure Settings**.

In **Cobol Program Structure Settings** tab, you can set display limits for Programs. You can use the default value or you can customize it according to the needs of your project.

**Remember:** Click **Apply** to save the changes.

**Cobol Variable Usage Settings**

Use Cobol Variable Usage settings to limit the number of search results that are displayed in the **Cobol Variable Usage** tab.

To access Cobol Variable Usage settings, go to **IBM AD Analyze Client** and select **Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > Cobol Variable Usage Settings**.

In **Cobol Variable Usage Settings** tab, you can set display limits for Programs. You can use the default value or you can customize it according to the needs of your project.

**Remember:** Click **Apply** to save the changes.

**DAL Usage in Program Settings**

Use DAL Usage in Program settings to limit the number of search results that are displayed in the **DAL Usage in Program** tab.
To access DAL Usage in Program settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > DAL Usage in Program Settings.

In DAL Usage in Program Settings tab, you can set display limits for: DAL, Programs, and Statement types. You can use the default values or you can customize them according to the needs of your project.

**Remember:** Click **Apply** to save the changes.

**Datacom Table Settings**

Use Datacom Table settings to limit the number of search results that are displayed in the Datacom Table Usage tab.

To access Datacom Table Settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > Datacom Table Settings.

In Datacom Table Settings tab, you can set display limits for: Datacom tables, Programs, and Statement types. You can use the default values or you can customize them according to the needs of your project.

**Remember:** Click **Apply** to save the changes.

**Dataset Usage in Jobs Settings**

Use Dataset Usage in Jobs settings to limit the number of search results that are displayed in the Dataset Usage in Jobs tab.

To access Dataset Usage in Jobs settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > Dataset Usage in Jobs Settings.

In Dataset Usage in Jobs Settings tab, you can set display limits for: Datasets, Jobs, Steps, and DDNames. You can use the default values or you can customize them according to the needs of your project.

**Remember:** Click **Apply** to save the changes.

**Dataset Usage in Programs Settings**

Use Dataset Usage in Programs settings to limit the number of search results that are displayed in the Dataset Usage in Programs tab.

To access Dataset Usage in Programs settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > Dataset Usage in Programs Settings.

In Dataset Usage in Programs Settings tab, you can set display limits for: Datasets, DDNames, Programs, and Statement types. You can use the default values or you can customize them according to the needs of your project.

**Remember:** Click **Apply** to save the changes.

**DBI Usage in Program Settings**

Use DBI Usage in Program settings to limit the number of search results that are displayed in the DBI Usage in Program tab.

To access DBI Usage in Program settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > DBI Usage in Program Settings.

In DBI Usage in Program Settings tab, you can set display limits for: DBI, Programs, and Statement types. You can use the default values or you can customize them according to the needs of your project.

**Remember:** Click **Apply** to save the new changes.
DDCL Dictionary Usage Settings

Use DDCL Dictionary Usage settings to limit the number of search results that are displayed in the DDCL Dictionary Usage tab.

To access DDCL Dictionary Usage settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > DDCL Dictionary Usage Settings.

In DDCL Dictionary Usage Settings tab, you can set display limits for: used DDCL Elements, DDCL Elements, and Programs. You can use the default values or you can customize them according to the needs of your project.

Remember: Click Apply to save the changes.

Dictionary Elements Settings

Note: This setting is only relevant for VME projects.

Use Dictionary Elements settings to limit the number of search results that are displayed in the Dictionary Elements tab.

To access Dictionary Elements settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > Dictionary Elements Settings.

In Dictionary Elements Settings tab, you can set display limits for DDCL elements. You can use the default value or you can customize it according to the needs of your project.

Remember: Click Apply to save the changes.

File Usage in Programs Settings

Use File Usage in Programs settings to limit the number of search results that are displayed in the File Usage in Programs tab.

To access File Usage in Programs settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > File Usage in Programs Settings.

In File Usage in Program Settings tab, you can set display limits for: Files, Programs, and Statement types. You can use the default values or you can customize them according to the needs of your project.

Remember: Click Apply to save the changes.

Files in DDCL Elements Settings

Note: This setting is only relevant for VME projects.

Use Files in DDCL Elements settings to limit the number of search results that are displayed in the Files in DDCL Elements tab.

To access Files in DDCL Elements settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > Files in DDCL Elements Settings.

In Files in DDCL Elements Settings tab, you can set display limits for: Files and DDCL elements. You can use the default values or you can customize them according to the needs of your project.

Remember: Click Apply to save the changes.

IDMS Usage Settings

Use IDMS Usage settings to limit the number of search results that are displayed in the IDMS Usage tab.

To access IDMS Usage settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > IDMS Usage Settings.
In **IDMS Usage Settings** tab, you can set display limits for: IDMS Schemas, IDMS Sub-schemas, Records, Sets, Programs, and Statement Types. You can use the default values or you can customize them according to the needs of your project.

**Remember:** Click **Apply** to save the changes.

**IDMSX Usage Settings**

**Note:** This setting is only relevant for VME projects.

Use IDMSX Usage settings to limit the number of search results that are displayed in the **IDMSX Usage** tab.

To access IDMSX Usage settings, go to **IBM AD Analyze Client** and select **Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > IDMSX Usage Settings**.

In **IDMSX Usage Settings** tab, you can set display limits for: IDMSX Schemas, IDMSX Sub-schemas, Records, Sets, Programs, DDCL Elements, and Statement Types. You can use the default values or you can customize them according to the needs of your project.

**Remember:** Click **Apply** to save the changes.

**IMS/DB Logical Usage Settings**

Use IMS/DB Logical Usage settings to limit the number of search results that are displayed in the **IDS/DB Logical Usage** tab.

To access IMS/DB Logical Usage settings, go to **IBM AD Analyze Client** and select **Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > IMS/DB Logical Usage Settings**.

In **IMS/DB Logical Usage Settings** tab, you can set display limits for: Database, Segments, Statements, and Programs. You can use the default values or you can customize them according to the needs of your project.

**Remember:** Click **Apply** to save the changes.

**IMS/DB Structure Settings**

Use IMS/DB Structure settings to limit the number of search results that are displayed in the **IMS/DB Structure Usage** tab.

To access IMS/DB Structure settings, go to **IBM AD Analyze Client** and select **Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > IMS/DB Structure Settings**.

In **IMS/DB Structure Settings** tab, you can set display limits for: IMS/DB, Segments, and Fields. You can use the default values or you can customize them according to the needs of your project.

**Remember:** Click **Apply** to save the changes.

**IMS/DB Usage Settings**

Use IMS/DB Usage settings to limit the number of search results that are displayed in the **IMS/DB Usage** tab.

To access IMS/DB Usage settings, go to **IBM AD Analyze Client** and select **Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > IMS/DB Usage Settings**.

In **IMS/DB Usage Settings** tab, you can set display limits for the following elements: Database, Segments, Statements, and Programs. You can use the default values or you can customize them according to the needs of your project.

**Remember:** Click **Apply** to save the changes.
Include Usage Settings

Use Include Usage settings to limit the number of search results that are displayed in the Include Usage tab.

To access Include Usage settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > Include Usage Settings.

In Include Usage Settings tab, you can set display limits for the following elements: Includes, Programs, and Statement Types. You can use the default values or you can customize them according to the needs of your project.

Remember: Click Apply to save the changes.

Job Usage Inventory Settings

Use Job Usage Inventory settings to limit the number of search results that are displayed in the Job Usage Inventory tab.

To access Job Usage Inventory settings, go to IBM AD Analyze Client, and select Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > Job Usage Inventory Settings.

In Job Usage Inventory Settings tab, you can set display limits for Jobs. You can use the default values or you can customize them according to the needs of your project.

Remember: Click Apply to save the changes.

MQueue Usage Settings

Use MQueue Usage settings to limit the number of search results that are displayed in the MQueue Usage tab.

To access MQueue Usage settings, go to IBM AD Analyze Client, and select Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > MQueue Usage Settings.

In MQueue Usage Settings tab, you can set display limits for: Queues, Queue Managers, Programs, and Statement Types. You can use the default values or you can customize them according to the needs of your project.

Remember: Click Apply to save the changes.

Natural Program Structure Settings

Use Natural Program Structure settings to limit the number of search results that are displayed in the Natural Program Structure tab.

To access Natural Program Structure settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > Natural Program Structure Settings.

In Natural Program Structure Settings tab, you can set display limits for Programs. You can use the default values or you can customize them according to the needs of your project.

Remember: Click Apply to save the changes.

Natural Variable Usage Settings

Use Natural Variable Usage settings to limit the number of search results that are displayed in the Natural Variable Usage tab.

To access Natural Variable Usage settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > Natural Variable Usage Settings.
In **Natural Variable Usage Settings** tab, you can set display limits for Programs. You can use the default values or you can customize them according to the needs of your project.

**Remember:** Click **Apply** to save the changes.

**Open TP Usage Settings**

Use Open TP Usage settings to limit the number of search results that are displayed in the **Open TP Usage** tab.

To access Open TP Usage settings, go to **IBM AD Analyze Client** and select **Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > Open TP Usage Settings**.

In **Open TP Usage Settings** tab, you can set display limits for: Programs and Statement types. You can use the default values or you can customize them according to the needs of your project.

**Remember:** Click **Apply** to save the changes.

**Pgm Usage in Jobs Settings**

Use Pgm Usage in Jobs settings to limit the number of search results that are displayed in the **Pgm Usage in Jobs** tab.

To access Pgm Usage in Jobs settings, go to **IBM AD Analyze Client** and select **Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > Pgm Usage in Jobs Settings**.

In **Pgm Usage in Jobs Settings** tab, you can set display limits for: Programs, Jobs, Steps, DDNames, and Datasets. You can use the default values or you can customize them according to the needs of your project.

**Remember:** Click **Apply** to save the changes.

**PL/I Program Structure Settings**

Use PL/I Program Structure settings to limit the number of search results that are displayed in the **PL/I Program Structure** tab.

To access PL/I Program Structure settings, goto **IBM AD Analyze Client** and select **Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > PL/I Program Structure Settings**.

In **PL/I Program Structure Settings** tab, you can set display limits for Programs. You can use the default values or you can customize them according to the needs of your project.

**Remember:** Click **Apply** to save the changes.

**PL/I Variable Usage Settings**

Use PL/I Variable Usage settings to limit the number of search results that are displayed in the **PL/I Variable Usage** tab.

To access PL/I Variable Usage settings, go to **IBM AD Analyze Client** and select **Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > PL/I Variable Usage Settings**.

In **PL/I Variable Usage Settings** tab, you can set display limits for Programs. You can use the default values or you can customize them according to the needs of your project.

**Remember:** Click **Apply** to save the changes.

**Procedure Usage in Jobs Settings**

Use Procedure Usage in Jobs settings to limit the number of search results that are displayed in the **Procedure Usage in Jobs** tab.
In order to access Procedure Usage in Jobs settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > Procedure Usage in Jobs Settings.

In Procedure Usage in Jobs Settings tab, you can set display limits for Procedures and Jobs. You can use the default values or you can customize them according to the needs of your project.

**Remember:** Click Apply to save the changes.

**SCL Usage Settings**

Use SCL Usage settings to limit the number of search results that are displayed in the SCL Usage tab.

To access SCL Usage settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > SCL Usage Settings.

In SCL Usage Settings tab, you can set display limits for Programs. You can use the default values or you can customize them according to the needs of your project.

**Remember:** Click Apply to save the changes.

**SQL Table Field Usage Settings**

Use SQL Table Field Usage settings to limit the number of search results that are displayed in the SQL Table Field Usage tab.

In order to access SQL Table Field Usage settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > SQL Table Field Usage Settings.

In SQL Table Field Usage Settings tab, you can set display limits for SQL Tables, SQL Table Fields, Programs, and Statement types. You can use the default values or you can customize them according to the needs of your project.

**Remember:** Click Apply to save the changes.

**SQL Table Usage Settings**

Use SQL Table Usage settings to limit the number of search results that are displayed in the SQL Table Usage tab.

In order to access SQL Table Usage settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > SQL Table Usage Settings.

In SQL Table Usage Settings tab, you can set display limits for SQL Tables, Programs, and Statement types. You can use the default values or you can customize them according to the needs of your project.

**Remember:** Click Apply to save the changes.

**TPMSX Usage Settings**

**Note:** This setting is only relevant for VME projects.

Use TPMSX Usage settings to limit the number of search results that are displayed in the TPMSX Usage tab.

In order to access TPMSX Usage settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Limits and restrictions > Usage Settings > TPMSX Usage Settings.

In TPMSX Usage Settings tab, you can set display limits for TPMSX Tables, Programs, and Statement Types. You can use the default values or you can customize them according to the needs of your project.

**Remember:** Click Apply to save the changes.
Local Database Settings

Use Local Database Settings to set the local database configuration.

In order to access Local Database Settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Local Database Settings.

In the DB Server area, select the type of database server you want to use: MS SQL Server or HSQL.

If you select HSQL, the following fields are available:

- **Server host**, enter, or update the name of the server host.
- **Server port**, enter the port number that is used for this connection.
- **Database name**, enter the database name.
- **HSQL Directory**, enter the directory in which the database is stored. You can also browse for this directory by clicking Browse.

If you select MS SQL Server, the following fields are available.

- **Server host**, enter, or update the name of the server host.
- **Server port**, enter the port number that is used for this connection.
- **User name**, enter the user name that is used to access the database.
- **Password**, enter the password that is used to access the database.
- **Instance name**, enter the database instance name if exists, or leave empty.
- **Database name**, enter the database name. If the specified database is new or wasn’t created yet, see IBM AD Installation and Configuration Guide > Eclipse Configuration for SQL Server chapter.

Finally, click Test connection to verify that the database was set correctly.

Reports Settings

Use Reports settings to determine what type of information is displayed on the front page of the reports that are generated with IBM AD Analyze Client. Specific parameters are also available according to the project type: Java projects or mainframe projects.

In order to access Reports settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Reports settings.

By default, the Owner(s), Organization, Project/Organization Role, and Report header image file fields display the global settings configured for the reports in IBM AD Configuration Server at installation time.

If Allow overwrite option was checked in IBM AD Configuration Server for the reports settings, IBM AD Analyze users can select Overwrite global configuration and proceed to change the reports settings for their local workstations.

If Allow overwrite option is not checked in IBM AD Configuration Server, only the Global settings are taken into account.

- **Owner(s)**, enter your name or the name of the person who generates the reports.
- **Organization**, enter the name of your company.
- **Project/Organization role**, enter your position in the organization or role in the project.
- **Report header image**, use Browse to locate and select a header image for the generated reports.
- **Activate Application Discovery Reports view every time a report is finished**, select this check box to automatically present the AD Reports view when a report is generated.
Java Reports Preferences - McCabe Complexity Report
Use McCabe Complexity Report settings to set the complexity degrees used to calculate the McCabe complexity score for Java projects.

In order to access McCabe Complexity report settings for Java projects, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Reports settings > Java > McCabe Complexity.

The following options are available:

- **Simple**, enter the complexity degree up to which a program entity is considered as simple.
- **Moderate**, enter the complexity degree up to which a program entity is considered to be of moderate complexity.
- **Complex**, enter the complexity degree above which a program entity is considered to be complex.

Use the color chip to open the Color window and select a color to represent this parameter in the diagrams that are presented in the McCabe Complexity Report for Java projects.

Mainframe Reports Preferences
Use Mainframe Reports preferences to determine what information is included by default in the reports that are generated for mainframe projects in IBM AD Analyze Client.

In order to access Mainframe Reports preferences, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Reports settings > Mainframe.

The following options are available:

- **Show appendix**, this option is selected by default and ensures that the appendix is shown together with the report that is generated for a mainframe project.
- **Show input details in appendix**, select this option if you want to include in the appendix the input details.
- **Use current project name**, this option is selected by default and it insert the current project name on the cover page of the report.
- **Use custom name**, select this option then enter a custom name that you want displayed on the cover page of the report instead of the original project name.

Rules Based Analysis Settings
Use Rules Based Analysis settings to specify the rules based on which the Rule Based analysis is generated.

In order to access Rules Based Analysis settings, go to IBM AD Analyze Client and select Window > Preferences > Application Discovery > Local settings > Rules Based Analysis.

By default, the Rules file and File encoding fields display the global settings configured for the Rule based analysis in IBM AD Configuration Server at installation time.

If Allow overwrite option was checked in IBM AD Configuration Server for the Rule based analysis settings, IBM AD Analyze users can select Overwrite global configuration and proceed to change the reports settings for their local workstations.

If Allow overwrite option is not checked in IBM AD Configuration Server, only the Global settings are taken into account.

Use Rules file field to locate the file that contains the rules then select the File encoding.

For an example of this type of file, see “Appendix 2 - Rules File Example for Rule Based Analysis” on page 175.
AD Perspectives Common Elements

Use **AD Perspectives Common Elements** for a detailed description of interface elements common to all **Application Discovery** perspectives.

When launching Eclipse, you can select a perspective, that is, a specific set of views according to the type of project you need to analyze.

**IBM AD Analyze** perspectives bring together specific **Application Discovery** views and a subset of Eclipse views to create several AD default layouts. You can modify the layout of the selected perspective at any time, by changing the layout of existing views, opening and closing views as required. Some of the views from a perspective are initially docked to the borders of the display area, but they can be undocked and moved, resized, and hidden (closed). Window names are not shown on docked windows. Many of the windows have pop-up menus that are opened by moving the mouse cursor into the window and right-clicking. In some cases, different pop-up menus are available, depending on the exact position of the cursor in the window.

To return to the default perspective layout, right-click on the perspective box at the upper right of the screen and select **Reset** or select **Window > Reset > Perspective**.

To select one of **IBM AD Analyze Client** default perspectives, follow the instructions on screen and either click the button as indicated or select **Window > Open Perspective > Other**. A list of default perspectives is displayed.

The following are **IBM AD Analyze Client** specific perspectives:

- **Application Discovery Analysis** and **Application Discovery Flow** - used for the analysis of Java projects.
- **Application Discovery Browser** - used for the analysis of mainframe projects.
- When a perspective is open, the following elements are available on screen.
  - Title bar, displays the name of the current perspective, such as **Application Discovery Browser**.
  - Menu bar, displays the Eclipse and AD Client menus.
  - Toolbar, displays the options available for working with Eclipse and AD Client.
  - **Explore** tab, in the central part of the screen, displays the projects list if the **Explore projects** tab is displayed, the contents of the selected project if the **Explore project** tab is displayed and the results of a Search in files operation if the **Search in files** tab is displayed. The area to the right of the screen presents the graphs, reports, and usage analyses that can be generated for the selected projects or resources.
  - **Explore API** tab, displaying APIs and services downloaded from the AD Catalog web service and defined in z/OS Connect.
  - **Graphs**, **AD Reports** and **AD Usage** tabs, in the central part of the screen, display the current analysis output (graph, report, usage analysis) (for details, see **AD Graphs Tab**, **AD Reports Tab**, and **AD Usage Tab**).
  - Views, **AD Graph Overview**, **AD Graph Inventory**, **Properties**, **Editor**, **Outline**, **Problems**, **Errors** - display details or additional information related to the current analysis output.
  - Status bar, displays the current system status according to the current task/view.

Some of these elements are part of Eclipse’s general set of tools while others are especially created for analysis purposes with **AD Analyze Client**. This section presents a short inventory of the specific **AD Analyze Client** views, for details on the general Eclipse views see Eclipse help files.
Note: The perspective layout can be customized according to the user’s needs by moving, resizing, minimizing, maximizing, or closing windows and tabs. Each layout can be saved as a perspective for use in the future. See the Eclipse help files for details on perspectives.

Menu Bar

AD Analyze Client operations are controlled by choosing commands in the Menu bar and pop-up menus, clicking icons on the toolbar, and by using keyboard shortcuts.

The menu bar commands are summarized in the following table. Equivalent keyboard shortcuts, when available, are also listed.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Keyboard shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Alt+F</td>
<td>Opens the File menu. All options in this menu are standard Eclipse options. For details, see your Eclipse help file.</td>
</tr>
<tr>
<td>Edit</td>
<td>Alt+E</td>
<td>Opens the Edit menu. All options in this menu are standard Eclipse options. For details, see your Eclipse help file.</td>
</tr>
<tr>
<td>Navigate</td>
<td>Alt+N</td>
<td>Opens the Navigate menu. All options in this menu are standard Eclipse options. For details, see your Eclipse help file.</td>
</tr>
<tr>
<td>Search</td>
<td>Alt+A</td>
<td>Opens the Search menu. All options in this menu are standard Eclipse options. For details, see your Eclipse help file.</td>
</tr>
<tr>
<td>Project</td>
<td>Alt+P</td>
<td>Opens the Project menu. All options in this menu are standard Eclipse options. For details, see your Eclipse help file.</td>
</tr>
<tr>
<td>Application</td>
<td>Alt+L</td>
<td>Opens AD Client Menu.</td>
</tr>
<tr>
<td>Discovery</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Run</td>
<td>Alt+Run</td>
<td>Opens the Run menu. All options in this menu are standard Eclipse options.</td>
</tr>
<tr>
<td>Window</td>
<td>Alt+W</td>
<td>Opens the Window menu, which includes both Eclipse and AD Analyze Client options.</td>
</tr>
<tr>
<td>Help</td>
<td>Alt+H</td>
<td>Opens the Help menu All options in this menu are standard Eclipse options. For details, see your Eclipse help file.</td>
</tr>
</tbody>
</table>

All the menu commands under the File, Edit, Navigate, Search, Project, Run Window and Help menus are standard Eclipse options. For details about these commands, refer to your Eclipse help files.

The options available in Application Discovery menu are described in the following sections.

Application Discovery Menu

According to the version that you purchased, Application Discovery menu can contain several options. One, several or all of the following options might be available at some point in Application Discovery menu: Annotations, Java Reports, Export Graph, Project Database Connection Test.
Window Menu

In the Window menu, the Preferences option offers access to a set of IBM AD Analyze Client specific parameters that allow the user to define general, graph, usage, and reports settings and other parameters.

For detailed instructions on how to set these parameters see Chapter 3, “Preferences,” on page 7.

Main Screen Toolbar

The main screen toolbar icons enable frequently used menu commands to be performed without having to navigate through the menu hierarchy. A brief explanation of each is presented in the following table.

**Note:** As the menu can be configured according to the user’s requirements, in this section only the options relevant for IBM AD Analyze Client are explained.

<table>
<thead>
<tr>
<th>Function</th>
<th>Menu Bar (Keyboard Shortcut Equivalent)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>File/New (Ctrl+N)</td>
<td>Starts the New Project/Other wizard.</td>
</tr>
<tr>
<td>Save file</td>
<td>File/Save (Ctrl+S)</td>
<td>Saves the current file.</td>
</tr>
<tr>
<td>Print</td>
<td>File/Print (Ctrl+P)</td>
<td>Prints the selected/displayed file.</td>
</tr>
<tr>
<td>Build All</td>
<td>File/Build All (Ctrl+B)</td>
<td>Builds the current project.</td>
</tr>
<tr>
<td>Export Graph</td>
<td>Application Discovery/Export Graph</td>
<td>Exports the selected graph. For details, see the Exporting the Graph.</td>
</tr>
<tr>
<td>Search</td>
<td>Search (Ctrl+H)</td>
<td>Opens the Search window.</td>
</tr>
<tr>
<td>Last Edit Location</td>
<td>(Ctrl+Q)</td>
<td>Jumps to the location in the file that was last edited.</td>
</tr>
<tr>
<td>Back to</td>
<td>Navigate/Back (Alt+left)</td>
<td>Jumps to the previous file in the list of opened files.</td>
</tr>
<tr>
<td>Forward to</td>
<td></td>
<td>Jumps to the next file in the list of opened files.</td>
</tr>
</tbody>
</table>

AD Graph Overview Window

AD Graph Overview window presents an overview of the graph that is displayed in the AD Graphs tab; a zoom square marks the current area of the graph that is displayed in AD Graphs tab. For details, see AD Graph Overview window.

AD Graph Inventory

AD Graph Inventory view shows a hierarchical, tree-like list of all the components in the currently selected graph. For details, see AD Graph Inventory View.

Properties View

The Properties view displays the properties for the selected item, which can be a file, a project, a project node, SQL table, IDMS record/set, and so on. For details, see the Eclipse help.
Text Editor area

AD Analyze Client uses the Eclipse integrated text editor where the content of text files can be viewed and modified. Files that are modified in the Editor are permanently changed.

Note: Files from mainframe projects cannot be modified with the Editor.

To open a file in the text Editor window, select File > Open to open the standard Windows Open File dialog box.

Alternatively, double-click a source file icon from the graph to open the corresponding file in an Editor window, often with the appropriate statement highlighted.

For details on the text Editor area, Outline, Problems, and Errors views, see the Eclipse help.

Application Discovery Analysis Perspective

Application Discovery Analysis and Application Discovery Flow perspectives contain the same tabs. The only difference is the way in which the tabs are organized on your screen.

In Application Discovery Analysis perspective, the Project Explorer or AD Navigator tab displays a hierarchical tree that is comprised of all the projects and project components that are loaded into IBM AD Analyze Client. The tree nodes can be expanded or collapsed by clicking the “+” or “-” signs to the left of each node. The type of each branch is identified by an icon and a text label. Each node corresponds to a source code file or XML meta-data file of a project entity. Double-clicking the node causes the source file or XML to be displayed in the editor window. Right-clicking a node causes a pop-up menu to open. The pop-up menu usually contains commands for displaying the code, expanding or collapsing the branch represented by the node, or for viewing properties of the object.

AD Navigator Toolbar

Many of the AD Navigator Toolbar options are Eclipse default options. Here, are presented only the options that are relevant for AD Analyze Client. For details about the other options, refer to your Eclipse help files.

The following options are available, depending on the selected project/node:

<table>
<thead>
<tr>
<th>Table 3: AD Navigator toolbar buttons</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>Back</td>
</tr>
<tr>
<td>Forward</td>
</tr>
<tr>
<td>Up to Repository</td>
</tr>
<tr>
<td>Collapse All</td>
</tr>
<tr>
<td>Link Open Editors with Content in the Navigator</td>
</tr>
<tr>
<td>Menu</td>
</tr>
</tbody>
</table>

Project Node

In AD Navigator tab, double-click the Project node to expand/collapse the project tree. To display the options available for the project node, right-click on the selected node to display the corresponding pop-up menu. The options available in the project pop-up menu vary according to the type of project selected (Java, CSharp, or NetWeaver). For details on the organizational entities in a project, see Projects Folders and Files.
Following are explanations of menu options available in the project node pop-up menu for Java projects. For more information on the other options, see the Eclipse Help.

### Table 4: Java Project node pop-up menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Graph</td>
<td>Shows the call graph that presents the chain of possible calls at runtime in Java.</td>
</tr>
<tr>
<td>Resource Dependencies Graph</td>
<td>Presents the Resource Dependencies graph showing the links between the special entities present in the special web category (objects such as *.jsp, *.js, *.css, *.html files). For details, see Resource Dependencies Graph in the Graphs chapter.</td>
</tr>
<tr>
<td>Entity Diagram</td>
<td>Presents a diagram for all the classes in the project that contain an “@Entity” annotation. For details, see Entity Diagram in Graphs chapter.</td>
</tr>
<tr>
<td>Imports Analysis Graph</td>
<td>Presents the inheritance relationships (imported, inherited, implemented) among all the entities in the application analyzed. For details, see Imports Analysis Graph in the Graphs chapter.</td>
</tr>
<tr>
<td>Third-Party Usage Report</td>
<td>Presents a list of the classes that use third-party entities (classes and packages).</td>
</tr>
<tr>
<td>Java Complexity Report</td>
<td>Presents complexity measurements that are developed to render the complexity of a class directly from source code.</td>
</tr>
<tr>
<td>McCabe Complexity Report</td>
<td>Presents the McCabe Complexity Report showing McCabe complexity for the current project or for the selected object.</td>
</tr>
<tr>
<td>Java Inventory Report</td>
<td>Presents a list of all the components in the current project.</td>
</tr>
<tr>
<td>Cross Applications Call Graph</td>
<td>Presents relationships that exist between Java and Cobol applications.</td>
</tr>
</tbody>
</table>

### Project Properties

To access the project properties, right-click a project in the AD Navigator tab then from the pop-up menu that appears select Properties. A dialog window is displayed offering the following options: Project folders, Project database settings, and External classpath.

**Note:** The available options depend on the type of project selected.

You can use the available tabs to set the type of project folders, set up or change the project database configuration or determine the external classpath.

### Changing the project database settings

**Note:** For multi-user installations, only the owner of a project can change the database and the project folders settings. For all the other users, the fields in the Project database settings and Project folders tabs are disabled.

The user can modify the database settings of a project at any time. For Multiuser installations, restrictions apply. If another analysis is in progress, no change is allowed in the database settings. To change the project database settings, select the project from the AD Navigator, right-click to display the corresponding pop-up menu, and select Properties.
The Project database settings window is displayed. You can change the server host and port, you can create a new database, or you can connect to another existing database. Or you can make the database public by clearing the selection of Restrict access for new projects option. Use Test Connection to verify the connection with the new database. For detailed instructions on how to set up a new database, see Creating a Java project.

Folder Type Nodes

Each folder in the Analysis Navigator tab represents a list of source files of the corresponding type that are included in the project. This list is displayed when the node is expanded. Double-click the folder node to expand/collapse the project tree.

By default, a Java project is split into two groups of folders, which represent the two types of components of a Java application: src (Java source folder) and lib (third-party libraries folder). An extra web folder (web sources folder) is available, it stores web application resources of your Java project (if applicable).

Component Node

Double-click a component node to display the component. In case the component has Java source code, the source is opened in the Editor. In case the component has only attributes without a source code, an XML representation of the component is opened in the Editor. To better see attributes of a component, choose the Properties view and then select the component in the AD Navigator instead of opening the XML.

Application Discovery Browser Perspective

Use Application Discovery Browser Perspective to view and analyze mainframe projects created with IBM AD Build Client. Other types of projects such as Java and C language projects can be also viewed and analyzed using this perspective. From the perspectives list (Windows > Open Perspective > Other), select Application Discovery Browser to display it as in the following image.

The central part of the screen - the AD Explore/Explore Projects tab - displays a list of projects found on the IBM AD Build Configuration (other types of projects will only be visible in this list if created within Application Discovery Analysis perspective or if imported from IBM AD Analyze Server).
Apart from AD Explore, the following tabs are also available: Explore API, AD Graphs, AD Usage, and AD Reports.

AD Explore Tab

Explore Projects Tab

Use Explore projects to analyze mainframe projects that are created with IBM AD Build Client as displayed as in the following image.

Figure 3: Explore Projects tab

In the central part of the screen, the Explore Projects view within AD Explore tab, displays a list of projects that are found on the IBM AD Build Configuration. For each project, the corresponding type is displayed. The Details column presents the type of environment in which the project was created and the types of resources that are included in the project. The pane to the right of the screen presents the types of graphs, reports, and usage analyses, which can be generated for the selected project.

Note: to make sure that the list of mainframe projects is up-to-date, right-click in the Explore projects view and select Refresh project list.

The types of graphs, reports, and usage analyses available in the pane to the right of the screen depend on the nature of the selected project and on the number of projects.

• For details on the analyses available for mainframe projects, see Mainframe Graphs, Mainframe Reports, and Usage.
• For details on the analyses available for a Java project, see Java Graphs and Java Reports.
• For details on the analyses available when two projects are selected, see Compare Projects in Editor, Compare Projects Report, Shared Resources Graph, Shared Resources Report.

In the upper right corner of AD Explore tab the following buttons are available:

• Explore projects, click this button to return to the Explore projects tab.
• Move to separate view, click this button to move the current view to a separate tab.

Explore API

Use this view as a starting point of analysis regarding APIs defined the z/OS Connect.
When first starting the Analyze Client, the view is empty; at the first call of Reload content action (right-click on tool-bar) the view will be filled with data read from AD Catalog using the web-service settings from Preferences. This list is cached and kept on client until the next call of the Reload action. By selecting an API/service, corresponding analyses are visible in the right part of the screen. Available analyses at the moment are: “API Usage” on page 165 and “API Call Graph” on page 64. Furthermore, when selecting an API/service, its details are visible in Properties view.

Limitations of analysis made on APIs/services.

• services using the WOLA provider are not supported yet.
• services that are not exposed through APIs are not visible and cannot be analyzed.

Manage Resolutions Analysis Tab

Manage Resolutions analysis tab in Application Discovery Browser perspective is described in detail.

**Note:** This function is only available for mainframe projects for which a graph database was set up. Currently, the Manage Resolutions function is implemented only for Cobol and Assembler programs.

The Manage Resolutions Analysis provides an exhaustive list of all dynamic calls resolutions that are identified within the selected project. Furthermore, it allows the user to check and override if needed the existing resolutions. The result of the change can then be seen when the corresponding graph is generated or reloaded.

To access the Manage Resolutions analysis tab, in Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select your project. For details on how to select a perspective and a description of Application Discovery Browser perspective, see the section AD Perspectives Common Elements.

In the Explore section to the right of the Explore Projects view, double-click Manage Resolutions, the Manage Resolutions Analysis tab is displayed as in the following image.

![Image of Manage Resolutions Analysis Tab](image)

**Figure 4: Manage Resolutions Analysis Tab**

The central part of Manage Resolutions analysis tab displays a list of all dynamic calls resolutions that are identified in the selected project. For each resolution the following information is available:

• The resolution type (either automatic, manual, or not resolved),
• The user who provided the resolution,
• The date and time when the resolution was provided.
• The name of the program that contains the dynamic call for which a resolution was provided.
The resolution path (the path to the call statement), that is, the path to the program or include that contains the dynamic call for which a resolution was provided.

- The number of the line where the dynamic call appears.
- The statement type,
- The absolute program path (in case the call is made within an include file, the path to the program where the include is used).

The value set for a resolution is displayed in the Values of the resolution area once it is selected from the resolutions list. Selecting a resolution value, that is, a program name from the Values of the resolution area, displays in the area to the right of the tab all the analyses that can be generated for that program.

Use the fields in the Filters area to filter the resolution list. You can filter by text, by program name, by resolution type, or by project; real-time filtering is available. The option Hide unused is selected by default and hides manual resolutions that were not applied at the time of the latest build. Unused resolutions are existing resolutions that point to lines that no longer contain a dynamic call. If this option is not selected, the unused resolutions appear in the resolutions list marked with a warning icon. For these resolutions, special actions are available on right-click: Delete (removes it) or Reassign resolution (the user can decide to reassign values of this resolution to another automatic resolution present in that program).

When the filtering operation is finished, you can use the black arrow button in the upper left corner of Manage Resolutions analysis tab to hide the filters and maximize the Results area.

When you identified the resolution that you want to check or modify, select it from the list and then right-click to display the pop-up menu. Two options are available: View Source and Override resolution. Selecting View Source opens the source file in the Editor. Selecting Override resolution displays the Override Current Resolution window.

Override Current Resolution

Override Resolution allows the user to change the existing resolution for a dynamic call.

To access the Override Current Resolution dialog window:

- From a graph (Job Call graph, Program call graph, Program flow graph, Screen call graph, and Transaction call graph), right-click on a red arrow edge (representing a dynamic call) and from the pop-up menu select Override Resolution.

- From the Graph Inventory analysis tab, click Resolutions to display the resolutions list, select a resolution, right-click and from the pop-up menu select Override Resolution.

- From the Manage Resolutions analysis tab, select a resolution from the list, right-click and from the pop-up menu select Override Resolution.

The Override Resolution dialog window is displayed as in the following image.
The name of the program that contains the dynamic call and the absolute path to that program are displayed in the upper part of the dialog.

The details of the current resolution for the dynamic call are displayed in the Resolution area of the dialog window: resolution path (in case the dynamic call is made within an include file), the line number, and the statement type.

The current type of the resolution is displayed (automatic, manual, or not resolved) as well as the current resolution value or values.

To change the current value of a resolution, use the fields in the lower right corner of the dialog window, enter the new called program Name, the Member name (only applicable for ASSEMBLER_CSECT and ASSEMBLER_ENTRY program types), and the program type. Then, use the arrow button to the left of the Name field to add the new value to the list. You can use Delete to delete a value from the list.

The check-box COBOL nested program is used to mark a nested program (nested programs can also be called). Use this option only if the program added in the Name field is contained within the program where the resolution is overridden. Once a nested program is added to the Values list, if the option COBOL nested program was selected, the name of the parent and the name of the child programs are displayed as a single entry in the list. After you finish editing of the values list, make sure to click Apply to save the modifications.

To view a list of resolutions previously applied at the same place as the current one, click Show History. A dialog window shows all the previous manual and automatic resolutions only after a build selection was performed. If a build project is performed only the current resolution is shown.

To reapply one of the previous resolutions, select it from the list then click Choose to close the dialog window.

Back to the main Override Resolution dialog window, use Reset to current to go back to the resolution existing when you opened the Override Resolution dialog.

Back to the resolution list in the Manage Resolutions analysis tab, click Reload to display the updated resolution in the list.

You can then generate a new graph to display the result of the resolution change or reload an existing graph.

Figure 5: Override Current Resolution
Explore … (project name) Tab
Explore … (project name) tab allows the user to explore the project contents and to see the list of available project resources.

Note: This function is only available for mainframe projects.

The resource types available in the Resource type drop-down list depend on the type of project that was created in IBM AD Build.

To display the project contents, in Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select your project. For details on how to select a perspective and a description of Application Discovery Browser perspective, see the section AD Perspectives Common Elements.

In the Explore section, to the right of the Explore Projects view double-click Explore project. The Explore …(project name) tab is displayed as in the following image.

![Figure 6: Explore Project tab](image)

The Resource type field allows the user to filter the resources that are displayed in the central part of the screen according to the resource type. Use the Name field to filter the resources by name. Use the a-z button to the right of the Name filter field to order the list alphabetically. Click the adjacent button display only annotated to filter the search results so that only the annotated resources are shown. The list of items contains both resources that were physically added to the project and resources that exist in the database but are not physically added in the project. For example, programs that are not physically added but are called by other programs that exist in the project).

Select a resource from the list: the analyses pane to the right of the screen displays the analyses that can be generated for the selected resource. Double-click a resource from the list to open it in the Editor view in the lower part of the screen.

When a resource is selected, the Properties view displays details about the selected resource such as the resource type and its path. For the resources that do not actually exist in the project - which are only called or used by existing resources, the path is not available. This method can be used to identify this type of resources.

Important: PL/I Programs have special treatment in AD Analyze: external procedures from a PL/I file are treated as programs. Therefore, all the analysis show the procedure name prefixed with the member name (example: member:procedure) as is the case of Explore. To filter the content of the PL/I programs list, special characters can be used. For example, you can use the special character * and add it to either
prefixes or suffixes as in member* or *procedure. In order to filter right after the name displayed in the list, you can use the member:procedure notation.

Search in Files Analysis Tab

Search in Files option allows the user to search for specific terms throughout the files of the selected project.

Note: This function is only available for mainframe projects.

Note: VERY IMPORTANT! The search can be performed only if a project was indexed with IBM AD Batch Server.

In Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select your project. For details on how to select a perspective and a description of Application Discovery Browser perspective, see AD Perspectives Common Elements.

In the Explore section, to the right of Explore Projects view double-click Search in Files: the Search in Files analysis tab is displayed as in the following image.

![Search in Files Analysis Tab](image)

The following search criteria are available in the Filters area:

**Term pattern**, enter the pattern that you are looking for. Supported patterns include "a* b**", "a*, b**", "a-b", "a b-c-d***", "a @**, "a #:", "a $", "a?b".

Syntax details.

- **","** (comma) means "OR": searching for "termA,termB" shows occurrences (and files) that match any of the terms.
- **" ",** (space) means consecutive terms: searching for "termA termB" shows only occurrences that match both terms in this exact order. Space or spaces right after comma is(are) ignored and multiple spaces are trimmed - considered as one.
- **"?"** (question mark) means any one character: searching for "abc?" shows occurrences of all four character terms where the first 3 characters are "abc".
- **"*"** (asterisk) means any term or any number of characters part of a term. (Because the search is performed on indexed terms and not on full text and a term is considered any sequence of valid characters delimited by separators. For details about which characters are considered as a valid part of a term (and not a separator, and consequently ignored), see [https://docs.oracle.com/javase/7/docs/api/java/lang/Character.html#isJavaIdentifierPart(char)](https://docs.oracle.com/javase/7/docs/api/java/lang/Character.html#isJavaIdentifierPart(char)). To that list the following characters are added:
These search patterns can be combined to search for the wanted terms.

**Restrict results to files**, enter the names of the files where you want to perform the search.

**File type**, select the file types where the search is to be performed. Click the adjacent button to display a list of available file types.

**Case sensitive**, select this option to make the search case sensitive.

**Regular expression**, select this option to search for regular expressions. If this option is not selected, the field **Term pattern** can take any text.

**Syntax details.**

- "," (comma) means "OR", the same as in the syntax list under **Term pattern**. ("regEx1,regex2" is equivalent to "regEx1|regex2").
- " " (space) means consecutive terms, the same as in the syntax list under **Term pattern**.

**Note:** When Regular expressions option is checked, regular expression matching is also done for the file name.

**Note:** In order to obtain a result, the search term (both simple text and regular expression) must fully match an indexed term. In regular expression context, this means that if you use, for example, something like an online regex validator/tester for the regex "term", you match "term" plus any word that contains "term" ("terms", "terminates"). When Search in files function is used with "Regular expression" option selected, searching for "term" shows only occurrences of "term". To obtain the same behavior, you must use a regular expression such as "term\w*".

**Ignore comment**, use this option to exclude comments from the search results.

**Note:** The following option is only available for Cobol resources.

**Search in results**, use this option to perform a search within the results of a previous search operation.

The available projects are listed in the pane to the right of the tab. Select the project where the search is to be performed. Once you selected the wanted criteria, click **Search** to perform the actual search operation. When the filtering operation is finished, you can use the black arrow button in the upper left corner of **Search in files** tab to hide the filters and maximize the Results area. The results of the search are displayed in the lower part of the tab and are grouped by project.

Specific analyses can be generated for the files in the Files per project area. Select a file from the list and the available analyses are displayed in the area to the right of **Search in files** tab. Double-click a file from the Files per project area to open it in the appropriate editor. Also, if you double-click an occurrence in the Occurrences (per file) area the corresponding file is opened in the editor at the line where the searched word was found.

To export the results of the Search in files operation, use **Export results to CSV file** in the upper corner of the Results area. The *.CSV file includes all the search criteria used, as well as the number of occurrences per file.

**Cobol Source Analysis Tab**

**Cobol Source Analysis** tab provides an inventory of the code elements that are identified in the selected code section.

**Note:** This function is only available for mainframe projects.

To start the **Cobol Source Analysis**, go to the Editor window, select part of a Cobol source code, and from the right-click menu choose **Cobol Source Analysis**. The corresponding tab is displayed as in the following image.
The Source selection area displays the absolute path to the resource file that contains the selected Cobol source code section. The start line number and end line number of the selection are displayed. The field **In the context of** displays the name of the ancestor program file if the selection was made within the Cobol Include file.

The selected section of Cobol source code is displayed in the Source text area. Click **Analyze** to analyze the selected Cobol source code. The results of the analysis are displayed in the Results area of the tab.

Once the analysis of the Cobol source code is finished, you can use the black arrow button in the upper left corner of Cobol Source Analysis tab to hide the Filters area and maximize the Results area.

The results of the analysis consist of a list of source code elements that are identified within the selected Cobol source code section. The results are organized in a tree structure where the root is the Cobol file and the identified elements are grouped in categories such as Includes, Variables. Click an element from the list. In the Explore area to the right of **AD Explore** tab the analyses that can be generated for the selected element are displayed.

**View Expanded Source**

**View Expanded Source** allows the user to view the content of preprocessed COBOL and PL/I programs or JCL.

**Note:** This option is only available in mainframe projects for Cobol, PL/I and JCL resources if the preprocessing feature was configured in **IBM AD Batch Server**. For details, see IBM AD Batch Server Configuration Guide.

The COBOL preprocessing implies expanding all include files and applying all REPLACE compiler directives. For JCLs, preprocessing implies expanding all JCL procedures and JCL include files.

For PL/I, preprocessing implies expanding all include files, with the following supported syntax:

- File inclusion: %INCLUDE File, %XINCLUDE File, ++INCLUDE File, -INC File
- Library member inclusion: %INCLUDE MEMBER, %INCLUDE LIB (MEMBER)

**Cobol Resource Expanded**

To view the Cobol expanded source, go to the Editor window and from the right-click menu choose **View expanded source**. A new tab is displayed indicating that it contains the expanded resource.
The expanded Cobol code contains a comment that is inserted before a copy expansion, full path of the Copy file used with the source line number for the Copy/Include statement, and a comment inserted at the end of the expansion with the same copy file information (path and line number) matching the start comment.

**Example 1 REPLACE compiler directing statement**

REPLACE Compiler directing statement replaces one or more words with another sequence of words (or by nothing), in all sources, including all nested (copied) ones, until REPLACE OFF statement is met or till the end of the program if REPLACE OFF is not specified.

Note that a blank space in the text to be replaced may mean one or more blanks in the source itself. In the following example, two pseudo texts were replaced with two other.

REPLACE compiler directing statement:

```
REPLACE ==TEXT TO BE REPLACED== BY ==NEW TEXT==
==EXHIBIT NAMED== BY ==DISPLAY==
```

**Example 2 COPY statement replacing**

COPY statement can be found in a basic format, copying only the source code as is without changes (unless REPLACE is active at the point of COPY), or with a REPLACING clause which can modify the text within that COPY and all copies nested within it.

A blank in the text to be replaced can translate into one or more blanks in the source itself, for example, two token replacements and one pseudocode replacement.

COPY statement replacing:

```
COPY CPY00001 REPLACING V1 BY V0001
  V2 BY V0002
==TEXT TO BE REPLACED== BY ==NEW TEXT==
```

**Example 3 "-INC" replacing**

"-INC" is another format of Copy, and copies only the source code as is without changes unless used with prefix.

The additional information for performing the replacement is stored into the repository.

**Example 3 Prefix replacing**

Prefixes are used together with "–INC" commands and are defined within comments in the original Cobol source.

After a prefix is defined, each record or variable name that is mentioned in variable definition will have a prefix as indicated in the prefix declaration, including a hyphen. The prefix is added to all variables defined following the Prefix start, these could be both in the program code and copybooks code, until a comment with PREFIX,END is found. Prefix would be applied on all nested COPY/-INC too.

A prefix active in the scope of one "–INC" command.

```
01 ITF1-AREA.
  *PREFIX,ITF1
-INC CCMNT000
  +PREFIX,END
```

If copybook CCMNT000 has the following definitions:

```
copybook CCMNT000 definitions:
```

```
02 REC1.
  03 V1 PIC 999
  03 V2 REDEFINES V1 PIC 9V99
  03 FILLER PIC XX.
```

The expanded copybook has variables with “ITF1-“ prefix:
Example 4 SQL Include

Embedded SQL INCLUDE commands are handled in a similar way to a simple COPY statement. The SQL include files are inserted in the place of the EXEC SQL INCLUDE statements.

JCL Resource Expanded

To view the expanded JCL source, go to the Editor window and from the right-click menu choose View expanded source. A new tab is displayed indicating that it contains the expanded resource.

The JCL source code expansion process consists of the following operations:

- Per each symbol in the Job, performs the replacement;
- Per each Proc/Include usage, performs the symbol replacement and expands the Proc file;
- The Proc file or Include file content is included after the Proc step or Include command and appears with two leading characters ("XX") for every line, replacing the original two slash characters used in the PROC/Include ("//").

JCL symbols are defined or set in the job code. The symbols are similar to template variables that can be initialized and set along the JCL Jobs Procs and include files code.

When defined, the symbols are used as a name followed by equal sign and value, and when used in the Job code or Proc or Include code, the same name is used with an ampersand ("&") before it. When the Job is expanded, the symbols are replaced both within the job code and Proc/Include code, from the point of definition of the symbol till the end of that job. Symbols are relevant for the Job they are defined in, and other jobs defined in the same JCL file don’t use them. The Proc code may have symbols set at the beginning of the Proc as a default value in case the Job did not override (define or set) some/all symbols before calling the proc.

The reference for symbols is done with "&" before the symbol name and period following it (if there is more text after the symbol) as in the example below.

Original Proc code:

```
//STP010 EXEC PGM=IKJEFT1B,
// REGION=&RGN
//XSBCF DD DSN= &PARML..CONTRLIB(PISYPP20),
// DISP=SHR
//XSOCF DD SYSOUT=*
//PSZP316 DD DSN=&STP0100,
// DISP=(NEW,PASS),
// DCB=(BLKSIZE=21600,LRECL=120,RECFM=FB),
// SPACE=(CYL,(5,5),RLSE),
// UNIT=(WORK,&VOL)
//PSZP317 DD DSN= &DSNGP..P00PS.BP.PSBMPP20,
// DISP=(NEW,CATLG),
// DCB=(BLKSIZE=21600,LRECL=120,RECFM=FB),
// SPACE=(CYL,(5,5),RLSE),
// UNIT=(DATA,&VOL)
```

Proc lines after symbol replacement:

```
XXSTP010 EXEC PGM=IKJEFT1B,
XX REGION=4096K
XXSBCF DD DSN= PJ.OPRPO..CONTRLIB(PISYPP20),
XX DISP=SHR
XXSOCF DD SYSOUT=*
XXPSZP316 DD DSN=&STP0100,
XX DISP=(NEW,PASS),
XX DCB=(BLKSIZE=21600,LRECL=120,RECFM=FB),
XX SPACE=(CYL,(5,5),RLSE),
XX UNIT=(WORK,6)
```
Double ampersands before a word (for example, "&&STP0100") are not a symbol reference but rather a temporary file name.

**PL/I Resource Expanded**

To view the PL/I expanded source, **Editor window > right click > View Expanded Source**. A new tab is displayed indicating that it contains the expanded resource. The expanded PL/I code contains the following information:

- a comment that is inserted before an include expansion.
- the full path of the Include file used with the source line number for the Include statement.
- a comment inserted at the end of the expansion with the same include file information (path and line number) matching the start comment.

**Example %INCLUDE replacing**

The "%INCLUDE" preprocessor statement is used to include the text of another file, having the effect of including the specified file code without any further changes.

**AD Graphs Tab**

**Graphical Analysis Overview**

An overview of the graphical analysis features available in AD Graphs tab from the Application Discovery Browser perspective of IBM AD Analyze Client.

The graphical analysis results are presented in **AD Graphs** tab. This view is the main analysis view that displays the results of the analysis that was performed on the selected project or project component. For example, the following picture shows a Program call graph displayed in the AD Graphs tab.

![AD Graphs tab](image)

**Figure 9: AD Graphs tab**

The graphical analysis is presented in three views:

- AD Graphs - the main view, in the central part of the screen - displays the graphs that are generated in IBM AD Analyze Client for the selected project. The graphs are presented at a zoom of 100%. The nodes in the graph represent the project components, while the edges (arrows) represent relationships between the components. Both nodes and edges are color coded to show the type of component or relationship. To see a description of all the nodes and edges available in the currently displayed graph, click **Show Graph Legend** from “Graphical Analysis Toolbar” on page 40. The graph legend is presented on the right side of the screen. For most graphs, you can use the symbols in the graph legend
to show/hide the nodes and edges of the graph. The graph symbols depend on the type of graph displayed.

- **AD Graph Overview** view - presents a zoomed-out version of the graph displayed in AD Graphs view so that the entire graph is available at a glance. For details, see AD Graph Overview Area.

- **AD Graph Inventory** view - shows a hierarchical, tree-like list of all the components in the current graph. Some components have specific icons, for details see AD Graph Inventory View.

Several types of graphs can be generated depending on the type of project or on the number of selected projects, for details, see Graphs chapter.

Various parts of the graph can be hidden and redisplayed by using commands on pop-up menus, and also by positioning the selection box in the AD Graph Overview view. Other information can be obtained by double-clicking components in the graph (which usually causes the corresponding source file to open in an Editor window), or by positioning the mouse cursor over an element.

For details about each type of graph, see Mainframe Graphs and Java Graphs.

**Graphical Analysis Toolbar**
Graphical analysis toolbar from AD Graphs tab is presented in detail.

The following buttons are available in the graphical analysis toolbar:

<table>
<thead>
<tr>
<th>Table 5: Graphical Analysis toolbar buttons</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>Move between windows</td>
</tr>
<tr>
<td>Legend</td>
</tr>
<tr>
<td>Hide all edges</td>
</tr>
<tr>
<td>Show all edges</td>
</tr>
<tr>
<td>Hide selected</td>
</tr>
<tr>
<td>Hide unconnected</td>
</tr>
<tr>
<td>Reload content</td>
</tr>
<tr>
<td>Refresh contents</td>
</tr>
<tr>
<td>Fit in canvas</td>
</tr>
<tr>
<td>Pointer</td>
</tr>
<tr>
<td>Panning</td>
</tr>
<tr>
<td>Marquee zoom tool</td>
</tr>
<tr>
<td>Interactive zoom tool</td>
</tr>
</tbody>
</table>
Table 5: Graphical Analysis toolbar buttons (continued)

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigate edges</td>
<td>Enables the user to navigate across edges within the graph. If you click Navigate edges and then right-click on a component, it iterates between all of the edges that are connected to the component (meaning, which arrow leaves or enters the current node), showing the name of the destination node each time as a hint. Left-clicking moves the graph along the selected edge. IMPORTANT: Refrain from moving the mouse when you are using this tool, it can lose focus.</td>
</tr>
<tr>
<td>Refresh layout</td>
<td>Enables the user to select a symmetrical, circular, or orthogonal layout for the graph. The default layout is hierarchical.</td>
</tr>
</tbody>
</table>

AD Graph Overview Window

In **AD Graph Overview** window the entire graph is presented, and a zoom square marks the current area that is shown in the main tab.

This view is used to select a specific area of the graph that is displayed in the **AD Graphs** tab and to navigate around the graph. This function is useful when the graph is large and cannot be seen in its entirety at any one time.

To select the area of the graph that you want to display in the **AD Graphs** tab, draw a rectangle with your mouse in **AD Graph Overview** window and drag it to mark the required section of the graph.

![Figure 10: AD Graph Overview Window](image)

Every time you resize the rectangle, **AD Graphs** tab is updated. Also, changes made in the graph that is displayed in **AD Graphs** tab are reflected in AD Graph Overview window.

Graph Inventory View

AD Graph Inventory view shows a hierarchical tree-like display of all the components in the currently selected graph. By default, this view is displayed in the upper-left corner of the screen. The quick filter field can be used to filter the different components in the graph inventory according to the text typed in that field. Typing some text leaves in the inventory only the items that have that text somewhere within their name.

An example of an AD Graph Inventory view is displayed in the following image.
Figure 11: AD Graph Inventory View

By default, all graph elements are listed in the AD Graph Inventory view.

Use All button to see all nodes of the graph grouped by their type.

Use Annotated button to show only the graph elements with annotations.

**Note:** Only Program Call graph, Program Flow, Screen Call graph, Job Call graph, Transaction Call and API Call Graph graph analyses support annotations management.

Use Resolutions button to show all dynamic calls from that graph, whether resolved by the compiler or overridden through a manual resolution. Possible statuses for a dynamic call showed in the list: dynamic call resolved automatically by the compiler, dynamic call not resolved, dynamic call manually resolved. To modify the resolution status of a dynamic call, right-click on the dynamic call and from the menu select Override Resolution. For details on the options available in Override Resolution dialog window, see Override Resolution.

Use Export Graph Inventory button in the upper right corner of the AD Graph Inventory view to export the current graph inventory in CSV format.

**AD Usage Analysis Tab**

**Note:** Usage analysis is only available for mainframe projects.

The Usage tab displays a set of parameters that allow the user to determine in what way a certain type of entity (such as SQL table, file, include) is used throughout the resources of the selected project.

In Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select your project. For details on how to select a perspective and a description of Application Discovery Browser perspective, see AD Perspectives Common Elements. The pane to the right of the screen presents the types of graphs, reports, and usage analyses that can be generated for the selected project. Double-click a usage analysis to display the Usage tab as in the following image.
Figure 12: AD Usage tab

The central part of the screen displays the list of attribute filters. The breadcrumb displays the selected projects, the selected attributes together with the filters set for each attribute.

Click the Filter field to the right of an attribute name and enter the filter that you want to use for the attributes' names. Only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "*AAA" or "AAA*". To limit the number of attributes of a certain type returned by the filtering operation, use the fields in the Limit column. The default limit is 50; the maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see Usage Settings. The Context column displays the context of the filter operation where relevant. The context of the first attribute filter in the list is the project. The context of any other attribute filter in the list is the attribute above it in the list.

To the right of Attribute filters area, the list of projects is displayed.

Use Save to save the current filter configuration. Use Load to load a previously saved filter configuration.

By default, Enable levels limit is selected and the number of elements which are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press Apply to apply the selected filters.

When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the current usage analysis parameters in a separate tab, use the button move to separate view in the upper corner of the tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button find only annotated to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available.

Expand all, click this button to expand the tree.

Collapse all, click this button to fold all the tree branches.

Export Results to CSV File, use this button to export the results together with the used filter configuration.
Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. Once you select a tree node, the area to the right of the screen is updated and displays the graphs, reports, and usage analyses that can be generated for the selected element.

In the tree, double-click an element to open the corresponding file at the occurrence line. The nodes available in the tree depend on the current analysis. For more information on the nodes available for each usage analysis, see Chapter 8, “Usage,” on page 125.

**Node pop-up menu**

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. For more information on all the Usage analyses that can be generated for each type of project, see Chapter 8, “Usage,” on page 125.

**AD Reports Tab**

**AD Reports** tab displays the report generated for the selected project or resource.

![Figure 13: AD Reports tab](image1)

**Note:** For details on how to customize the information that appears on the cover page of the reports, see Reports Settings.

**Report toolbar**

The toolbar that appears above the reports is used to perform various operations on the report.

The following icons are available.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export</td>
<td>Export the report in PDF, RTF, XLSX, DOCX, or CSV format.</td>
</tr>
<tr>
<td>Print</td>
<td>Print the report on a printer that is connected to your system.</td>
</tr>
<tr>
<td>First page</td>
<td>Jump to the first page of the report.</td>
</tr>
<tr>
<td>Previous</td>
<td>Go to the previous page of the report.</td>
</tr>
<tr>
<td></td>
<td>Number of the current page.</td>
</tr>
</tbody>
</table>
### Table 6: Report Toolbar buttons (continued)

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next</td>
<td>Go to the next page of the report.</td>
</tr>
<tr>
<td>End</td>
<td>Jump to the last page of the report.</td>
</tr>
<tr>
<td>Actual size</td>
<td>Present the report in standard size.</td>
</tr>
<tr>
<td>Fit page</td>
<td>Present the report to fit to page.</td>
</tr>
<tr>
<td>Fit width</td>
<td>Present the report as to fit to width.</td>
</tr>
<tr>
<td>Go back</td>
<td>Return to the previous location in the report.</td>
</tr>
<tr>
<td>Zoom out</td>
<td>Zoom out (in increments of 25).</td>
</tr>
<tr>
<td>Zoom in</td>
<td>Current* zoom percentage. Select from the drop-down list to zoom to 25% - 200% (in increments of 25).</td>
</tr>
</tbody>
</table>

For details on how to generate reports, see the Reports chapter.

### Annotations

#### Annotations Overview

Annotations are comments that help the next person in the application’s lifecycle to process the application. In this way, the engineers who access the annotated resource can see what additions/updates were made during the application’s lifecycle and can add their own comments. **IBM AD Analyze Client** provides simple tools to assist you in handling the annotations in your project. Changes made to annotations are stored for maintenance under numbered revisions. An annotation that is created on a resource in a project is visible on all projects that contains that resource.

In case you are not using the API feature, annotations can be added and seen only on physical resources such as programs and JCL Jobs.

In the context of API feature, the annotations are collected by the API Resolver and can be seen on the following resources: CICSTran, SQLTable, SQLField, CICSTransMap, IMSMessageDescriptor, IMSTransaction and IMSDBSegment. For more details related to the API Resolver, see **IBM AD Build Client** documentation.

The options for handling annotations are available in **IBM AD Analyze Client** in multiple locations:

- **In Explore** tab, under Explore projects view, the area to the right of the screen presents the annotations option available for the selected project or projects. The option is View Annotation.
- **In Explore** tab, under Explore project view, when any program or JCL is selected. The options are Add Annotation and View Annotations.
- **In Explore** tab, under Search in files view, for the selected project or projects. The option is View Annotations.
- In the pop-up menu of the graph elements, when any program or JCL job nodes are selected from Graph Inventory or from the graph displayed. The options that appear in the pop-up menu under Annotations are Add Annotation and View Annotations.
- **In Usage** tab, when any program or JCL is selected. The options are Add Annotation and View Annotations.
- **In Cobol Source analysis** view, when a Cobol program is selected. The options are Add Annotation and View Annotations.
The annotation-related options are described under “Adding an Annotation” on page 46 and “View Annotations” on page 47 chapters.

Note: Make sure that Annotations Database configurations from IBM® AD Configuration Server are set and IBM® AD Batch Server is configured to access IBM® AD Configuration Server that contains the configurations for annotations database. For more information, see Configuring the Annotations Database chapter in IBM® AD Configuration Server User Guide and Server Properties chapter in IBM® AD Batch Server Configuration Guide.

Adding an Annotation

Add Annotation allows the user to create a new annotation for the selected resource. An annotation can be added from Explore project view, a graph, an usage or Cobol Source analysis view.

About this task

This task takes you step-by-step through the process of adding an annotation.

Procedure

1. To add an annotation, select a resource and depending on the analysis from which you want to add the annotation, you will either have to:
   a. Go in the results area and choose Add Annotation from the Explore area to the right of the tab.
   b. Go in the Graph inventory or on the graph that is displayed, right-click on the selected resource and from the pop-up menu that is displayed select Annotations > Add Annotation. After Add Annotation is selected the Create Annotation window appears.

   ![Create Annotation Window](image)

   Figure 14: Add Annotation

2. The Resources area displays the resource name, the resource type, and the name of the project.
   a) In the Title field, enter a short, relevant title for the annotation.
   b) In the Main text field, enter the annotation.
   c) The Date field displays the current date, which represents the annotation date.
   d) To add keywords for the annotation, click the Manage button from the Keywords area. In the Manage keywords dialog window, a list of available keywords is displayed. Use the arrow buttons to move keywords between the Available and Selected areas. To add a keyword to the list, enter the
word in the field at the top of the list then press the **Add** button. Once you selected all the wanted keywords, press **Ok** to return to the **Create Annotations** dialog window. The selected keywords are displayed in the Keywords area of the dialog window.

3. Finally, click **Save** to add the annotation to the selected resource. An icon next to the resource in the graph indicates that an annotation is available for that resource.

**View Annotations**

**View Annotations** presents a list of annotations that are defined for the selected resource either by a user directly in IBM AD Analyze Client or collected by API Resolver.

This analysis can be started either at resource level by selecting the resource that has attached an annotation or at project or project level by selecting one or more projects.

To add an annotation, select a resource and depending on the analysis from which you want to add the annotation, you will either have to:

1. Go in the results area and choose **View Annotation** from the **Explore** area to the right of the tab.
2. Go in the Graph inventory or on the graph that is displayed, right-click on the selected resource and from the pop-up menu that is displayed select **Annotations**, then select **View Annotation**.

To view the annotations that are attached to the resources of a project, select the project or the projects for which you want to see the annotations and from the area to the right of the screen choose **View Annotations**. The **View Annotations** tab is presented as in the following image.

![View Annotations](image)

**Figure 15: View Annotations**

The Filters area allows the user to search throughout the selected project for annotations that match specific search criteria such as:

- **Text**, use this area to search by both annotation title and main annotation text.
- **Keys**, click the adjacent button to display a list of keywords that you can use to search for the annotation.
- **Date filtering**, use these fields to filter the search results by the date when the annotation was added.
- **Resource name**, enter the name of the file for which you want to view annotations; alternatively it shows the name of the selected resource.
- **Resource type**, click the adjacent button to display a list of resource types and select the ones that you want to use for the filtering operation.
Once you selected the wanted criteria, click **Search** to perform the actual search operation.

The Projects list area to the right of the Filters area displays the projects list and allows the user to search through one or several projects.

When the filtering operation is finished, you can use the black arrow button in the upper left corner of the **View Annotations** tab to hide the filters and maximize the Results area.

In the Results area to the left, the list of annotations is presented. You can move through the list of annotations by using the keyboard arrow keys or by selecting one from the list. If you select an annotation from the list, the fields in the Details area display the main annotation text, the date when the annotation was created, and the corresponding keywords.

The Resources area displays the resources where this annotation was found, grouped by resource type, while the Related projects area displays the list of projects that contain the resources in the above field.

Use **Edit** and **Delete** at the top of annotations list, to edit or delete the selected annotation.

**Note:** In case that API feature is used, only the Delete option is available on an annotation.

To export the annotations list, use **Export results to CSV file** in the upper corner of the Results area.

By selecting the resource that is displayed in the Resources area from the Results that are displayed, according to the resource type, a list of analysis are shown in the Explore area to the right of the Explore tab.
Chapter 5. Using IBM AD Analyze Client

Overview
An overview of the organizational elements of a project in IBM AD Analyze and a brief description of the typical tasks that are performed in IBM AD Analyze Client.

Concepts and capabilities of the product are presented, and the typical sequence of tasks to be followed when a project is created, how to perform the analysis, and how to display and analyze the results. Since the objective is to provide a general picture of the use of IBM AD Analyze Client, all the capabilities, alternatives, and options available at each stage are not described exhaustively. For more information on IBM AD Analyze Client, see Chapter 4, “IBM AD Analyze Client Reference,” on page 23.

Projects, Folders, and Files
Use Projects, Folders, and Files to organize projects, folders and files in IBM AD Analyze Client.

IBM AD Analyze Client projects correspond to independent applications. An IBM AD Analyze Client project can contain references to all application source files or part of them. These are organized into folders that are category lists for the different kinds of files that make up the project/application. Standard folders are defined and included in the project by default. Depending on the environment of the application to be analyzed, projects can have different folder structures. New folders can be added if necessary. Creating an IBM AD Analyze Client project creates a project folder on the computer or on a network drive. You can specify the location for this folder.

Tasks
Working with IBM AD Analyze Client usually means performing the following sequence of tasks:

<table>
<thead>
<tr>
<th>Table 7: IBM AD Analyze Client tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start IBM AD Analyze Client</td>
</tr>
<tr>
<td>Create a New Project</td>
</tr>
<tr>
<td>Adjust Project Settings</td>
</tr>
<tr>
<td>(Re)build</td>
</tr>
<tr>
<td>Analyze</td>
</tr>
</tbody>
</table>

| Start IBM AD Analyze Client          |                           |
| Create a New Project                 | Create a project using the IBM AD Analyze Client wizard by specifying the project name, location, and folders. |
| Adjust Project Settings              | Adjust the project settings as appropriate. |
| (Re)build                            | Build the project.        |
| Analyze                              | Examine the results of a build by means of graphs, reports, usage and compare analyses. |

Tasks 2 and 3 are setup and organizational steps. Their purpose is to define the source material that is analyzed. Step 4 (Build) populates the repository that is the basis for the Analysis step. The following sections of this chapter describe the typical tasks followed when using IBM AD Analyze Client for the analysis of projects. In many cases, there are alternative ways for activating the same IBM AD Analyze client functions (main menu, pop-up menus, keyboard shortcuts, and the main screen toolbar). In this chapter reference is primarily made to the main menu commands. The alternatives are described in IBM AD Analyze Client Reference chapter.
Creating an AD Java Project

About this task
The first step of the process of analyzing Java resources is creating a Java project.

Procedure
1. To create a Java project, go to IBM AD Analyze Client and select File > New > Project. The New Project window appears.

![New Project window](image)

Figure 16: New Java Project wizard - project type

Under Application Discovery Analyze directory, select AD Java Project and click Next.

2. The New Application Discovery Project window is displayed.
Enter the name of the new project in the **Name** field.

Keep the project type as local project (default). By default, **Use Default Location** check box is selected. In the example presented, the project is created under the default path `C:\Users\IBM_ADMIN\workspace\zOS workspace\My_Pet_Store`. To select a different path, clear the selection of **User Default Location**: the **Location**. Click **Browse** to open the Browse for Folder window and select a location. Select **Make New Folder** to create a new folder for the new project.

In multi-user installations, projects can be shared and registered on an **IBM AD Analyze Server**. **Shared project on server...**, select this option if you want to share the newly created project. When you select this option, the associated **Server Settings Configuration** link becomes available. Click this link to open the Server settings window and select or define the server where you want to share your project. For details on how to define/change the server settings see **Server Settings** in Preferences chapter.

**Note:** In order to be able to share projects on the server, make sure that the IP of your computer is on the Allowed IPs list from the **Access Settings** tab in **IBM AD Analyze Server Manager**. For details, see **Access Settings** tab.

Click **Next**.

3. The Set database for project window is displayed:
When new projects are created, the default option is to also create dedicated databases with restricted access. In this case, “restricted access” means that no new projects can use this database. If you want to create a database that is public, make sure that the option **Restrict access for new projects** is NOT selected.

**Note:** You can later change the database access parameters either from the project Properties dialog window, from the **Project database settings** tab or from the Server Manager dialog window, in the **Project Database Access** tab (for multiuser environment).

Fill in the available fields as follows.

- **SQL Server**, enter, or update the name of the server host.
- **Server port**, enter the port number used for this connection. **User name**, enter the user name used to access the database.
- **Password**, enter the password used to access the database.
- **Instance**, enter the database instance name if exists or leave empty.
- **Database**, this field will be automatically filled with the name of the database after it is created. This field is a non-editable field.

Once you entered the database details, click **Setup database** to create the new database for the new project. The following dialog window is displayed.
Figure 19: New Java project wizard - database setup wizard

In the first page of the wizard, enter the name of the database. When a database is configured for the first project, the wizard creates the database. If the user specified in Set database for project window does not have such an authorization, check Administrative Credentials and give a user and password that can be used to create the database. This user is used only for this setup procedure. Press Next. Five situations can exist regarding the database for the new project:

a. The database does not exist and you can create it now.
b. The database exists and is ready to be used.
c. The database exists but access to it is restricted.
d. The database exists but is obsolete.
e. The database is not valid.

Pressing the Next button creates or recreates the database.

If there is a connectivity issue and the database cannot be reached the possible cause is displayed on the wizard page. Fix the problem according to the possible cause, then press Back and try again.

Finally, after the Database setup wizard was completed successfully, the name of the database will be displayed in the Database field of the Set database for project wizard.

4. Alternatively, when a new project is created, instead of creating a new, dedicated database, you can use one of the existing databases. In this case you need to select the Use existing database option: the available options change as in the following dialog.
Figure 20: New Java project wizard - select existing database

The central part of the screen displays a list of existing databases that are also public. (Databases that are not public, that is, that were created with the option **Restrict access for new projects**, do not appear in this list). Select the database that you want to use for your new project. If the option **Restrict access for new projects** is selected, no other new projects are allowed to share the selected database.

Click **Next**.

5. The Project Settings screen appears allowing the user to specify the folder names for the resources to be analyzed.
Creating a Mainframe Project

Creating a mainframe project is the first step of the process of analyzing mainframe resources. Mainframe projects are created in IBM AD Build, see IBM AD Build Client User Manual for details on how to create a mainframe project.

Importing a Shared Project from AD Analyze Server

Use this option to import a project that is shared on AD Analyze Server into IBM AD Analyze Client.

About this task

In multi-user installations of IBM AD Analyze Client, all shared projects are registered on an IBM AD Analyze Server. Shared projects are created by one client and then accessed by other clients for analysis purpose. In order to access such projects, the user has to import them.

Procedure

1. To start an import, right-click in the AD Navigator window and choose Import to display the Import dialog window as in the following image.
Figure 22: Import project wizard

Under Application Discovery Analyze, select Import shared projects and press Next.

2. The Import shared projects dialog is displayed.
In the Import shared projects dialog, verify that a server name is displayed. In case you didn’t define any server yet, click the link Server Settings Configuration. The Server Settings tab from the Preferences window is displayed. Define a server, test the connection, set it as a default server, and press OK (for details on how to add servers, see Server Settings).

Next, press Get projects. In case the connection to the server can be established, and on the server there are projects that weren’t imported so far to your local IBM AD Analyze Client, a list of projects appears. Select the project that you want to import and press Finish.

**Working With Resources From Remote Systems**

**Integrating IBM AD Analyze Client with IDz features**

When IBM AD Analyze Client is installed together with IDz, a contextual menu entry (Application Discovery > Analyze) is available in IDz views, allowing the user to run AD analyzes.

The contextual menu is available for the following types of resources:

1. From the Remote Systems view:
   - PDS
   - PDS Member
   - Sequential Data Set
   - VSAM Data Set
2. From the Local Transactions view:
   - CICS Transactions
3. From the **Data Source Explorer** view:
   - SQL tables

4. From various **CICS Interdependency Analyzer (IA)** views, for example **Programs** or **Command flow**:
   - Programs

Once the action is selected, you are prompted to choose the **AD Project** that is used for analysis. Click **Next** and choose the analysis that you want to perform. Once you click **Finish** the results are displayed in AD perspective.

---

**Analyzing Resources From a Remote Mainframe System**

To start an analysis on a resource from a remote mainframe system follow these steps:

1. Create a project in **IBM AD Build** and bring resources from the mainframe system:
   a. In **IBM AD Build Client**: Create a project.
   b. In **IBM AD Build Configuration**:
      - Create a z/OS connection.
      - Associate the z/OS connection to your project.
      - Configure the z/OS connection.
   c. In **IBM AD Build Client**:
      - Bring resources from the remote mainframe system by using the defined z/OS connection.
      - Build your project. For details on how to create a project in **IBM AD Build**, and how to bring resources from mainframe systems, see **IBM AD Build Client and Server User Guide**.

   Once you completed these steps, when you open your **IBM AD Analyze Client** the new project is available in the projects list in the **Explore projects** tab of **AD Explore** view (to make sure that the project list is up-to-date, right-click in the projects list and select **Refresh project list**).

2. In your **IBM AD Analyze Client**, define a connection to the remote mainframe system. For details on how to create a connection to a remote system, see the IDz documentation.

3. Once the connection to the remote mainframe system was established, and you can see it in the **Remote Systems** view, set up a filter to make it easier to locate your sources. For details on how to create a filter, see the IDz documentation.

4. In the corresponding view from IDz, right-click the resource that you want to analyze, and from the pop-up menu select the **Application Discovery > Analyze**. The wizard dialog is displayed showing a list of projects that are found on **IBM AD Analyze Server**.
5. Select the mainframe project that contains the resource you want to analyze and click **Next**.

6. The **Select** available analysis dialog window is displayed.

The analyzes that can be performed on the resource that is selected from the remote system are displayed.
From the analysis that is generated in this way, you have the option to view the contents of a selected resource directly on the remote mainframe system, by selecting an element from the graph, and then **right click > View analysis source**. The contents of the selected resource are displayed in the **Editor** view and the tooltip displays the full path to the resource location on the mainframe.

**Viewing Resources From an Endevor Remote System**

When you work with resources that are hosted on an Endever Remote System, security restrictions might prevent you from seeing the contents of those resources in the Editor view. **IBM AD Analyze** is able to generate all the analyses for those resources, but to view their contents in the **Editor** view, you must set up a connection to the Endevor Remote System.

**Before you begin**

When the users work with mainframe resources of Endevor type, in order to view the contents of the resources in the Editor view they must set up a CARMA connection.

**Note:** To set up a CARMA connection, you need to have the CARMA feature installed either on RDz or IDz platform. During the installation process of **IBM AD Analyze Client** the **Application Discovery integration with Common Access Repository Manager (CARMA)** feature needs to be selected.

Let’s assume you already have a project with sources brought from a remote mainframe system using the Endevor feature. You generate a graph, you select an element from the graph, and you want to see the contents of the selected resource in the Editor view. Right-click and from the shortcut menu select **View Analysis Source**.

If you didn't create a CARMA connection to the remote mainframe system, a warning message informs you that the selected resource cannot be accessed.

If you created one or several CARMA connections to the remote mainframe system, a list of available connections is displayed. Select which connection you want to use in order to view the contents the selected resource in the Editor view. The tooltip of the Editor view displays the details of the CARMA connection that was used to show the contents of the resource.

Below are the steps that must be taken in order to view the resource contents in the **Editor** view.

**About this task**

This task presents the steps that must be performed in order to see in the Editor view a resource from a remote Endevor system.

**Procedure**

1. Create a project in **IBM AD Build** and bring resources from the remote Endevor system:
   a) In **IBM AD Build Client**: Create a project.
   b) In **IBM AD Build Configuration**:
      - Create a z/OS connection.
      - Associate the z/OS connection to your project.
      - Configure the z/OS connection for the Endevor system (the ENDEVOR Info tab).
   c) In **IBM AD Build Client**:
      - Bring resources from the remote Endevor system using the defined z/OS connection;
      - Build your project. For details on how to create a project in **IBM AD Build**, and how to bring resources from Endevor systems, see **IBM AD Build Client and Server User Guide**.

2. In your **IBM AD Analyze Client**, define a CARMA connection to the remote Endevor system. When you set up the CARMA connection, make sure that to choose a user with access rights. For details on how
to create a connection to a remote system, see the IDz or RDz documentation. For details on the supported versions, see Prerequisite Software and Configurations.

3. In your IBM AD Analyze Client, locate the wanted resource using the Explore Project tab and double-click it to display its contents in the Editor view. Alternatively you can generate a graph and select from the graph the element you want see in the Editor view. Right-click and from the pop-up menu select View Analysis Source.

Checking the Connection to the Project Database

About this task
Steps that must be performed in order to check the connection to the project database.

Procedure
1. To check the connection to the database, from IBM AD Client select Application Discovery > Project Database Connection Test.

   ![Figure 24: Select projects for which to check the connection with the database](image)

2. The Project Database Connection Test wizard is displayed showing a list of projects that were identified on the server. Use the arrow buttons to move the projects from the Available list to the Selected then press Next.

3. The Test Results dialog window of the wizard presents the results of the test. For each of the selected projects the following information is displayed: project name, project database name, status of the connection, test result message text. Project Database Connection Test option is useful when you work with many projects: if, for example, you forgot the name of the database you associated to your project, you can use this option to identify the wanted database.
Building an AD Java Project

About this task

A “build” is the process in which IBM AD Analyze Client reads the project sources, places the results in the project repository, and generates the data for displaying graphical representations of the application’s internal and external program relationships.

The build process can be executed on individual programs in the project, or on all of them together. Generally, a global build is performed, but if, for example, only a single source file was changed, a build on that file alone is appropriate. In this case, only this program is analyzed and the project repository is updated. Eclipse also has an option to keep the repository up-to-date by switching on the option of an Automatic build. When this option is switched on, any update to the sources of the project triggers a build process to update the repository. In addition, when this option is switched on, the possibility of building the project manually is disabled. For details on the Automatic build option, see the IDz/Eclipse help files.

To build a project:

Procedure

1. In your IBM AD Analyze Client, select the project that you want to build.
2. From the Project menu, select one of the Build options:
   - **Build All**, build all open projects.
   - **Build Project**, build the current project.
   - **Build Working Set**, build the current working set.
3. The build process starts. As each file is processed, its name and accompanying notes and messages, including error notifications, are displayed in the IBM AD Analyze Client Message Board. The Progress tab, and the message Sequential Build (100%) together with a Progress bar are presented in the right corner of the Status bar. The build is performed in the background. Click the Progress icon to show the build’s progress bar. Click the Problems tab to view any problems that might have occurred during the build. On completion of the build, you can double-click any of these messages in order to open the corresponding source file at the appropriate line. See Problems View in Eclipse help for details on the Problems tab.
4. To update the project after several sources were changed, select the file or files to be built then right-click and select **Build Selection**.

Analyzing a Project

On completion of the build process, different functions can be performed.

- Graphically displaying the interrelations between all application entities, and/or the internal relationships within individual programs. These functions are automatically enabled after a build. For more information on the graphs which can be generated, see Chapter 6, “Graphs,” on page 63.
- Viewing and editing the application’s source files. For more information on how to find a specific source file, see Explore Project.
- Producing different types of reports to analyze the data. For details, see Chapter 7, “Reports,” on page 91.
- Searching the source files for specific text strings. See Search in Files tab for details.
Chapter 6. Graphs

Mainframe Graphs and Layouts

A-AUTO Graph

The A-AUTO Graph presents Networks dependencies relationships and Jobs relationship inside a Network or several Networks.

If A-AUTO dataset flag information is available in the project, triggering relationships are also presented in this graph. The A-AUTO dataset flag is a mechanism that allows a Job to trigger an A-AUTO network execution by setting a dataset-related flag, thus linking one network in which this Job was executing to a second network. Networks can reside in the current project or in other mainframe z/OS projects. The A-AUTO dataset flag information is available in a report that is used in the project building process, in IBM AD Build Client. For details, see IBM AD Build Client and Server User Guide.

To display the A-AUTO graph, in Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select the project that contains the resource for which you want to generate an A-AUTO graph. For details on perspectives and their components, see IBM AD Analyze Client Reference.

In the Mainframe Graphs section, to the right of the Explore Projects view, double-click A-AUTO Graph. The A-AUTO Graph Analysis wizard is displayed.

Select the starting point of the analysis - job or network - then make your choices in the Graph options area. By default, the graph analysis depth is limited to three levels. The direction of the analysis is forward and the network nodes are collapsed. Modify according to needs, then click Next to display the second dialog window of the wizard.

The Available jobs(networks) area displays the resources available for graph generation. Use the Name field to filter the contents of the list. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish.

If the direction selected for the analysis is either backward or both (backward and forward), an extra dialog window is available in the wizard that allows the selection of projects where to look for triggered networks.

Important: This list contains only mainframe z/OS projects. In order to see results, make sure that you select projects that contain the same Dataset flag report file that is used for A-AUTO dataset flag mechanism. See IBM AD Build Client and Server User Guide for details on how to include a Dataset flag report in the build process.

AD Graphs tab displays the generated graph. To navigate the graph, use the buttons in the graph toolbar, which is located in the upper right corner of the screen. For details, see Graphical Analysis Toolbar. To show details on the meaning of the elements of the graph, use the Legend button. For details on the graph legend, see Showing the Graph Legend.

If the direction selected for the analysis is forward, the generated graph has the following characteristics:

• Input networks are expanded by default. The rest of the networks are collapsed; networks that are linked only by triggering relationships cannot be expanded.
• Input networks names are displayed in blue in the graph and in the Graph Inventory window.
• The same icon type is used for all identified networks regardless of whether they reside in the current project or not.
If the direction selected for the analysis is backward, the generated graph has the following characteristics:

- Input networks are expanded by default. The rest of the networks are collapsed.
- In the context of A-AUTO dataset flag mechanism, networks that reside in other projects can be expanded but display only the JCLs that contain the flag that triggered the network.
- Input networks names are displayed in blue in the graph and in the Graph Inventory window.
- Special icons are used to mark the networks that reside in projects other than the current one.
- If more than one project was used as input, in the Graph Inventory window the networks are grouped according to the project where they reside.

By default, a limit icon marks the nodes for which further analysis results are not displayed because of the limit set in the wizard. (highlight results that are cut short by the threshold option checked in Analysis Expansion Limit tab from Preferences window). If highlight results... option is not checked, all nodes that reach the level limit set in the wizard are marked with a limit icon regardless of whether further analysis results are available or not. The same criteria apply for displaying the limit icon in the Graph Inventory window.

AD Graph Overview window in the upper left corner of the screen presents an overview of the entire graph, which is useful when you work with large graphs. For details, see AD Graph Overview Window.

AD Graph Inventory pane presents a list of all the elements in the graph. For details, see AD Graph Inventory View. In the Graph Inventory window, a limit icon is displayed in front of the networks on which a depth limitation is set from the wizard.

The Properties window displays the properties of the element selected from the graph. For details, see Properties View.

Use Export Graph and Print (from the Eclipse toolbar) to export the graph to a portable format or print it. For details, see the sections Exporting the Graph and Printing the Graph.

**A-AUTO graph element pop-up menu**

Right-click an element from the A-AUTO Graph to display the pop-up menu.

The options available in the pop-up menu depend on the type of element that is selected from the graph. Options available for all element types: View analysis source, Show properties, and Filter. According to the selected element, some or all of the following options might also be available: Annotations, Reports, and Usage analyses. For JCL nodes, View source option is also available.

The Filter options in the pop-up menu allow the user to toggle on/off different elements of the graph.

For details on the options available for all element types, see Graph element pop-up menu.

**API Call Graph**

API Call Graph can be used to visualize details about the implementation of the selected API or service in a certain project and to have a more detailed view of the implementation down to programs, tables or files.

To display the API Call Graph, go to Application Discovery Browser perspective > Explore APIs > Name list, and then select the API for which one to generate a API Call Graph.

The Available Projects area displays the projects available for graph generation. Select a project, set a calligraph limit then click Finish to generate the API Call Graph.

**Application Master Graph**

Note: This graph is only available for VME projects.

The Application Master Graph presents what elements are included in Application Master environment, as defined by the DDCL file.
The graph can contain the following DDCL Element types: TP-service, Application, Dialog, Exchange, Component, Module, Report-program, Batch-program, Screen, File, Report (when called by Report-Programs), Record, and Set (these elements appear in the graph, but are not available as input type when the user starts the analysis).

To display the Application Master Graph, go to Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select the project that contains the resource for which you want to generate an Application Master Graph. For details on perspectives and their components, see IBM AD Analyze Client Reference.

In the Mainframe Graphs section to the right of the Explore Projects view, double-click Application Master to display the Application Master Graph Analysis wizard.

The Available DDCL Elements area displays the resources available for graph generation. To filter the available resources, click one of the buttons to the left of the list to display only certain types of resources. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. Use the Name field to filter the contents of the list. Use the arrow buttons to move the resources between the Available and Selected lists then select the Call direction. By default, the graph analysis depth is limited to three levels. Modify if needed, then click Finish.

AD Graphs tab displays the generated graph. To navigate the graph, use the buttons in the graph toolbar, which is located in the upper right corner of the screen. For details, see “Graphical Analysis Toolbar” on page 40.

To show details on the meaning of the elements of the graph, use the Legend button. For details on the graph legend, see Showing the Graph Legend.

AD Graph Overview window in the upper left corner of the screen presents an overview of the entire graph, which can be useful when you work with large graphs. For details, see AD Graph Overview Window.

AD Graph Inventory pane presents a list of all the elements in the graph. For details, see AD Graph Inventory View.

The Properties window displays the properties of the element that is selected from the graph. For details, see Properties View.

Use Export Graph and Print (from the Eclipse toolbar) to export the graph to a portable format or print it. For details, see Exporting the Graph and Printing the Graph.

Application master graph element pop-up menu

Right-click on an element from the Application Master Graph to display the pop-up menu.

The options available in the pop-up menu depend on the type of element that selected from the graph. Here are the options available for all element types: View analysis source, Show properties, and Filter.

According to the selected element, some or all of the following options might also be available: Annotations, Reports, and Usage analyses.

The Filter options in the pop-up menu allow the user to toggle on/off different elements of the graph.

For details on the options available for all element types, see Graph element pop-up menu.

CA7 Job Triggering Flow

The CA7 Job Triggering Flow graph shows the scheduling graph starting from the selected job.

To display the CA7 Job Triggering Flow graph, in Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select the project that contains the resource for which you want to generate a CA7 Job Triggering Flow graph. For details on perspectives and their components, see IBM AD Analyze Client Reference.

In the Mainframe Graphs section, to the right of the Explore Projects view, double-click CA7 Job Triggering Flow to display the CA7 Job Triggering Flow wizard.
The Available CA7 Jobs area displays the CA7 jobs available for graph generation. Use the Name field to filter the contents of the list. Select a job from the list then press Next to display the second dialog window of the wizard.

The Available Schedule IDs area displays all the schedule IDs available for the CA7 job that was selected in the previous dialog of the wizard. Select one of the available Schedule IDs and the display Options then press Finish.

AD Graphs tab displays the generated graph. To navigate the graph, use the buttons in the graph toolbar, which is located in the upper right corner of the screen. For details, see Graphical Analysis Toolbar. To show details on the meaning of the elements of the graph, use the Legend button. For details on the graph legend, see Showing the Graph Legend.

AD Graph Overview window, in the upper left corner of the screen, presents an overview of the entire graph, which is useful when you work with large graphs. For details, see AD Graph Overview Window.

AD Graph Inventory pane presents a list of all the elements in the graph. For details, see AD Graph Inventory View.

The Properties window displays the properties of the element that is selected from the graph. For details, see Properties View.

Use Export Graph and Print (from the Eclipse toolbar) to export the graph to a portable format or print it. For details, see the sections Exporting the Graph and Printing the Graph.

CA7 Job Triggering flow graph element pop-up menu

Right-click on an element from the CA7 Job Triggering Flow Graph to display the pop-up menu.

The options available in the pop-up menu depend on the type of element selected from the graph. Here are the options available for all element types: View analysis source, Show properties, and Filter.

According to the selected element, some or all of the following options might also be available: Annotations, Reports, and Usage analyses.

The Filter options in the pop-up menu allow the user to toggle on/off different elements of the graph.

For details on the options available for all element types, see Graph element pop-up menu.

CA7 Paths

The CA7 Paths graph shows the scheduling path between two selected jobs.

To display the CA7 Paths graph, in Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select the project that contains the resource for which you want to generate a CA7 Paths graph. For details on perspectives and their components, see IBM AD Analyze Client Reference.

In the Mainframe Graphs section, to the right of the Explore Projects view, double-click CA7 Paths to display the CA7 Paths wizard.

The Available CA7 Jobs for first job and Available CA7 Jobs for last job areas display the CA7 jobs available for graph generation. Use the Name field at the bottom of the list to filter the contents of a list. Select a start job and an end job from the lists then press Next to display the second dialog window of the wizard.

The Available Schedule IDs area displays schedule IDs for the job that was selected as starting point. Select one of the available schedule IDs and the display Options then press Finish.

AD Graphs tab displays the generated graph. To navigate the graph, use the buttons in the graph toolbar, which is located in the upper right corner of the screen. For details, see Graphical Analysis Toolbar. To show details on the meaning of the elements of the graph, use the Legend button. For details on the graph legend, see Showing the Graph Legend.

AD Graph Overview window presents an overview of the entire graph, which can be useful when you work with large graphs. For details, see AD Graph Overview Window.
AD Graph Inventory pane presents a list of all the elements in the graph. For details, see AD Graph Inventory View.

The Properties window displays the properties of the element that is selected from the graph. For details, see Properties View.

Use Export Graph and Print (from the Eclipse toolbar) to export the graph to a portable format or print it. For details, see the sections Exporting the Graph and Printing the Graph.

**CA7 Paths graph element pop-up menu**

Right-click on an element from the CA7 Paths graph to display the pop-up menu.

The options available in the pop-up menu depend on the type of element selected from the graph. Here are options available for all element types: View analysis source, Show properties, and Filter. According to the selected element, some or all of the following options might also be available: Annotations, Reports, and Usage analyses.

The Filter options in the pop-up menu allow the user to toggle on/off different elements of the graph. For details on the options available for all element types, see Graph element pop-up menu.

**Cross Application Callgraph**

For cross-project analyses within the mainframe-based projects that follow API calls between projects, use the Cross Application Callgraph.

The Cross Application Callgraph shows applications and their dependencies without inner control flow. It is similar to the Shared Resources Graph. However, the Cross Application Callgraph does not follow or show the sharing of data sources. It is based on control flow, which means calls to programs or transactions, while the Shared Resources Graph is based on data sharing.

Only the mainframe projects from the workspace that has the graph database are considered for a Cross Application Callgraph analysis. It can start on one or multiple mainframe projects. The analysis purpose is to compute and display the high-level connections between projects through the following API external calls in a graphical way:

- The call to a program that is matched against the application name.
- The call to a program that is matched against the CICS region name.
- The call to a transaction that is matched against the application name.
- The call to a transaction that is matched against the CICS region name.

**Dataset Flow**

The Dataset Flow graph shows the data flow within a batch process, starting from a physical dataset. The starting dataset can be at the start of the process (forward data flow), at the end of the data flow (backward data flow) or in the middle of it (backward and forward data flow).

To display the Dataset Flow graph, in Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select the project that contains the resource for which you want to generate a Dataset Flow graph. For details on perspectives and their components, see IBM AD Analyze Client Reference.

In the Mainframe Graphs section to the right of the Explore Projects view double-click Dataset Flow to display the Data Flow Through Physical Dataset Analysis wizard.

The Available Datasets area displays the datasets available for graph generation. Use the Name field to filter the contents of the list. Use the arrow buttons to move the datasets between the Available and Selected lists. By default, the graph analysis depth is not limited and the direction of the analysis is forward. Modify according to needs then click Next to display the second dialog window of the wizard.
Select the datasets for which the subsequent tree must be excluded from the graph. The "excluded" datasets are displayed in the graph with a funnel icon that indicates that the subsequent tree was excluded from the graph. Then, press Finish to generate the graph.

**AD Graphs** tab displays the generated graph. To navigate the graph, use the buttons in the graph toolbar. For details, see Graphical Analysis Toolbar. To show details on the meaning of the elements of the graph, use the Legend button. For details on the graph legend, see Showing the Graph Legend.

By default, a limit icon marks the nodes for which further analysis results are not displayed because of the limit set in the wizard. ([**highlight results that are cut short by the threshold**] option checked in Analysis Expansion Limit tab from Preferences window). If [**highlight results**... option is not checked, all nodes that reach the level limit set in the wizard are marked with a limit icon regardless of whether further analysis results are available or not. The same criteria apply for displaying the limit icon in the Graph Inventory window.

**AD Graph Overview** window presents an overview of the entire graph, which can be useful when you work with large graphs. For details, see AD Graph Overview Window.

**AD Graph Inventory** pane presents a list of all the elements in the graph. For details, see AD Graph Inventory View.

The Properties window displays the properties of the element that is selected from the graph. For details, see Properties View.

Use Export Graph and Print (from the Eclipse toolbar) to export the graph to a portable format or print it. For details, see the sections Exporting the Graph and Printing the Graph.

**Dataset Flow graph element pop-up menu**

Right-click on an element from the dataset flow graph to display the pop-up menu.

The options available in the pop-up menu depend on the type of element that selected from the graph. Options available for all element types include View analysis source, Show properties, and Filter.

According to the selected element, some or all of the following options might also be available: Annotations, Reports, and Usage analyses.

The Filter options in the pop-up menu allow the user to toggle on/off different elements of the graph. For details on the options available for all element types, see Graph element pop-up menu.

**Flow Chart**

The statement Flow Chart shows the structure of the program on a statement level in flowchart format.

To display the Flow Chart, in Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select the project that contains the resource for which you want to generate a Flow Chart. For details on perspectives and their components, see IBM AD Analyze Client Reference.

In the Mainframe Graphs section to the right of the Explore Projects view double-click Flow Chart to display the Flow Chart Analysis wizard.

The Available Programs area displays the resources available for graph generation. Use the Name field to filter the contents of the list. To display the full name of the resource type, click the white arrow button to the left of the dialog window. Select the resource for which you want to generate the Flow Chart then click Finish.

**AD Graphs** tab displays the generated graph. To navigate the graph, use the buttons in the graph toolbar, which is located in the upper right corner of the screen. For details, see Graphical Analysis Toolbar.

To show details on the meaning of the elements of the graph, use the Legend button. For details on the graph legend, see Showing the Graph Legend.

**AD Graph Overview** window presents an overview of the entire graph, which can be useful when you work with large graphs. For details, see AD Graph Overview Window.
AD Graph Inventory pane presents a list of all the elements in the graph. For details, see AD Graph Inventory View.

The Properties window displays the properties of the element that is selected from the graph. For details, see Properties View.

Use Export Graph and Print (from the Eclipse toolbar) to export the graph to a portable format or print it. For details, see the sections Exporting the Graph and Printing the Graph.

Flowchart element pop-up menu
Right-click on an element from the flowchart to display the pop-up menu.

The options available in the pop-up menu depend on the type of element that is selected from the graph. Options available for all element types include Show properties, and Filter. According to the selected element, Go to source option can also be available.

The Filter options in the pop-up menu allow the user to toggle on/off different elements of the graph. For details on the options available for all element types, see Graph element pop-up menu.

Job Call Graph
The Job Call Graph shows the global relationships between a selected JCL and other components of the project.

To display the Job call graph, in Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select the project that contains the jobs for which you want to generate a Job call graph. For details on perspectives and their components, see IBM AD Analyze Client Reference.

In the Mainframe Graphs section, to the right of the Explore Projects view, double-click Job call graph to display the Job call graph wizard.

The Available Jobs area displays the resources available for graph generation. Use the Name field to filter the contents of the list. Use the arrow buttons to move the resources between the Available and Selected lists. By default, the graph is limited to three levels. Modify if applicable then click Finish.

AD Graphs tab displays the generated graph. Input nodes are displayed in blue. To navigate the graph, use the buttons in the graph toolbar. For details, see Graphical Analysis Toolbar. To show details on the meaning of the elements of the graph, use the Legend button. For details on the graph legend, see Showing the Graph Legend.

Note: For large, complex graphs you can choose to restrict the number of programs displayed. You can specify a program beyond which subsequent programs must not be displayed. According to the type of database used for the projects, restricted nodes are displayed differently. When working with graph database, restricted graph nodes are displayed in red and marked with a specific icon - a funnel. When working with SQL database, restricted nodes are displayed in red. Restrictions can be defined from Preferences window, for details on how to set these restrictions, see Call graph restrictions.

By default, a limit icon marks the nodes for which further analysis results are not displayed because of the limit set in the wizard. (highlight results that are cut short by the threshold option checked in Analysis Expansion Limit tab from Preferences window). If highlight results... option is not checked, all nodes reaching the level limit set in the wizard are marked with a limit icon regardless of whether further analysis results are available or not. The same criteria apply for displaying the limit icon in the Graph Inventory window.

AD Graph Overview window presents an overview of the entire graph, which can be useful when you work with large graphs. For details, see AD Graph Overview Window.

AD Graph Inventory pane presents a list of all the elements in the graph. For details, see AD Graph Inventory View.

Input nodes are displayed in blue.
**Note:** In the Graph Inventory window the names of the restricted nodes are displayed differently according to the database used for the projects. When working with graph database, restricted graph nodes are displayed in red and marked with a specific icon - a funnel. When working with SQL database, restricted nodes are displayed in red. Restrictions can be defined from Preferences window, for details on how to set these restrictions see Call graph restrictions.

The **Properties** window displays the properties of the element that is selected from the graph. For details, see Properties View.

Use **Export Graph** and **Print** (from the Eclipse toolbar) to export the graph to a portable format or print it. For details, see the sections Exporting the Graph and Printing the Graph.

**Supported resource types for API calls**
For the resource types that are supported for API calls, go to section Supported resource types for API calls in topic Program Callgraph.

**Job Call graph element pop-up menu**
Right-click on an element from the Job call graph to display the pop-up menu.

The options available in the pop-up menu depend on the type of element selected from the graph. Options available for all element types include View analysis source, Show properties, and Filter.

According to the selected element, some or all of the following options might also be available: Annotations, Reports, and Usage analyses.

The Filter options in the pop-up menu allow the user to toggle on/off different elements of the graph.

For details on the options available for all element types, see Graph element shortcut menu.

**Job Flow**
The Job Flow graph shows the sequence of steps within the selected job.

To display the Job Flow graph, in Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select the project that contains the job for which you want to generate a Job Flow graph. For details on perspectives and their components, see IBM AD Analyze Client Reference.

In the Mainframe Graphs section, to the right of the Explore Projects view, double-click Job Flow to display the Job Flow graph wizard.

The Available Jobs area displays the resources available for graph generation. Use the Name field to filter the contents of the list. Select a job from the list then click Finish.

AD Graphs tab displays the generated graph. To navigate the graph, use the buttons in the graph toolbar. For details, see Graphical Analysis Toolbar. To show details on the meaning of the elements of the graph, click Legend. For details on the graph legend, see Showing the Graph Legend.

AD Graph Overview window presents an overview of the entire graph, which can be useful when you work with large graphs. For details, see AD Graph Overview Window.

AD Graph Inventory pane presents a list of all the elements in the graph. For details see, AD Graph Inventory View.

The Properties window displays the properties of the element that is selected from the graph. For details, see Properties View.

Use Export Graph and Print (from the Eclipse toolbar) to export the graph to a portable format or print it. For details, see the sections Exporting the Graph and Printing the Graph.

**Job Flow graph element pop-up menu**
Right-click on an element from the Job Flow Graph to display the pop-up menu.
The options available in the pop-up menu depend on the type of element that is selected from the graph. Options available for all element types include **Show properties** and **Filter**.

The **Filter** options in the pop-up menu allow the user to toggle on/off different elements of the graph. For details on the options available for all element types, see *Graph element pop-up menu*.

**Layouts**

The Layouts graph allows the user to view the layout of the screen as it appeared in its original system.

To display the Screen Layout, go to Application Discovery Browser perspective, and select **Projects list > project** that contains the screen for which you want to see the layout. For details on perspectives and their components, see *IBM AD Analyze Client Reference*.

In the **Layouts** section to the right of the Explore Projects view double-click **Screen Layout**, the Screen Layout wizard is displayed. Select the screen for which you want to see the layout then press **Finish**. To display the full name of the resource type, click the white arrow button to the left of the dialog window.

**Mainframe Layout**

The Mainframe Layout graph shows the mainframe landscape including CPU, Sysplex, LPAR, installed subsystems (Db2®, CICS, MQ, Control-M, IMS, Natural, Adabas, and so on), and devices (Tapes, Printers, Disks).

To display the Mainframe Layout, in Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select the project for which you want to generate a Mainframe Layout graph. For details on perspectives and their components, see *IBM AD Analyze Client Reference*.

In the Mainframe Graphs section, to the right of the Explore Projects view, double-click Mainframe Layout. **AD Graphs** tab displays the generated graph. To navigate the graph, use the buttons in the graph toolbar. For details, see *Graphical Analysis Toolbar*. To show details on the meaning of the elements of the graph, use the **Legend** button. For details on the graph legend, see *Showing the Graph Legend*.

AD Graph Overview window presents an overview of the entire graph, which can be useful when you work with large graphs. For details, see *AD Graph Overview Window*.

**AD Graph Inventory** pane presents a list of all the elements in the graph. For details, see *AD Graph Inventory View*.

The Properties window displays the properties of the element that is selected from the graph. For details, see *Properties View*.

Use **Export Graph** and **Print** (from the Eclipse toolbar) to export the graph to a portable format or print it. For details, see the sections *Exporting the Graph* and *Printing the Graph*.

**Mainframe Layout graph element pop-up menu**

Right-click on an element from the Mainframe Layout graph to display the pop-up menu.

The options available in the pop-up menu depend on the type of element that is selected from the graph. Options available for all element types include **Show properties** and **Filter**. Use the **Show properties** option to display important information about the Mainframe components in the Properties window.

The **Filter** options in the pop-up menu allow the user to toggle on/off different elements of the graph. For details on the options available for all element types, see *Graph element pop-up menu*.

**Program Callgraph**

The **program callgraph** shows the global relationships between a selected program and other components of the project.

**Note:** The graph wizard is presented in detail only in this section. For all the other graphs, only the specific options are presented in the respective sections.
To display the **program callgraph**, in Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select the project that contains the resource for which you want to generate a **program callgraph**. For details on perspectives and their components, see *IBM AD Analyze Client Reference*.

In the **Mainframe Graphs** section, to the right of the Explore Projects view, double-click **Program Callgraph** to display the wizard as in the following image.

![Program callgraph wizard](image)

**Figure 25: Program callgraph wizard**

The Available Programs area displays the resources available for graph generation. To filter the available resources, click one of the buttons to the left of the list to display only certain types of resources. Place the cursor over an icon to display a tooltip about the type of resource it will display and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. Use the **Name** field to filter the contents of the list. Use the arrow buttons to move the resources between the Available and Selected lists. Then select the **Call direction**, that is, whether you want to see the programs and resources that are being called by the program (Forward), or those that call the program (Backward) or both. By default, the graph is limited to three levels. Modify if applicable then click **Next**.
The second dialog window of the wizard displays a list of children available in the selected programs. Select the children that you want to include in the graph then click **Finish** to generate the program callgraph.

**AD Graphs** tab presents the generated graph. Input nodes are displayed in blue. To navigate the graph, use the buttons in the graph toolbar, which is located in the upper right corner of the screen. (For details see Graphical Analysis Toolbar). To see details on the meaning of the elements of the graph, use the **Legend** button. For details on the graph legend function, see Showing the Graph Legend.

**Note:** For large, complex graphs you can choose to restrict the number of programs displayed: you can specify a program beyond which subsequent programs must not be displayed. According to the type of database used for the projects, restricted nodes are displayed differently. When working with graph database, restricted graph nodes are displayed in red and marked with a specific icon - a funnel. When working with SQL database, restricted nodes are displayed in red. Restrictions can be defined from Preferences window, for details on how to set these restrictions, see Call graph restrictions.

By default, a limit icon marks the nodes for which further analysis results are not displayed because of the limit set in the wizard. (**highlight results that are cut short by the threshold** option checked in Analysis Expansion Limit tab from Preferences window). If **highlight results**... option is not checked, all nodes that reach the level limit set in the wizard are marked with a limit icon regardless of whether further analysis results are available or not. The same criteria apply for displaying the limit icon in the Graph Inventory window.

**AD Graph Overview window** in the upper left corner of the screen presents an overview of the entire graph, which is useful when working with large graphs. For details, see AD Graph Overview Window.

**AD Graph Inventory view** presents a hierarchical list of all the elements in the graph. For details, see AD Graph Inventory View. Input nodes are displayed in blue.

**Note:**
In the **Graph Inventory** window, the names of the restricted nodes are displayed differently according to the database used for the projects. When working with graph database, restricted graph nodes are displayed in red and marked with a specific icon - a funnel. When working with SQL database, restricted nodes are displayed in red. Restrictions can be defined from Preferences window, for details on how to set these restrictions, see [Call graph restrictions](#).

The Properties view displays the properties of the element that is selected from the graph. For details, see [Properties View](#).

**Supported resource types for API calls**

In a program callgraph, if the extensibility feature is enabled, the following resource types are supported for API calls:

<table>
<thead>
<tr>
<th>Resource type</th>
<th>Statement</th>
<th>Location</th>
<th>Call direction</th>
<th>Expanding to other projects</th>
</tr>
</thead>
<tbody>
<tr>
<td>CICS screen</td>
<td>CICSReceiveMap</td>
<td>N/A</td>
<td>Forward Backward Both forward and backward</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>CICSSendMap</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CICS transaction</td>
<td>CICS Return</td>
<td>CICS region</td>
<td>Forward Backward Both forward and backward</td>
<td>Supported</td>
</tr>
<tr>
<td></td>
<td>CICS Start</td>
<td>Application</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COBOL program</td>
<td>Call</td>
<td>CICS region</td>
<td>Forward Backward Both forward and backward</td>
<td>Supported</td>
</tr>
<tr>
<td></td>
<td>Application</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>File</td>
<td>CICS File Delete</td>
<td>N/A</td>
<td>Forward Backward Both forward and backward</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>CICS File Read</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CICS File Rewrite</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CICS File Write</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>File Delete</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>File Read</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>File Rewrite</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>File Write</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IMS screen</td>
<td>IMSReceiveMap</td>
<td>N/A</td>
<td>Forward Backward Both forward and backward</td>
<td>Not supported</td>
</tr>
<tr>
<td></td>
<td>IMS function insert (ISRT)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>IMSSendMap</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>IMS function get unique (GU)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 8: Supported resource types for API calls in the program callgraph (continued)

<table>
<thead>
<tr>
<th>Resource type</th>
<th>Statement</th>
<th>Location</th>
<th>Call direction</th>
<th>Expanding to other projects</th>
</tr>
</thead>
<tbody>
<tr>
<td>IMS segment</td>
<td><strong>IMSDBDDelete</strong>&lt;br&gt;IMS function delete (DLET)&lt;br&gt;<strong>IMSDBDInsert</strong>&lt;br&gt;IMS function insert (ISRT)&lt;br&gt;<strong>IMSDBDRead</strong>&lt;br&gt;IMS function get unique (GU)&lt;br&gt;<strong>IMSDBDReadNext</strong>&lt;br&gt;IMS function get next (GN)&lt;br&gt;<strong>IMSDBDUpdate</strong>&lt;br&gt;IMS function replace (REPL)</td>
<td>N/A</td>
<td>Forward Backward Both forward and backward</td>
<td>Not supported</td>
</tr>
<tr>
<td>IMS transaction</td>
<td><strong>IMSStartTransaction</strong></td>
<td>Application</td>
<td>Forward Backward Both forward and backward</td>
<td>Supported</td>
</tr>
<tr>
<td>PL/I program</td>
<td>Call</td>
<td>CICS region Application</td>
<td>Forward Backward Both forward and backward</td>
<td>Supported</td>
</tr>
<tr>
<td>SQL field</td>
<td>SQLInsert SQLSelect</td>
<td>N/A</td>
<td>Forward Backward Both forward and backward</td>
<td>Not supported</td>
</tr>
<tr>
<td>SQL table</td>
<td>SQLDelete SQLInsert SQLSelect SQLUpdate</td>
<td>N/A</td>
<td>Forward Backward Both forward and backward</td>
<td>Not supported</td>
</tr>
</tbody>
</table>

**Note:** The preceding resource types are also supported for API calls in the job callgraph, screen callgraph, and transaction callgraph.

### Graph element pop-up menu

The operations available in the pop-up menu of graph elements depend on the type of element selected. The following options might be available:

- **View analysis source** - opens the analysis source in the Editor window.
  
  **Note:** If the selected resource is on a remote system, additional configurations are needed in order to view its contents in the Editor view. For details, see Working with sources from remote systems.

- **Annotations** - shows the Annotations options available for the selected resource.
- **Complexity Reports** - shows the Complexity reports that can be generated for the selected resource.
- **Dead Code Reports** - shows the Dead Code reports that can be generated for the selected resource.
- **Impact Reports** - shows the Impact reports that can be generated for the selected resource.
- **Inventory Reports** - shows the Inventory reports that can be generated for the selected resource.
- **Mainframe Graphs** - shows the graphs that can be generated for the selected resource.
- **Miscellaneous Reports** - shows the Miscellaneous reports that can be generated for the selected resource.
- **Usage in Jobs** - shows the Usage in Jobs analyses that can be generated for the selected resource.
- **Usage in Programs** - shows the Usage in Programs analyses that can be generated for the selected resource.
- **Where Used Reports** - shows the Where Used reports that can be generated for the selected resource.
- **Show properties** - shows the properties of the selected resource in the Properties window.
- **Filter** - shows the filtering criteria available for the selected resource.

**Graph edge pop-up menu**
Click on an edge from the graph to select it then right-click to display the pop-up menu.

The following options might be available depending on the type of edge selected.

- **Override Resolution** - available only for a red arrow edge (representing a dynamic call) in job callgraph, program callgraph, program flow graph, screen callgraph, and transaction callgraph. Displays the Override Current Resolution dialog. This function is available only for mainframe projects for which a graph database was set up. Currently, the Override Resolution function is implemented only for Cobol and Assembler programs.
- **View analysis source** - opens the analysis source in the Editor window.
- **Show properties** - shows the properties of the selected edge in the Properties window.

**Navigating in the graph**
In addition to the standard horizontal and vertical scroll bars, the Zoom, Pan, and Resize icons can be used to help move around the graph. Also, you can select a node and drag it to a new location. When a node is moved, all the connectors that are attached to it are changed to fit the new location.

**Graph Layout Examples**
In this section, an example of each type of graph layout is presented. The same data is presented in each layout type illustration.
Figure 27: Hierarchical graph layout

Figure 28: Symmetric graph layout
Figure 29: Circular graph layout
Selecting graph elements

You can select multiple elements in the graph by dragging the mouse over the area to be selected. Different operations can then be performed on the selected objects such as printing, exporting.

Printing the graph

For maintenance purposes, the graph can be sent to a printer or to any other printing device connected to your computer.

To print the graph, from IBM AD Analyze client File menu, select Print or press "Ctrl+P".

The Print Manager window appears with the current graph shown. Click Print Setup in the upper left corner of Print Manager window to define the printing settings. Click Print in the upper left corner of Print Manager window to open the standard Windows Print window and print the graph.
Exporting the graph

In addition to printing, the graph can also be exported to different file formats.

To export the graph, from IBM AD Analyze menu, select Export Graph. The Export Graph window appears.

Image Area

In the Type field, select the type of file to be created. Supported types include *.jpg, *.pdf, or *.svg.

In the File Name field, the default file name and location is presented. The default file name is the name of the resource with the extension selected in the Type field. The default location is C:\Program Files \eclipse. Type in a new name for the file if applicable, and click Browse to select a new location for the file.

Image Content Area
Select one of the available options to define the image content.

**Image Quality**
Select one of the available options to define the quality of the exported image. A higher-quality image will, by definition, be larger in file size.

**Size Area**
Select one of the following to determine the size of the exported image:
- **Current Zoom Level**, the image is created at the same zoom level as currently shown in AD Graphs window.
- **Actual Size**, the entire graph is printed at a zoom level of 100% regardless of the zoom level of the graph shown in AD Graphs window.
- **Fit in Canvas**, the image is created with the entire graph shown in one page of the file.
- **Custom**, the image is created in a size specified by the user. Enter the desired width and height for the image, in pixels, in the Width and Height fields.

**Export as CSV file**
*Note: Export as CSV file* option is only available for Program callgraphs generated with forward or backward options. It is NOT available for a Program callgraph generated for both call directions.

Select this option to export the graph as a CSV file. Use **Browse** to select the location where you want to export the graph.

Click **OK** to begin the export operation.

**Program Flow**
The Program Flow graph presents the internal structure for a program, including all referenced files, tables, screens, and other programs.

The following entities are visible depending on the language:
- **Cobol** – Sections, Paragraphs, PERFORM, and PERFORM THROUGH, Fall Through, GOTO, CALL, CICS XCTL, CICS RETURN, CBLTDLI.
- **Natural** – Main, Subroutines, PERFORM, CALL, CALLNAT.
- **PL/I** – Procs, CALL, GOTO, CICS XCTL, CICS LINK, CICS RETURN, PLITDLI.

To display the Program Flow graph, in Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select the project that contains the resource for which you want to generate a Program Flow graph. For details on perspectives and their components, see IBM AD Analyze Client Reference.

In the Mainframe Graphs section, to the right of the Explore Projects view, double-click Program Flow to display the Program Flow wizard.

The Available Programs area displays the resources available for graph generation. To filter the available resources, click one of the buttons to the left of the list to display only certain types of resources. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. Use the **Name** field to filter the contents of the list. Use the arrow buttons to move the resources between the Available and Selected lists. Select a program from the available list then click **Finish**.

**AD Graphs** tab displays the generated graph. To navigate the graph, use the buttons in the graph toolbar. For details, see Graphical Analysis Toolbar. Paragraph names (COBOL) are shown as green rectangles to the left. Colored rectangles on the right represent external entities. The relationships between the paragraphs (for example, GoTo, Entry, Xctl) and external units (BMS map, programs) are denoted by color-coded edges or lines. For details on the meaning of the elements of the graph, use the **Legend** button. For details on the graph legend, see Showing the Graph Legend.
**AD Graph Overview** window presents an overview of the entire graph, which can be useful when you work with large graphs. For details, see AD Graph Overview Window.

**AD Graph Inventory** pane presents a list of all the elements in the graph. For details, see AD Graph Inventory View.

The **Properties** window displays the properties of the element that is selected from the graph. For details, see Properties View.

Use **Export Graph** and **Print** (from the Eclipse toolbar) to export the graph to a portable format or print it. For details, see the sections Exporting the Graph and Printing the Graph.

**Program Flow graph toolbar**

The **Program Flow** Graph toolbar has the following extra icons.

<table>
<thead>
<tr>
<th>Table 9: Program flow graph toolbar</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Button</strong></td>
</tr>
<tr>
<td>Flow Chart</td>
</tr>
<tr>
<td>Change to Resources layout</td>
</tr>
</tbody>
</table>

**Program Flow element pop-up menu**

Right-click on an element from the Program Flow to display the pop-up menu.

The options available in the pop-up menu depend on the type of element that is selected from the graph. Options available for all element types include **Go to source**, **Show properties**, and **Filter**.

The **Filter** options in the pop-up menu allow the user to toggle on/off different elements of the graph.

For details on the options available for all element types, see Graph element pop-up menu.

**Screen Call Graph**

The Screen call graph shows all programs that use a specific screen.

To display the Screen call graph, in Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select the project that contains the screen for which you want to generate a Screen call graph. For details on perspectives and their components, see IBM AD Analyze Client Reference.

In the Mainframe Graphs section, to the right of the Explore Projects view, double-click Screen Call Graph to display the Screen Call Graph wizard.

The Available Screens area displays the resources available for graph generation. To filter the available resources, click one of the buttons to the left of the list to display only certain types of resources. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. Use the **Name** field to filter the contents of the list. Use the arrow buttons to move the resources between the Available and Selected lists then select the **Call direction**. By default, the graph is limited to three levels. Modify if applicable, then click **Finish**.

**AD Graphs** tab displays the generated graph. Input nodes are displayed in blue. To navigate the graph, use the buttons in the graph toolbar. For details, see Graphical Analysis Toolbar. To show details on the
meaning of the elements of the graph, use the **Legend** button. For details on the graph legend, see **Showing the Graph Legend**.

**Note:** For large, complex graphs you can choose to restrict the number of programs displayed. You can specify a program beyond which subsequent programs must not be displayed. According to the type of database that is used for the projects, restricted nodes are displayed differently. When working with graph database, restricted graph nodes are displayed in red and marked with a specific icon - a funnel. When working with SQL database, restricted nodes are displayed in red. Restrictions can be defined from Preferences window, for details on how to set these restrictions, see **Call graph restrictions**.

By default, a limit icon marks the nodes for which further analysis results are not displayed because of the limit set in the wizard. *(highlight results that are cut short by the threshold)* option checked in **Analysis Expansion Limit** tab from Preferences window. If highlight results... option is not checked, all nodes that reach the level limit set in the wizard are marked with a limit icon regardless of whether further analysis results are available or not. The same criteria apply for displaying the limit icon in the Graph Inventory window.

**AD Graph Overview** window presents an overview of the entire graph, which can be useful when you work with large graphs. For details, see **AD Graph Overview Window**.

**AD Graph Inventory** window presents a list of all the elements in the graph. Input nodes are displayed in blue. For details, see **AD Graph Inventory View**.

The **Properties** window displays the properties of the element that selected from the graph. For details, see **Properties View**.

Use **Export Graph** and **Print** (from the Eclipse toolbar) to export the graph to a portable format or print it. For details, see the sections **Exporting the Graph** and **Printing the Graph**.

**Supported resource types for API calls**

For the resource types that are supported for API calls, go to section **Supported resource types for API calls** in topic **Program Callgraph**.

**Screen Call graph element pop-up menu**

Right-click on an element from the Screen call graph to display the pop-up menu.

The options available in the pop-up menu depend on the type of element that is selected from the graph. Options available for all element types include **View analysis source**, **Show properties**, and **Filter**.

According to the selected element, some or all of the following options might also be available: **Reports** and **Usage** analyses.

The **Filter** options in the pop-up menu allow the user to toggle on/off different elements of the graph.

For details on the options available for all element types, see **Graph element pop-up menu**.

**Shared Resources Graph**

This graph will be available after selecting two or more projects.

To display the Shared Resources graph, in Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select the projects for which you want to generate a Shared Resources graph. For details on perspectives and their components, see **IBM AD Analyze Client Reference**.

After selecting two or more projects from the Explore Projects tab, the available graphs, reports, and usage analyses are displayed.

In the Shared Resources section, to the right of the Explore Projects view, double-click **Shared Resources Graph** to display the Shared Resources Graph wizard.

The Available applications area displays the applications available for graph generation in the selected projects. Use the arrow buttons to move the applications between the Available and Selected lists then click **Next** to display the second dialog window of the wizard.
The Available types area displays the types of resources available for graph generation. Use the arrow buttons to move the resource types between the Available and Selected lists then click Finish.

**AD Graphs** tab displays the generated graph. To navigate the graph, use buttons in the graph toolbar. For details, see Graphical Analysis Toolbar. To show details on the meaning of the elements of the graph, use the Legend button. For details on the graph legend, see Showing the Graph Legend.

**AD Graph Overview** window presents an overview of the entire graph, which can be useful when you work with large graphs. For details, see AD Graph Overview Window.

**AD Graph Inventory** pane presents a list of all the elements in the graph. For details, see AD Graph Inventory View.

The Properties window displays the properties of the element that is selected from the graph. For details, see Properties View.

Use Export Graph and Print (from the Eclipse toolbar) to export the graph to a portable format or print it. For details, see the sections Exporting the Graph and Printing the Graph.

**Shared Resources graph element pop-up menu**

Right-click on an element from the Shared Resources Graph to display the pop-up menu.

The options available in the pop-up menu depend on the type of element selected from the graph. Options available for all element types include Show properties and Filter. According to the selected element, Expand or Collapse options might also be available.

The Filter options in the pop-up menu allow the user to toggle on/off different elements of the graph.

For details on the options available for all element types, see Graph element pop-up menu.

**Transaction Call Graph**

The Transaction call graph shows all programs that use a specific transaction.

To display the Transaction call graph, in Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select the project that contains the resource for which you want to generate a Transaction call graph. For details on perspectives and their components, see IBM AD Analyze Client Reference.

In the Mainframe Graphs section, to the right of the Explore Projects view, double-click Transaction call graph to display the Transaction Call Graph wizard.

The Available Transactions area displays the resources available for graph generation. To filter the available resources, click one of the buttons to the left of the list to display only certain types of resources. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. Use the Name field to filter the contents of the list. Use the arrow buttons to move the resources between the Available and Selected lists then select the Call direction. By default, the graph is limited to three levels. Modify if applicable, then click Finish.

**AD Graphs** tab displays the generated graph. Input nodes are displayed in blue. To navigate the graph, use the buttons in the graph toolbar. For details, see Graphical Analysis Toolbar. To show details on the meaning of the elements of the graph, use the Legend button. For details on the graph legend, see Showing the Graph Legend.

**Note:** For large, complex graphs you can choose to restrict the number of programs displayed. You can specify a program beyond which subsequent programs must not be displayed. According to the type of database that is used for the projects, restricted nodes are displayed differently. When working with graph database, restricted graph nodes are displayed in red and marked with a specific icon - a funnel. When working with SQL database, restricted nodes are displayed in red. Restrictions can be defined from Preferences window, for details on how to set these restrictions, see Call graph restrictions.

By default, a limit icon marks the nodes for which further analysis results are not displayed because of the limit set in the wizard. *(highlight results that are cut short by the threshold)* option checked in Analysis.
**Expansion Limit** tab from Preferences window). If **highlight results...** option is not checked, all nodes that reach the level limit set in the wizard are marked with a limit icon regardless of whether further analysis results are available or not. The same criteria apply for displaying the limit icon in the Graph Inventory window.

**AD Graph Overview** window presents an overview of the entire graph, which can be useful when you work with large graphs. For details, see **AD Graph Overview Window**.

**AD Graph Inventory** pane presents a list of all the elements in the graph. Input nodes are displayed in blue. For details, see **AD Graph Inventory View**.

**Note:** In the **Graph Inventory** window, the names of the restricted nodes are displayed differently according to the database that is used for the projects. When working with graph database, restricted graph nodes are displayed in red and marked with a specific icon - a funnel. When working with SQL database, restricted nodes are displayed in red. Restrictions can be defined from **Preferences** window, for details on how to set these restrictions see **Call graph restrictions**.

The **Properties** window displays the properties of the element that is selected from the graph. For details, see **Properties View**.

Use **Export Graph** and **Print** (from the Eclipse toolbar) to export the graph to a portable format or print it. For details, see the sections **Exporting the Graph** and **Printing the Graph**.

**Supported resource types for API calls**
For the resource types that are supported for API calls, go to section **Supported resource types for API calls** in topic **Program Callgraph**.

**Transaction Call graph element pop-up menu**
Right-click on an element from the **Transaction Call Graph** to display the pop-up menu.

The options available in the pop-up menu depend on the type of element that is selected from the graph. Options available for all element types include **Show properties** and **Filter**.

The **Filter** options in the pop-up menu allow the user to toggle on/off different elements of the graph. For details on the options available for all element types, see **Graph element pop-up menu**.

**TWS Graph**
The TWS Graph shows the scheduling graph starting from the selected job or jobs.

To display the TWS Graph, in Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select the project that contains the resource for which you want to generate a TWS Graph. For details on perspectives and their components, see **IBM AD Analyze Client Reference**.

In the Mainframe Graphs section, to the right of the Explore Projects view, double-click TWS Graph to display the TWS Graph wizard.

Use the options in the Input Options area to filter analysis inputs by either job name or application name. Alternatively, you can use the application Validity dates to filter the inputs for the TWS Graph. If no filter criteria is entered, the complete list of applications is presented. In the Graph Options area, use the available options to customize the appearance of the generated graph then press **Next** to display the second dialog window of the wizard.

The Available TWS Applications area displays the applications that are identified within TWS input resources. Use the **Name** field to filter the contents of the list. Use the arrow buttons to move the applications between the Available and Selected lists then click **Next** to display the third dialog of the wizard.

The Available TWS jobs area displays the TWS jobs available in the selected application. Use the **Name** field to filter the contents of a list. Use the arrow buttons to move jobs between the Available and Selected lists then click **Finish**.

**Graphs** 85
To limit the number of applications to be displayed, click **Next** to display a fourth dialog of the wizard. Use the available options to set up the graph restrictions then click **Finish**.

**AD Graphs** tab displays the generated graph. To navigate the graph, use buttons in the graph toolbar. For details, see **Graphical Analysis Toolbar**. To show details on the meaning of the elements of the graph, use the **Legend** button. For details on the graph legend, see **Showing the Graph Legend**.

**AD Graph Overview** window presents an overview of the entire graph, which can be useful when you work with large graphs. For details, see **AD Graph Overview Window**.

**AD Graph Inventory** pane presents a list of all the elements in the graph. For details, see **AD Graph Inventory View**.

The **Properties** window displays the properties of the element that is selected from the graph. For details, see **Properties View**.

Use **Export Graph** and **Print** (from the Eclipse toolbar) to export the graph to a portable format or print it. For details, see the sections **Exporting the Graph** and **Printing the Graph**.

**TWS graph element pop-up menu**

Right-click on an element from the TWS Graph to display the pop-up menu.

The options available in the pop-up menu depend on the type of element that is selected from the graph. Options available for all element types include **Show properties** and **Filter**. According to the selected element, some or all of the following options might also be available: **Collapse ...**, **Reports**, and **Usage** analyses.

The **Filter** options in the pop-up menu allow the user to toggle on/off different elements of the graph.

For details on the options available for all element types, see **Graph element pop-up menu**.

---

**Java Graphs**

**Cross Applications Call Graph**

This graph is used to reveal interfaces and/or code flows between projects. Applications or projects are represented in the graph as nodes, while an edge between two applications represents one or more calls via a given call mechanism or interface type. The purpose of the edges is to show the various ways in which the applications communicate rather than how many calls per interface type. The number of calls represented by a given edge is shown to the user by a number next to the edge or a pop-up hint. The Cross Applications Call Graph can be generated for two projects (Java and mainframe).

To display the Cross Applications Call Graph, in Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select the Java project which contains the resource for which you want to generate a Cross Applications Call Graph. For details on perspectives and their components, see **IBM AD Analyze Client Reference**.

In the Cross Application Graphs section, to the right of the Explore Projects view, double-click Cross Applications Call Graph to display the Cross Applications Call Graph wizard.

A list of pre-defined Method calls is displayed. Use **Add** to add elements to the list if necessary then press **Next** to display the second dialog window of the wizard.

The Mainframe projects area displays the corresponding mainframe projects found on the server. Select one of the available mainframe projects then click **Finish** to generate the graph for the selected Java and mainframe projects.

**AD Graphs** tab displays the generated graph. To navigate the graph use buttons in the graph toolbar. For details, see **Graphical Analysis Toolbar**. To show details on the meaning of the elements of the graph, use the **Legend** button. For details on the graph legend, see **Showing the Graph Legend**.
**AD Graph Overview** window presents an overview of the entire graph, which can be useful when you work with large graphs. For details, see AD Graph Overview Window.

AD Graph Inventory pane presents a list of all the elements in the graph. For details, see AD Graph Inventory View.

The Properties window displays the properties of the element that is selected from the graph. For details, see Properties View.

Use **Export Graph** and **Print** (from the Eclipse toolbar) to export the graph to a portable format or print it. For details, see the sections Exporting the Graph and Printing the Graph.

**Cross Applications Call graph element pop-up menu**

Right-click on an element from the Cross Applications Call Graph to display the pop-up menu.

The options available in the pop-up menu depend on the type of element that is selected from the graph. Options available for all element types include **View analysis source**, **Show properties**, and **Filter**.

According to the selected element, some or all of the following options might also be available: **Annotations**, **Reports**, and **Usage** analyses.

The **Filter** options in the pop-up menu allow the user to toggle on/off different elements of the graph. For details on the options available for all element types, see Graph element pop-up menu.

**Entity Diagram**

The entity diagram presents a diagram for all the classes in the project that contain an @Entity annotation. Each graphic element shown in the Entity Diagram represents a class or a type of relationship within the selected entity. Various operations can be performed on the elements in the Entity Diagram. Some operations are common to all types of elements in all graphs; others only apply to certain types of elements.

To display the Entity Diagram, in Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select the Java project for which you want to generate an Entity Diagram. For details on perspectives and their components, see IBM AD Analyze Client Reference.

In the Java Graphs section, to the right of the Explore Projects view, double-click Entity Diagram. The Entity diagram is presented in **AD Graphs** tab. To navigate the graph, use buttons in the graph toolbar. For details, see Graphical Analysis Toolbar. To show details on the meaning of the elements of the graph, use the **Legend** button. For details on the graph legend, see Showing the Graph Legend.

**AD Graph Overview** window presents an overview of the entire graph, which can be useful when you work with large graphs. For details, see AD Graph Overview Window.

**AD Graph Inventory** pane presents a list of all the elements in the graph. For details, see AD Graph Inventory View.

The Properties window displays the properties of the element that is selected from the graph. For details, see Properties View.

Use **Export Graph** and **Print** (from the Eclipse toolbar) to export the graph to a portable format or print it. For details, see the sections Exporting the Graph and Printing the Graph.

**Entity Diagram element pop-up menu**

Right-click on an element from the Entity Diagram to display the pop-up menu.

The options available in the pop-up menu depend on the type of element selected from the graph. Options available for all element types include **View analysis source**, **Show properties**, and **Filter**.

According to the selected element, some or all of the following options might also be available: **Annotations**, **Reports**, and **Usage** analyses.

The **Filter** options in the pop-up menu allow the user to toggle on/off different elements of the graph.
For details on the options available for all element types, see Graph element pop-up menu.

**Imports Analysis Graph**

The Imports Analysis Graph presents the inheritance relationships (imported, inherited, implemented) among all the entities in the application analyzed. Each graphic element that is shown in the Imports Analysis Graph represents a type of resource or a type of relationship.

To display the Imports Analysis Graph, in Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select the Java project for which you want to generate an Imports Analysis Graph. For details on perspectives and their components, see IBM AD Analyze Client Reference.

In the Java Graphs section, to the right of the Explore Projects view, double-click Imports Analysis graph to display the Imports Analysis graph wizard. By default, all components (imported, inherited, and implemented) are included in the graph. Deselect the components that you want to exclude from the analysis then press Finish.

**AD Graphs** tab displays the generated graph. To navigate the graph use buttons in the graph toolbar. For details, see Graphical Analysis Toolbar. To show details on the meaning of the elements of the graph, use the **Legend** button. For details on the graph legend, see Showing the Graph Legend.

**AD Graph Overview** window presents an overview of the entire graph, which can be useful when you work with large graphs. For details, see AD Graph Overview Window.

**AD Graph Inventory** pane presents a list of all the elements in the graph. For details, see AD Graph Inventory View.

The **Properties** window displays the properties of the element that is selected from the graph. For details, see Properties View.

Use **Export Graph** and **Print** (from the Eclipse toolbar) to export the graph to a portable format or print it. For details, see the sections Exporting the Graph and Printing the Graph.

**Imports Analysis graph element pop-up menu**

Right-click on an element from the Imports Analysis Graph to display the pop-up menu.

The options available in the pop-up menu depend on the type of element that is selected from the graph. Options available for all element types include View analysis source, Show properties, and Filter.

According to the selected element, some or all of the following options might also be available: Annotations, Reports, and Graphs.

The Filter options in the pop-up menu allow the user to toggle on/off different elements of the graph.

For details on the options available for all element types, see Graph element pop-up menu.

**Java Call Graph**

The Java Call Graph presents the chain of possible calls at runtime in Java. The nodes in the graph represent the project components, while the edges (arrows) represent relationships between the components. Both nodes and edges are color coded to show the type of component or relationship.

To display the Java Call Graph, in Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select the Java project for which you want to generate a Java call graph. For details on perspectives and their components, see IBM AD Analyze Client Reference.

In the Java Graphs section, to the right of the Explore Projects view, double-click Java call graph to display the Java call graph wizard.

The Available resources area displays the resources available for graph generation. To filter the available resources click one of the buttons to the left of the list to display only certain types of resources. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to
the left of the dialog window. Use the Name field to filter the contents of the list. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish.

AD Graphs tab displays the generated graph. To navigate the graph use buttons in the graph toolbar. For details, see Graphical Analysis Toolbar. To show details on the meaning of the elements of the graph use the Legend button. For details on the graph legend, see Showing the Graph Legend.

AD Graph Overview window presents an overview of the entire graph, which can be useful when you work with large graphs. For details, see AD Graph Overview Window.

AD Graph Inventory pane presents a list of all the elements in the graph. For details, see AD Graph Inventory View.

The Properties window displays the properties of the element that is selected from the graph. For details, see Properties View.

Use Export Graph and Print (from the Eclipse toolbar) to export the graph to a portable format or print it. For details, see the sections Exporting the Graph and Printing the Graph.

Java Call graph element pop-up menu

Right-click on an element from the Java call graph to display the pop-up menu.

The options available in the pop-up menu depend on the type of element that is selected from the graph. Options available for all element types include View analysis source, Show properties, and Filter.

According to the selected element, some or all of the following options might also be available: Annotations, Reports, and Graphs.

The Filter options in the pop-up menu allow the user to toggle on/off different elements of the graph.

For details on the options available for all element types, see Graph element pop-up menu.

Resource Dependencies Graph

The Resource Dependencies Graph shows the links between the special entities present in the special web category (objects such as *.jsp, *.js, *.css, *.html files). This graph is only available for JSP and HTML object files. For the Resource Dependencies Graph, one additional operation is available: Java Call Graph.

To display the Resource Dependencies Graph, in Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select the Java project for which you want to generate a Resource Dependencies Graph. For details on perspectives and their components, see IBM AD Analyze Client Reference.

In the Java Graphs section, to the right of the Explore Projects view, double-click Resource Dependencies Graph to display the Resource Dependencies Graph wizard.

The Available resources area displays the resources available for graph generation. To filter the available resources click one of the buttons to the left of the list to display only certain types of resources. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. Use the Name field to filter the contents of the list. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish.

AD Graphs tab displays the generated graph. To navigate the graph, use buttons in the graph toolbar. For details, see Graphical Analysis Toolbar. To show details on the meaning of the elements of the graph, use the Legend button. For details on the graph legend, see Showing the Graph Legend.

AD Graph Overview window presents an overview of the entire graph, which can be useful when you work with large graphs. For details, see AD Graph Overview Window.

AD Graph Inventory window presents a list of all the elements in the graph. For details, see AD Graph Inventory View.

The Properties window displays the properties of the element selected from the graph. For details, see Properties View.
Use **Export Graph** and **Print** (from the Eclipse toolbar) to export the graph to a portable format or print it. For details, see the sections Exporting the Graph and Printing the Graph.

**Resource Dependencies graph element pop-up menu**

Right-click on an element from the Resource Dependencies Graph to display the pop-up menu.

The options available in the pop-up menu depend on the type of element that is selected from the graph. Options available for all element types include **View analysis source**, **Show properties**, and **Filter**.

According to the selected element, some or all of the following options might also be available: **Annotations**, **Reports**, and **Graphs**.

The **Filter** options in the pop-up menu allow the user to toggle on/off different elements of the graph.

For details on the options available for all element types, see **Graph element pop-up menu**.
Mainframe Reports

Generating a Report

About this task

Procedure

In Explore Projects view, go to Mainframe Reports list in the pane to the right. In the report list, double-click the wanted report. The report wizard is displayed presenting the resources available in the current project.

Figure 33: Cyclomatic Report Example

The Available area displays the resources available for report generation and allows the user to select the resources to be included in the report. The resources from the list can be filtered, by using the Name field, in the following two ways:

- Writing the name of the resource.
- Using regular expressions.

Examples of regular expressions that can be used for a given string CICS9.SAMG1.DFHAIP1:
• ^.*\.(DFHAIPL1 that is equivalent to ^.*DFHAIPL1
• CICS9\.(SAM.*
• CICS9\.(SAMG1\.(DF.*
• ^.*\.(DFHA.*
• ^.*\.(?i)df.*

**Important:** The filtering that uses regular expressions is case-sensitive. For case-insensitive match, the (?)i token can be used.

Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window.

In Report generation options area, the report appendix is displayed by default. To include input details in the appendix, select the option show input details in appendix. To show only the report summary, select the appropriate option.

Use the arrow buttons to move the resources between the Available and Selected lists then click **Finish** to generate the report.

**Note:** For certain reports, extra dialog windows are available allowing the selection of target sources for the report.

The Generating Report message appears, showing the progress of the report generation. For a large volume of data, the report generation may take some time. Therefore, **IBM AD Analyze Client** provides an option of running the report in the background so that you can continue working while the report is generated. To run the report in the background, click **Run in Background** in the Generating Report dialog.

While the report is being generated, icons in the Status bar indicate the type of report that is being generated and the progress of the operation. Click this icon to see the progress in the **Progress** tab.

After the report was generated, it is presented under a tab that is named with the report name in **AD Reports** tab.

**Report Toolbar**

The toolbar available for the reports is displayed as in the following image.

![Report toolbar](image)

**Figure 34: Report toolbar**

It allows the user to perform the following operations on the generated report:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export</td>
<td>Export the report in PDF, RTF, XLSX, DOCX, or CSV format.</td>
</tr>
<tr>
<td>Print</td>
<td>Print the report on a printer that is connected to your system.</td>
</tr>
<tr>
<td>First page</td>
<td>Jump to the first page of the report.</td>
</tr>
<tr>
<td>Previous</td>
<td>Go to the previous page of the report.</td>
</tr>
<tr>
<td>Next</td>
<td>Go to the next page of the report.</td>
</tr>
<tr>
<td>End</td>
<td>Jump to the last page of the report.</td>
</tr>
<tr>
<td>Actual size</td>
<td>Present the report in standard size.</td>
</tr>
</tbody>
</table>
Table 10: Report toolbar buttons (continued)

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fit page</td>
<td>Present the report to fit to page.</td>
</tr>
<tr>
<td>Fit width</td>
<td>Present the report as to fit to width.</td>
</tr>
<tr>
<td>Go back</td>
<td>Return to the previous location in the report.</td>
</tr>
<tr>
<td>Zoom out</td>
<td>Zoom out (in increments of 25).</td>
</tr>
<tr>
<td></td>
<td>Current zoom percentage. Select from the drop-down list to zoom to 25% - 200% (in increments of 25).</td>
</tr>
<tr>
<td></td>
<td>Zoom in (in increments of 25).</td>
</tr>
</tbody>
</table>

Complexity Reports

**Cyclomatic Report**
The Cyclomatic Report, or the McCabe Complexity Report, presents Cyclomatic complexity (a broad measure of soundness and confidence for a program) for the selected project entity. Cyclomatic complexity measures the number of linearly-independent paths through a program module.

To define the complexity thresholds for the Cyclomatic Report for the current project, in Explore Projects view go to the Mainframe Reports list in the pane to the right. Then, select Cyclomatic Reports and right-click on the Cyclomatic Report and select Show settings. In the Report settings dialog window, the Thresholds tab presents the complexity thresholds (Easy, Moderate, and Difficult) to be considered when the application calculates the cyclomatic complexity for the current analysis. Modify the default values as needed. The threshold for Difficult cannot be modified. A color is assigned by default to each complexity level; it is the color that is used in the report diagrams to represent a particular complexity level. To change the default color, double-click the color chip and then select the color you want. Use the Restore defaults button to return to the default settings.

To generate this report, in Explore Projects view, go to the Mainframe Reports list in the pane to the right. Select Complexity Reports then double-click the wanted report to display the report wizard. The Available programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window.

In Report generation options area, the selection indicates that report appendix is displayed by default. To include input details in the appendix, select the option show input details in appendix. To show only the report summary, select the appropriate option. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

In Complexity Score Summary, this report presents two charts: the Complexity percentage distribution chart and the File complexity distribution chart.

**Halstead Complexity Report**
The Halstead Complexity Report generates software metrics that are computed statically without program execution. Halstead complexity can be used to compare the complexity between two programs or two applications.

To define the Halstead Complexity Report settings for the current project, in Explore Projects view go to the Mainframe Reports list in the pane to the right. Then, select Complexity Reports, right-click on the Halstead Report and from the pop-up menu select Show settings.

In the Report settings dialog window, the Operators tab shows if a statement type is considered operator or operand when IBM AD Analyze calculates the Halstead complexity. By default, all statement types are
considered operators. Adjust the selections according to specific needs of your project. Use **Check all** and **Clear all** to manage the selection and **Restore defaults** to return to the default selection.

To generate this report, in Explore Projects view, go to the Mainframe Reports list in the pane to the right. Select Complexity Reports then double-click **Halstead Complexity Report** to display the report wizard.

The Available programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the **Name** field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window.

In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data you want to include in the appendix: **show input details in appendix, show operators in appendix**. To show only the report summary, select the appropriate option.

Use the arrow buttons to move the resources between the Available and Selected lists then click **Finish** to generate the report.

The Report summary section presents charts that show the Program length distribution, the Vocabulary size distribution, the Program volume distribution, the Difficulty level distribution, the Program level distribution, the Effort to implement distribution, the Time to implement distribution, and the Number of bugs distribution per program.

The Halstead Complexity Report details section shows for each program a chart that presents Program length, Vocabulary size, Program volume, Difficulty level, Program level, Effort to implement, Time to implement, and Number delivered bugs.

**Heuristic Complexity Report**

The Heuristic complexity Report determines the complexity of an application by assigning values to each type of statement available in the programming language. In the setup screen, the statements are arranged in groups to allow giving a value to all statements within the group.

Once the values are determined, the thresholds must be set to define the boundaries between simple, moderate, and complex programs. At complexity measurement time, each program complexity is determined by multiplying each statement weight by the statement occurrence number and then summing up all values for that program. The final complexity value is then compared to the thresholds to determine the degree of complexity (simple, moderate, or complex).

Heuristic complexity can be used to determine the effort of a specific software change by focusing on specific statements. For example, giving a weight of zero for all statements except SQL statements helps to measure the complexity of a change that relates only to SQL statements within your application. The weight can represent for example man/hours, providing a time estimation.

To define the Heuristic Complexity report settings for the current analysis, in Explore Projects view, go to the Mainframe Reports list in the pane to the right, then select Complexity Reports. Right-click the Heuristic Report and select **Show settings**. The Heuristic Report settings dialog window presents the weight and complexity (Simple, Moderate, and Complex) of each statement type. It contains two tabs: **Thresholds** and **Weights**.

The **Thresholds** tab presents the complexity thresholds (Simple, Moderate, and Complex) to be considered when IBM AD Analyze calculates the Heuristic complexity for the current analysis. Modify the default values as needed. The threshold for Complex cannot be modified. A color is assigned by default to each complexity level. It is the color that is used in the report diagrams to represent a particular complexity level. To change the default color, double-click the color chip and then select the desired color. Use the **Restore defaults** button to return to the default selection.

The **Weights** tab presents the weight of each statement type. By default, all statement types are assigned the value "1". You can change the weight of a single statement or of a group of statements.

Use **Restore defaults** button to return to the default selection.

To generate the Heuristic Complexity report, in Explore Projects view go to the Mainframe Reports list in the pane to the right. Select Complexity Reports then double-click the desired report to display the report.
wizard. The Available programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window.

In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix, show weights in appendix. To show only the report summary, select the appropriate option.

Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

The Report summary section presents two charts that show the Complexity percentage distribution and the File complexity distribution.

The Report details section shows for each program the number of statements, the Program weight, and the complexity level attributed (according to the values set in the Heuristic Report Settings dialog).

**Maintainability Index Report**
The Maintainability Index Report is a measurement that is intended to track maintainability and to indicate when it becomes cheaper/or less risky to rewrite code instead of changing it. The Maintainability Index report presents the combined maintainability, McCabe and Halstead complexity measurements for the current project.

To define the Maintainability Index report settings for the current project, in Explore Projects view, go to the Mainframe Reports list in the pane to the right then select Complexity Reports. Right-click the Maintainability Index Report and select Show settings.

In the Report settings dialog window, the Thresholds tab presents the maintainability thresholds (Difficult, Moderate, and Easy) to be considered when IBM AD Analyze calculates the Maintainability Index for the current analysis. Modify the default values as needed. The threshold for “Easy” cannot be modified.

A color is assigned by default to each maintainability level; it is the color that is used in the report diagrams to represent a particular maintainability level. To change the default color, double-click the color chip and then select the desired color. Use Restore defaults button to return to the default selection.

To generate this report, in Explore Projects view, go to the Mainframe Reports list in the pane to the right. Select Complexity Reports then double-click the desired report to display the report wizard. The Available programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window.

In Report generation options area, the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. To show only the report summary, select the appropriate option.

Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

The Report summary section presents two charts that show the Maintainability index percentage distribution and the File maintainability index distribution.

The Report details section shows for each program the Maintainability index value computed and the maintainability level attributed (according to the values set in the Maintainability Index Report Settings dialog).

**Datasets Reports**
Data Flow Through Datasets Report
The Data Flow Through Datasets Report shows the data flow within a batch process, starting with a physical dataset that can be either at the start of the process (forward data flow) or at the end of the data flow (backward data flow) or in the middle of it (backward and forward data flow).

To generate this report, in Explore Projects view, go to the Mainframe Reports list in the pane to the right. Select Datasets Reports then double-click the desired report to display the report wizard. The Available Datasets area lists the datasets available in the selected project. Use the Name field to filter the contents of the list. Use the arrow buttons to move the datasets between the Available and Selected lists.

In Report generation options area, if you select the option generate detailed info, the report presents all identified paths between two datasets. If you do not select this option, the report presents only one path between two datasets. The report appendix is displayed by default. If you select show input details in appendix, a list of all datasets that were used to generate the report is included in the appendix.

In Limit data flow area, by default, a complete report is generated. If you want to limit the analysis to X depth, check the option Threshold level and enter the desired value in the corresponding field. From the Data flow direction area, select one of the available options Forward, Backward, or Both.

Click Next to display the second dialog window of the wizard.

Select the datasets that you want to exclude from the report. Click Finish to generate the report.

Excluded nodes are marked with a "!" sign.

By default, an asterisk sign, "*", marks the chains for which further analysis results are not displayed because of the limit set in the wizard. (highlight results that are cut short by the threshold option checked in Analysis Expansion Limit tab from Preferences window). If highlight results... option is not checked, all chains that reach the level limit set in the wizard are marked with an asterisk regardless of whether further analysis results are available or not. The meaning of the asterisk sign "*" in the context of each report is explained in a note at the end of the report.

Datasets Record Structure Report
The Datasets Record Structure report presents the record that defines the file structure and also where it is being used in the programs.

To generate this report, in Explore Projects view go to the Mainframe Reports list in the pane to the right. Select Datasets Reports then double-click the desired report to display the report wizard.

The Available datasets area displays the datasets available for report generation. Use the Name field to filter the contents of the list.

In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix.

Use the arrow buttons to move the datasets between the Available and Selected lists then click Finish to generate the report.

Dead Code Reports

Unreferenced DDCL Elements

Note: This report is only available for VME projects.

This report lists unreferenced DDCL elements, that is, DDCL elements that exist in a DDCL, but are not referenced by any other element within that DDCL.

To generate this report, in Explore Projects view, go to the Mainframe Reports list in the pane to the right. Select Dead Code Reports then double-click the desired report to display the report wizard. The Available element types area displays the element types that are taken into account when the report is generated. Use the Name field to filter the contents of the list.

The area Excluded element types, lists the elements that are excluded by default from the analysis. Use the arrow buttons to move element types between the two lists.
In Report generation options area, the selection indicates that the report appendix is displayed by default. Press **Next** to display the second dialog window of the report wizard.

The Available DDCL Elements area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the **Name** field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. Use the arrow buttons to move the resources between the Available and Selected lists then click **Finish** to generate the report.

**Unreferenced Programs**

This report lists all programs that are not referenced by other programs within the project. These programs must be tested to determine whether they are main programs (and therefore are not referenced) or whether they are not used and can be considered dead code.

To generate this report, in Explore Projects view, go to the Mainframe Reports list in the pane to the right. Select Dead Code Reports then double-click the desired report to display the report wizard. The Available programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the **Name** field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window.

In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data must be included in the appendix: **show input details in appendix**.

Use the arrow buttons to move the resources between the Available and Selected lists then click **Finish** to generate the report.

The Report summary section presents a chart that shows the Programs usage ratio.

The Report details section shows the list of unreferenced programs that were found.

**Unused Routines Within Programs**

This report lists all routines within a program that are not referenced within the program. These routines cannot be reached at runtime and therefore are considered dead code.

To generate this report, in Explore Projects view, go to Mainframe Reports list in the pane, to the right. Select **Dead Code Reports** then double-click the desired report to display the report wizard.

The Available programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the **Name** field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window.

In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data must be included in the appendix: **show input details in appendix**. The option **Filter out unused EXIT routines for COBOL programs** is selected by default; deselected it if you want to include these routines in the report. Use the arrow buttons to move the resources between the Available and Selected lists then click **Finish** to generate the report.

The Report summary section presents two charts that show usage ratio of programs that have unused routines, and the unused routines occurrences in program.

The Report details section shows for each program: the routine name, the number of statements, and the line in the program where the routine is located.

**Impact Reports**
**Field Expansion Report**

This report presents the relationships among the resources of an application so that the impact of a field expansion operation can be understood.

To generate this report, in Explore Projects view go to the Mainframe Reports list in the pane to the right. Select Impact Reports then double-click the desired report to display the report wizard.

In the first dialog window of the wizard, specify the location of the variable for which you want to generate the Field Expansion report or browse for a table field.

**Note:** If you choose to start the impact report for an SQL table field, the report is generated on a variable that is mapped with the table field and not on the table field.

If you want to limit the analysis to X depth, check the option **limit expansion depth** and enter the desired value in the corresponding field then click **Next**.

In the second dialog window of the wizard, select the type of resource that contains the variable - program or include - then click **Next**.

According to the selections made in the previous dialog, a list of programs or includes is displayed. Use the field to filter the list and locate the desired resource. Once you selected the desired resource, the **Next** button becomes available. Click it to display the next dialog window of the report wizard.

A list of variables that were found in the selected resource is presented. Use the field to filter the list and locate the desired variable, then select it and click **Next** to display the next dialog window of the report wizard.

**Note:** In case you selected the **include** type of resource, only the variables from the first program are listed.

Use this dialog to specify variables that must be EXCLUDED from the report. If you do not want to exclude variables from the report, click **Finish**. If you want to exclude certain variables from the report, follow the instructions below.

Use **Import** to import a file that contains the variables that you want to exclude from the report. The variable list must be saved in a *.txt file, one variable on each line.

Enter the name of the variable in the available field then press the **Add** button to add it to the list.

Alternatively, use **Browse** to locate the variable. Click **Browse** to select the type of resource that contains the variable and display the next dialog window of the report wizard.

Select the type of resource - program or include - then press **Next** to display the next dialog window of the report wizard. According to the selection made in the previous dialog window, a list of programs or includes is presented. Select a program or an include then click **Next** to display the next dialog window of the report wizard.

A list of variables that were found in the selected resource is presented. Select one of the variables from the list then click **Add** to add it to the list of variables to be excluded from the report.

The variables that were selected for EXCLUSION are displayed in the central part of the dialog window. For variables added via **Browse** and **Import** buttons, the name of the resource (program or include) containing the variable is displayed as well as the variable’s position (line ...) within the resource.

Repeat the procedure that is presented above to add to the list as many variables as you need. To remove a variable from the list, select it then click **Delete** button. Click **Finish** to generate the Field Expansion Report.

**Field Usage Report**

This report presents the relationships among the resources of an application so that the impact of renaming a field can be understood.

To generate this report, in Explore Projects view go to the Mainframe Reports list in the pane to the right. Select Impact Reports then double-click the desired report to display the report wizard.
In the first dialog window of the wizard, select the target of the analysis - either locate variables in programs or includes, or browse for a table field - then click **Next** to display the second dialog window of the wizard.

**Note:** If you choose to start the impact report for an SQL table field, the report is generated on a variable that is mapped with the table field and not on the table field.

Choose the type of source file - program or include - for variable selection then click **Next**.

**Note:** In case you selected the **include** type of resource, a list of include items is presented. Select a single entry from the available list, then press **Next**. A list of programs that uses the selected include resource is presented. Use **CTRL** to select non-consecutive programs from the list.

Regardless of the selections made in the previous dialogs, a list of programs is displayed. Use the field to filter the list and locate the desired resource. Select the resource, then click **Next** to display the next dialog window of the report wizard.

A list of variables that were found in the selected resource is presented. Use **CTRL** to select non-consecutive variables from the list. Use the field to filter the list elements and to locate the desired variable then select it and click **Finish** to generate the report.

**Note:** In case you selected the **include** type of resource, only the variables from the first selected program are listed.

### Impact Analysis Report

The Impact Analysis report allows the developer to understand the consequences of modifying a certain resource. The impact analysis determines who uses the objects and presents the dependencies between the objects.

To generate this report, in Explore Projects view, go to the Mainframe Reports list in the pane to the right. Select Impact Reports then double-click the desired report to display the report wizard.

In the first dialog window of the report wizard, specify the location of the variable for which you want to generate the Impact Analysis report, or browse for a table field.

**Note:** If you choose to start the impact report for an SQL table field, the report is generated on a variable that is mapped with the table field and not on the table field.

Then, select the impact direction (omnidirectional, forward, or backward). If you want to limit the analysis to X depth, check the option **limit expansion depth** and enter the desired value in the corresponding field then press **Next**.

Select the type of resource - program or include - that contains the variable for which you want to perform the analysis, then press **Next**.

**Note:** In case you selected the **include** type of resource, a list of include items is presented. Select a single entry from the available list, then press **Next**. A list of programs that uses the selected include resource is presented. Use **CTRL** to select non-consecutive programs from the list.

Regardless of the selections made in the previous dialogs, a list of programs or tables is displayed. Use the field to filter the list and to locate the desired resource. Select the resource then click **Next** to display the next dialog window of the wizard.

A list of variables that were found in the selected resource is presented. Use **CTRL** to select non-consecutive variables from the list. Use the field to filter the list and locate the desired variable then select it and click **Next** to display the next dialog window of the report.

**Note:** In case you selected the **include** type of resource, only the variables from the first selected program are listed.

Use this dialog to specify variables that must be EXCLUDED from the report. If you do not want to exclude variables from the report, click **Next**. If you want to exclude certain variables from the report, follow the instructions below.

Enter the name of the variable in the available field then press **Add** to add it to the list.
Use **Import** to import a file that contains the variables to be excluded from the report. The variable list has to be saved in a *.txt file, one variable on each line.

Alternatively, use **Browse** to locate the variable. Click the **Browse** button to select the type of resource that contains the variable and to display the next dialog window of the report wizard.

Select the type of resource - program or include - then press **Next**.

According to the selections made in the previous dialog, a list of programs or includes is displayed. Select the resource then click **Next**.

A list of variables that were found in the selected resource is presented. Select one of the variables from the list then click **Add** to add it to the list of variables to be excluded from the report. The variables that were selected for EXCLUSION are displayed in the central part of the dialog window. For variables added via **Browse** and **Import** the name of the resource (program or include) containing the variable is displayed as well as the variable’s position (line ...) within the resource.

Repeat the procedure that is presented above to add to the list as many variables as you need. To remove a variable from the list, select it then use **Delete**. Click **Next** to display the next dialog window of the report wizard.

Use this dialog to specify which datasets must be excluded from the analysis. Use the arrow buttons to move the datasets between the Available and Selected lists then click **Finish** to generate the Impact Analysis report.

The Impact Analysis report takes into consideration the COBOL Reference Modification to move partial data from source field to target field. In the reference modification, the first position indicates the starting position and the second position indicates the length of the variable.

**Impact Analysis Report for PL/I**

The Impact Analysis report allows the developer to understand the consequences of modifying a certain resource. The impact analysis for PL/I shows the dataflow from the starting point to the end point, in the selected (forward or backward) direction. This report uses data stored in graph database. The following relationships are shown in the report:

- statements that actually transfer data (like assignments);
- statements that read from or write to external resources (like tables and files that are mapped further with datasets);
- parameter passing across internal procedures;
- parameter passing across external procedures;

To generate this report, in Explore Projects view, go to the Mainframe Reports list in the pane to the right. Select Impact Reports then double-click the desired report to display the report wizard.

In the first dialog window of the report wizard, specify the location of the variable for which you want to generate the Impact Analysis report, or browse for a datasource type: dataset or SQL table. If you select SQL table an additional wizard dialog is available where you can select a SQL field.

**Note:** If you choose to start the impact report for an SQL table field, the report is generated on a variable that is mapped with the table field and not on the table field.

Then, select the impact direction (forward or backward). If you want to limit the analysis to X depth, check the option **limit expansion depth** and enter the desired value in the corresponding field then press **Next**.

Select the type of resource - program or include - that contains the variable for which you want to perform the analysis, then press **Next**.

According to the selections made in the previous dialog, a list of programs, includes, SQL tables or datasets is displayed. Use the field to filter the list and to locate the desired resource. Select the resource then click **Next** to display the next dialog window of the wizard.

A list of variables that were found in the selected resource is presented. Use CTRL to select non-consecutive variables from the list. Use the field to filter the list and locate the desired variable then select it and click **Next** to display the next dialog window of the report.
Use this dialog to specify resources that must be EXCLUDED from the report. The list of entities available for exclusion presents variables, datasets, SQL tables, and SQL fields.

The exclude feature for Impact analysis report is done by adding a file with the details of the resources we want to exclude from report. The file structure is: resource_type, resource_name, [resource_detail_type, resource_detail]. Each line keeps information only for a resource. Each type of resource has a specific list of pairs:

- for variables: variable, variable_name, [program, program_name, forefather, forefather_name];
- for datasets: dataset, dataset_name;
- for SQL tables: sqltable, sqltable_name;
- for SQL fields: sqlfield, sqlfield_name, [sqltable, sqltable_name].

**Note:** Here is an example of a file containing details of the resources that must be excluded from the report:

<table>
<thead>
<tr>
<th>resource_type</th>
<th>resource_name</th>
<th>extra_details</th>
</tr>
</thead>
<tbody>
<tr>
<td>variable</td>
<td>CUSTID-REC</td>
<td></td>
</tr>
<tr>
<td>variable</td>
<td>CUSTID-REC</td>
<td>program, ACCT03, forefather, MISC</td>
</tr>
<tr>
<td>variable</td>
<td>CUSTID-REC</td>
<td>forefather, MISC</td>
</tr>
<tr>
<td>sqltable</td>
<td>ACCOUNTS</td>
<td></td>
</tr>
<tr>
<td>sqlfield</td>
<td>SCITY</td>
<td></td>
</tr>
<tr>
<td>sqlfield</td>
<td>SCITY</td>
<td>sqltable, CUSTOMER</td>
</tr>
</tbody>
</table>

The results of the report depend on the type of statement selected for analysis.

The Report summary section includes a Variables summary page, a Programs summary page, a File summary page, a Dataset summary page, a SQL Field summary page, and a Sources summary page. These pages present the input (selected variables or programs) for the report and the impacted resources (variables, files, datasets, SQL fields, and programs).

The Report details section presents the input variable and the final datasource for the variable together with all the steps in between.

**Example 1:** statements that actually transfer data (assignments). We want to show the impact of modifying the variable LINE. An Impact analysis of variable LINE presents the data flow that reaches to the variable LINE, through the assignment statements. The Report summary section presents information about entities that are impacted, that is, the list of sources being touched. In the Report details section, the definition source and the program that started the flow are presented. If we click on PL1: Assignment statement, we will see the statement highlighted in the source code in the Editor view.

**Example 2:** statements that read or write to external resources (like SQL table fields and Files). This level allows the user to get an overview of how data flows through the system at a level that is closer to the business view. This time we want to show the impact of modifying a SQL Table Field. An Impact analysis of SQL field presents the flow of data beginning with the starting point and ending with the SQL table field name - that is suffixed with the SQL table name. After the report is generated, clicking on the SQL insert, we will see the INSERT INTO statement (that is used to insert new records in a table x, the fields names and the values to be inserted).

In case you select statements that read from or write to files that are mapped with datasets: an Impact analysis of a dataset presents the dataflow beginning with the starting point and ending with the file. The file that is written has a DDCard association. Clicking on the DDCard association we'll see JCL Data definition (DD) statement that defines the datasets.

**Example 4:** Parameter passing across internal procedures and external procedures, the following data is shown:

- the program that started the flow;
- table with columns: "from", "to" "impact type" describing the flow of data beginning with the starting point and ending with the program;
- subsection with possible chains of calls and data flows between programs that start or get to the current program;
• subsection with list of variables impacted in the program;
• subsection with list of programs impacted and how variables in the current program map to defined
parameters of the called program.

Inventory Reports

DDCL Element Inventory

Note: This report is only available for VME projects.

The DDCL Element Inventory report presents a detailed list of all the DDCL elements in the current project as well as details about each element.

To generate this report, in Explore Projects view, go to the Mainframe Reports list in the pane to the right. Select Inventory Reports then double-click the desired report to display the report wizard.

The Available DDCL Element area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window.

In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. To show only the report summary, select the appropriate option. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

The Report summary section presents Input elements and Totals.

The Report details section shows usage details for each component according to the different access property including number of used screens, records, dialogues, applications, sets, tasks, total number of accessed files.

DDCL Project Inventory

Note: This report is only available for VME projects.

This report presents a list of all the DDCL elements in the current project.

To generate this report, in Explore Projects view, go to the Mainframe Reports list in the pane to the right. Select Inventory Reports then double-click the desired report to display the report wizard.

In Report generation options area, the selection indicates that the report appendix is displayed by default. To show only the report summary, select the appropriate option.

The Report summary section presents the total number of resources grouped by type.

The Report details section shows the detailed list of the elements that were found in the DDCL files from the current project.

Application Inventory Report

This report presents the list of resources that were found in the selected application or applications(s).

To generate this report, in Explore Projects view, go to the Mainframe Reports list in the pane to the right. Select Inventory Reports then double-click the desired report to display the report wizard.

A list of defined applications is displayed. Select the applications for which you want to generate the report.

In Report generation options area, the selection indicates that the report appendix is displayed by default. To show only the report summary, select the appropriate option. Click Finish to generate the report.

The Report summary section presents two charts that show Totals and Averages, including number of routines, number of resources used (files, tables, screens), number of includes, number of statements,
number of calls, and usage details for each resource according to the different access statements. All information is grouped by application.

The Report details section shows the list of components that are associated to each application.

**Members Inventory Report**

This report presents a list of all the members of the current project.

To generate this report, in Explore Projects view, go to the Mainframe Reports list in the pane to the right. Select Inventory Reports then double-click the desired report to display the report wizard.

The Available MF Libraries area displays the MF libraries that are available for report generation. Use the Name field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. Use the arrow buttons to move the MF libraries between the Available and Selected lists then click Finish to generate the report.

In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. To show only the report summary, select the appropriate option.

The Report summary section shows the following information:

- The total number of members and the total number of lines.
- For each member type, the summary displays the total number of members per type and the total number of lines.
- Total number of members per library and total number of lines.
- For each member type with the specific library, the summary displays the total number of members per type and total number of lines.

The Report details section of the report contains a list of all members with information such as Member name, type, no. of lines, and so on.

**Missing Components Report**

This report presents a list of all missing components for the selected programs such as called programs or SCL procedure that are missing from the current project.

To generate this report, in Explore Projects view, go to the Mainframe Reports list in the pane to the right. Select Inventory Reports then double-click the desired report to display the report wizard.

The Available programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix.

The Report details section of the report contains two lists:

- By program – showing for all selected programs, all the missing components.
- By component – showing for all components, all the programs that call those components.

At the end of the report, in the Report summary section, the total number of missing components is presented.

**Programs Inventory Report**

The Programs Inventory report presents a detailed list of all the programs in the current project as well as details about each program.
To generate this report, in Explore Projects view, go to the Mainframe Reports list in the pane to the right. Select **Inventory Reports** then double-click the desired report to display the report wizard.

The Available programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the **Name** field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. Use the arrow buttons to move the resources between the Available and Selected lists then click **Finish** to generate the report.

In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: **show input details in appendix**. To show only the report summary, select the appropriate option.

The Report summary section presents Totals and Averages.

The Report details section shows for each program, the total number of **Backfired Function Points**, total number of calls, total number of statements, and total number of includes. Also, a list of all the includes identified is displayed.

In order to calculate the values, the following formula is used: number of statements / k, where k is the constant used for each language as follows:

- COBOL - 175.0
- PL/1 - 126.0
- Natural - 100.0
- Assembler - 400.0

For for ADS Process or ADS Dialog resources, the **Backfired Function Points** value is not calculated.

**Remember:** The values are rounded before generating the report.

**Project Inventory Report**

This report presents a list of all the components in the current project.

To generate this report, in Explore Projects view, go to the Mainframe Reports list in the pane to the right. Select **Inventory Reports** then double-click the desired report to display the report wizard.

In Report generation options area, the selection indicates that the report appendix is displayed by default. To show only the report summary, select the appropriate option.

The generated report has two sections: Report summary, which contains the total number of resources, grouped by type and Report details, which shows the detailed list of the resources that were found in the project.

**Miscellaneous Reports**

**A-AUTO Network Dependency Report**

This report shows for all selected networks the successor/predecessor networks, up to the selected level if specified.

To generate this report, in Explore Projects view, go to the Mainframe Reports list in the pane to the right. Select **Miscellaneous Reports**, then double-click the desired report to display the report wizard.

In Report generation options area, choose the direction of the analysis (successors or predecessors). By default, the depth of the analysis is limited to three levels. The report appendix is displayed by default. Choose what additional data to include in the appendix: **show input details in appendix**.

The Report summary section presents the total number of input networks, the number of networks without successors/predecessors, and the length of the longest chain as well as a chart that shows Network dependency chain distribution.
The Report details section presents for each network the corresponding dependencies and the number of chains.

By default, an asterisk sign, "*", marks the chains for which further analysis results are not displayed because of the limit set in the wizard. (highlight results that are cut short by the threshold option checked in Analysis Expansion Limit tab from Preferences window). If highlight results... option is not checked, all chains that reach the level limit set in the wizard are marked with an asterisk regardless of whether further analysis results are available or not. The meaning of the asterisk sign "*" in the context of each report is explained in a note at the end of the report.

**Backward Call Chains Report**

This report shows all call chains within the application, going backward with connectivity direction. For each program, the number of chains and the maximum length are determined.

To generate this report, in Explore Projects view, go to the Mainframe Reports list in the pane to the right. Select Miscellaneous Reports, then double-click the desired report to display the report wizard.

The Available programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

The Report summary section presents a chart showing the Program call chain distribution.

The Report details section presents for each program, the number of chains per program.

Restricted nodes are be marked with a "!" sign. Restrictions can be defined from Preferences window, for details on how to set these restrictions see Call graph restrictions. By default, an asterisk sign, "*", marks the chains for which further analysis results are not displayed because of the limit set in the wizard. (highlight results that are cut short by the threshold option checked in Analysis Expansion Limit tab from Preferences window). If highlight results... option is not checked, all chains that reach the level limit set in the wizard are marked with an asterisk regardless of whether further analysis results are available or not. The meaning of the asterisk sign "*" in the context of each report is explained in a note at the end of the report.

**DDCL Backward Call Chains Report**

Note: This report is only available for VME projects.

This report shows all call chains within DDCL elements, going backward with connectivity direction. For each DDCL element, the number of chains and the maximum length are determined.

To generate this report, in Explore Projects view, go to the Mainframe Reports list in the pane to the right. Select Miscellaneous Reports, then double-click the desired report to display the report wizard.

The Available DDCL Elements area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window.

Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

**DDCL Forward Call Chains Report**

Note: This report is only available for VME projects.

This report shows all call chains within DDCL elements, going forward with connectivity direction. For each DDCL element, the number of chains, and the maximum length are determined.

To generate this report, in Explore Projects view, go to the Mainframe Reports list in the pane to the right. Select Miscellaneous Reports, then double-click the desired report to display the report wizard.
The Available DDCL Elements area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the **Name** field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window.

Use the arrow buttons to move the resources between the Available and Selected lists then click **Finish** to generate the report.

In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: **show input details in appendix**. Select **Continue on programs** if you want to include in the report the call chains to the programs. Select **Limit recursive relations** and enter a value in the adjacent field to determine the maximum call chain length.

**Forward Call Chains Report**

This report shows all call chains within the application, going forward with connectivity direction. For each program, the number of chains, and the maximum length are determined.

To generate this report, in Explore Projects view go to the Mainframe Reports list in the pane to the right. Select Miscellaneous Reports, then double-click the desired report to display the report wizard.

The Available programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the **Name** field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window.

Use the arrow buttons to move the resources between the Available and Selected lists then click **Finish** to generate the report.

In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: **show input details in appendix**.

**Mainframe Runtime Performance Report**

This report traces the runtime performance for the Mainframe elements like: Jobs, Programs, CICS Transactions.

To generate this report, in Explore Projects view, go to the Mainframe Reports list in the pane to the right. Select Miscellaneous Reports then double-click the desired report to display the report wizard.

Restricted nodes are marked with a "!" sign. Restrictions can be defined from Preferences window, for details on how to set these restrictions, see **Call graph restrictions**.

By default, an asterisk sign, "*" marks the chains for which further analysis results are not displayed because of the limit set in the wizard. *(highlight results that are cut short by the threshold* option checked in **Analysis Expansion Limit** tab from Preferences window). If **highlight results...** option is not checked, all chains that reach the level limit set in the wizard are marked with an asterisk regardless of whether further analysis results are available or not. The meaning of the asterisk sign "*" in the context of each report is explained in a note at the end of the report.

**Job Flow Report**

The Job Flow Report presents the job steps in the selected JCL or JCLs.

To generate this report, in Explore Projects view, go to the Mainframe Reports list in the pane to the right. Select Miscellaneous Reports then double-click the desired report to display the report wizard.

The Available Job files area displays the job files available for report generation. Use the **Name** field to filter the contents of the list. Use the arrow buttons to move the job files between the Available and Selected lists then click **Finish** to generate the report.

In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: **show input details in appendix**.
In the report wizard dialog window, select the resource types for which you want to generate the report, then a date range, and click **Next**.

In the subsequent dialog window, the Available resources area lists the available resources according to the type selected in the previous dialog of the wizard. Use the **Name** field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. Use the arrow buttons to move resources between the Available and the Selected lists. Once you selected the resources for which you want to generate the report, click **Finish**.

The report presents a list of resources with their corresponding runtime performance values for the selected time interval.

**Rule Based Analysis Report**

This report allows the user to select the coding rules to be used when generating the Rule Based Analysis report. The rules are stored in a special file, which can be modified/updated according to needs. For details on the specific syntax and an example of a rules file, see Appendix 2: Rules File Example for Rule Based Analysis.

To generate this report, in Explore Projects view, go to the Mainframe Reports list in the pane to the right. Select Miscellaneous Reports then double-click the desired report to display the report wizard.

In the report wizard dialog window, the Available rules area lists the coding rules available in the selected rules file. Use the **Name** field to filter the contents of the list. Select a coding rule from the list to display the rule description and the associated parameters (if applicable) in the Settings area. The parameters as well as the Weight for each coding rule can be customized. In Report generation options area, the selection indicates that the report appendix is displayed by default. Use the arrow buttons to move rules between the Available to the Selected lists then click **Next**.

The Available resources area lists the available resources. Use the **Name** field to filter the contents of the list. Once you selected the resources for which you want to generate the report, click **Finish**.

The Report summary section presents the list of rules that were used to generate the report and the list of resources that failed to comply with the selected rules. The rules names offer hyperlinks to the details section of the report.

The Report details section presents the name of the coding rule, the rule description, and category. Also, the report presents the list of resources that failed to comply with this rule. Furthermore, for each resource, the report presents the number of times the rule was broken and the line of code where the breach occurred. The number of the line of code where the breach occurred offers hyperlinks to the actual place in the resource. Clicking the hyperlink opens the resource in the editor at the line where the breach was identified.

**SQL Backward Call Chains Report**

This report shows the dependency SQL tables and for programs, all call chains within the application, going backward with connectivity direction. For each program, the SQL table(s) usage and the number of chains are determined.

To generate this report, in Explore Projects view go to the Mainframe Reports list in the pane to the right. Select Miscellaneous Reports then double-click the desired report to display the report wizard.

The Available SQL Tables area lists the SQL tables available in the selected project. Use the **Name** field to filter the contents of the list. Use the arrow buttons to move resources between the Available to the Selected lists. Once you selected the resources for which you want to generate the report, click **Finish**.

The Report summary section presents the total number of programs, the number of programs never called, and the longest chain.

Restricted nodes are marked with a "![" sign. Restrictions can be defined from Preferences window, for details on how to set these restrictions, see Call graph restrictions.
By default, an asterisk sign, "*", marks the chains for which further analysis results are not displayed because of the limit set in the wizard. (highlight results that are cut short by the threshold option checked in Analysis Expansion Limit tab from Preferences window). If highlight results... option is not checked, all chains that reach the level limit set in the wizard are marked with an asterisk regardless of whether further analysis results are available or not. The meaning of the asterisk sign "*" in the context of each report is explained in a note at the end of the report.

Where Used Reports

Where Used Reports Overview

Where Used Reports show all the places within the application where specific resources are referenced. Resources are entities that are used by programs for I/O actions. For example, resources can be IDMS records or sets, IDMSX records or sets, VSAM files, BMS screens. The list of Where Used Reports depends on the environment in which the mainframe project was created and also on the resource types that exist within the current project.

For all resources, excluding variables and string literals, two types of reports can be generated: resource to program and program to resource. A resource to program report allows the selection of specific resources and lists all programs that use those resources. A program to resource report allows the selection of specific programs and lists all resources that were used within those programs.

DDCL-Files Report
This report shows for each DDCL element, the name of the file accessed, the property, and the occurrences.

Note: This report is only available for VME projects.

To generate this report, go to Explore Projects view, and select Mainframe Reports list in the pane to the right. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available DDCL Elements area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix.

The Report summary section presents two charts that show the Files usage ratio and the Used files distribution.

The Report details section presents for each DDCL element, the name of the file accessed, the property, and the occurrences.

DDCL-Record Groups Report
This report shows for each DDCL element, the name of the record group accessed, the property, and the occurrences.

Note: This report is only available for VME projects.

To generate this report, go to Explore Projects view, and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available DDCL Elements area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to
include in the appendix: **show input details in appendix**. If you deselect the option **hide detailed images**, a chart showing DDCL references is displayed for each record group.

The Report summary section presents two charts that show the Record groups usage ratio and the Used record groups distribution.

The Report details section presents for each DDCL element, the name of the record group accessed, the property, and the occurrences.

**DDCL-Records Report**
This report shows for each DDCL element, the name of the records accessed, the property, and the occurrences.

**Note:** This report is only available for VME projects.

To generate this report, go to Explore Projects and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available DDCL Elements area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the **Name** field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. Use the arrow buttons to move the resources between the Available and Selected lists then click **Finish** to generate the report. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: **show input details in appendix**. If you deselect the option **hide detailed images**, a chart showing DDCL references is displayed for each record.

The Report summary section presents two charts that show the Records usage ratio and the Used records distribution.

The Report details section presents for each DDCL element, the name of the records accessed, the property, and the occurrences.

**DDCL-Sets Report**
This report shows for each DDCL element, the name of the sets accessed, the property, and the occurrences.

**Note:** This report is only available for VME projects.

To generate this report, go to Explore Projects view and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available DDCL Elements area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the **Name** field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: **show input details in appendix**. If you deselect the option **hide detailed images**, a chart showing all referenced DDCLs is displayed for each set. Use the arrow buttons to move the resources between the Available and Selected lists then click **Finish** to generate the report.

The Report summary section presents two charts that show the Sets usage ratio and the Used sets distribution.

The Report details section presents for each DDCL element, the name of the sets accessed, the property, and the occurrences.

**Adabas-Programs Report**
This report shows for each Adabas resource, all the programs that use it.

To generate this report, go to Explore Projects view and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.
The Available Adabas area lists the resources available for report generation in the selected project. Use the **Name** field to filter the contents of the list. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: *show input details in appendix*. Use the arrow buttons to move resources between the Available and Selected lists then click **Finish** to generate the report.

The Report summary section presents two charts that show the Adabas usage ratio and the Adabas distribution per programs.

The Report details section shows for all selected Adabas, all the programs that use the selected Adabas resources.

**DAL-Programs Report**
This report shows for each DAL resource, all the programs that use it.

To generate this report, goto **Explore Projects** view and select **Mainframe Reports** list. Select **Where Used Reports**, then double-click the desired report to display the report wizard.

The Available DAL area lists the resources available for report generation in the selected project. Use the **Name** field to filter the contents of the list. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: *show input details in appendix*. Use the arrow buttons to move resources between the Available and Selected lists then click **Finish** to generate the report.

The Report summary section presents two charts that show the DAL usage ratio and the DALs distribution per programs.

The Report details section shows for all selected DALs, all the programs using the selected DAL resources.

**Datacom-Programs Report**
This report shows for each Datacom table, all the programs that use it.

To generate this report, go to **Explore Projects** view and select **Mainframe Reports** list. Select **Where Used Reports**, then double-click the desired report to display the report wizard.

The Available Datacom Tables area lists the resources available for report generation in the selected project. Use the **Name** field to filter the contents of the list. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: *show input details in appendix*. Use the arrow buttons to move resources between the Available and Selected lists then click **Finish** to generate the report.

The Report summary section presents two charts that show the Datacom tables usage ratio and the Datacom tables distribution per programs.

The Report details section shows for all selected Datacom Tables, all the programs that use the selected tables.

**Datasets-Jobs Report**
This report shows for each Dataset, all the jobs where the selected dataset is defined and further used.

To generate this report, go to **Explore Projects** view and select **Mainframe Reports** list. Select **Where Used Reports**, then double-click the desired report to display the report wizard.

The Available Datasets area lists the resources available for report generation in the selected project. Use the **Name** field to filter the contents of the list. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what extra data to include in the appendix: *show input details in appendix*. Use the arrow buttons to move resources between the Available and Selected lists then click **Finish** to generate the report.

The Report summary section presents two charts that show the Datasets usage ratio and the Datasets distribution per jobs.

The Report details section shows for all selected Datasets, all the jobs where the selected dataset is defined. Also, for each job, a list of all the entities that are accessing it is presented. Furthermore, for each entity, the corresponding type is presented together with the number of occurrences.
DBI-Programs Report
This report shows all programs that use a given set of DBI tables.

To generate this report, go to Explore Projects view and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available DBI area lists the resources available for report generation in the selected project. Use the Name field to filter the contents of the list. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. Use the arrow buttons to move resources between the Available and Selected lists then click Finish to generate the report.

The Report summary section presents two charts that show DBI tables usage ratio and DBI distribution per programs.

The Report details section shows for each DBI table a list of programs using it.

Files-DDCL Report
This report shows for each file, all the DDCL elements that use it.

Note: This report is only available for VME projects.

To generate this report, go to Explore Projects view and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available Files area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

The Report summary section presents two charts that show the Access type distribution and the Occurrences per file.

The Report details section shows for all selected files, all the DDCL elements that use those files.

Files-Programs Report
This report shows for each file, all the programs that use it.

To generate this report, go to Explore Projects view and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available Files area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

The Report summary section presents two charts that show the Access type distribution and the Statement occurrences per file.

The Report details section shows for all selected files, all the programs that use those files.

Files-SCL Report
This report shows for each file, all SCL procedures that use it.

Note: This report is only available for VME projects.

To generate this report, go to Explore Projects view and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available Files area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to
generate the report. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix.

The Report summary section presents two charts that show the Access type distribution and the Statement occurrences per file.

The Report details section shows for all selected files, all SCL procedures that use those files.

**IDMSX Records-Programs Report**
This report shows for each IDMSX record, all programs that use it.

*Note:* This report is only available for VME projects.

To generate this report, go to Explore Projects view and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available IDMSX Records area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. If you deselect the option hide detailed images, a chart that shows statement occurrences in programs is displayed for each IDMSX record. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

The Report summary section presents two charts that show the Access type distribution and the Statement occurrences per IDMSX record.

The Report details section shows for all selected IDMSX Records, all the programs that use those records.

**IDMS Records-Programs Report**
This report shows for each IDMS Record, all programs that use it.

To generate this report, go to Explore Projects view and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available IDMS Records area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. If you deselect the option hide detailed images, a chart that shows statement occurrences in programs is displayed for each IDMS record. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

The Report summary section presents two charts that show the Access type distribution and the Statement occurrences per IDMS record.

The Report details section shows for all selected IDMS Records, all the programs that use those records.

**IDMSX Sets-Programs Report**
This report shows for each IDMSX set, all programs that use it.

*Note:* This report is only available for VME projects.

To generate this report, go to Explore Projects view and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available IDMSX Sets area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white
The report summary section presents two charts that show the Access type distribution and the Statement occurrences per IDMSX set.

The Report details section shows for all selected IDMS Sets, all the programs that use those sets.

**IDMS Sets-Programs Report**
This report shows for each IDMS Set, all the programs that use it.

To generate this report, go to Explore Projects view and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available IDMS Sets area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: **show input details in appendix**. If you deselect the option **hide detailed images**, a chart that shows statement occurrences in programs is displayed for each IDMSX set. Use the arrow buttons to move the resources between the Available and Selected lists then click **Finish** to generate the report.

The Report details section shows for all selected IDMS Sets, all the programs that use those sets.

**IMS DB-Programs Report**
This report shows for each IMS/DB resource, all the programs that use it, at IMS database segment level.

To generate this report, go to Explore Projects view and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available IMS/DB area displays the IMS databases available for analysis. Use the Name field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. Select the IMS/DB you want to analyze then click **Next**. A list of segments identified in the selected IMS database is presented. Select the segment or segments that you want to analyze.

In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: **show input details in appendix**. If you deselect the option **hide detailed images**, a chart that shows statement occurrences in programs is displayed for each IMS/DB. Use the arrow buttons to move the resources between the Available and Selected lists then click **Finish** to generate the report.

The Report summary section presents two charts that show the Access type distribution and the Statement occurrences per IMS/DB.

The Report details section shows for all selected IMS/DB, all the programs that use those databases grouped by the accessed segment, whether directly or indirectly, that is, through the corresponding logical segment.

**Includes-Programs Report**
This program shows for each Include, all the programs that use it.

To generate this report, go to Explore Projects view and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.
The Available Includes area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

The Report summary section presents the total number of includes, the number of programs that access includes, the maximum number of distinct programs that access one include, the minimum number of distinct programs that access one include, and the average number of distinct programs that access one include followed by a chart that shows the Include distribution per programs.

The Report details section shows for all selected includes, all the programs that use those includes.

**Jobs-Datasets Report**
This report shows for each job, all the datasets that are used by the selected job.

To generate this report, go to Explore Projects view and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available Jobs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what extra data to include in the appendix: show input details in appendix. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

The Report summary section presents two charts that present the Datasets usage ratio and the Used datasets distribution.

The Report details section presents for each selected job the list of all used datasets. Furthermore, for each dataset the report presents the list of specific programs that access it. For each specific program, the corresponding type is presented. If it is confirmed that the corresponding dataset statement is used in that program, the number of occurrences is also displayed.

**Jobs-Networks Report**
This report shows for each selected job, all the networks that include the selected job.

To generate this report, go to Explore Projects view and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available Jobs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

The Report details section presents for each selected job, the list of all networks that include that job.

**Jobs-SQL Tables Report**
This report shows for each job, all the SQL tables accessed based on the usage of the related programs.

To generate this report, go to Explore Projects view and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available Jobs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.
The Report summary section presents two charts presenting SQL tables usage ratio and Used SQL tables distribution.

The Report details section presents for each job the SQL tables that are accessed through the selected job as well as the name of the entity using the job to access the SQL table and the number of occurrences.

**MQueues-Programs Report**
This report shows for each MQueue resource, all the programs that use it.

To generate this report, go to **Explore Projects** view and select **Mainframe Reports** list. Select **Where Used Reports**, then double-click the desired report to display the report wizard.

The Available Jobs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the **Name** field to filter the contents of the list. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: **show input details in appendix**. Use the arrow buttons to move the resources between the Available and Selected lists then click **Finish** to generate the report.

The Report summary section presents two charts that show the Programs usage ratio and the MQueues distribution per programs.

The Report details section shows for all selected MQueues, all the programs that use those MQueues.

**Networks-Jobs Report**
This report shows all the jobs included in a selected network.

To generate this report, go to **Explore Projects** view and select **Mainframe Reports** list. Select **Where Used Reports**, then double-click the desired report to display the report wizard.

The Available networks area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the **Name** field to filter the contents of the list. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: **show input details in appendix**. Use the arrow buttons to move the resources between the Available and Selected lists then click **Finish** to generate the report.

The Report summary section presents two charts that show the jobs usage ratio and the network distribution per programs.

The Report details section shows for all selected networks, all the jobs included in those networks.

**Programs-Adabas Report**
This report shows for each program, all Adabas files used.

To generate this report, go to **Explore Projects** view and select **Mainframe Reports** list. Select **Where Used Reports**, then double-click the desired report to display the report wizard.

The Available Programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the **Name** field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: **show input details in appendix**. Use the arrow buttons to move the resources between the Available and Selected lists then click **Finish** to generate the report.

The Report summary section presents two charts that show the Adabas usage ratio and the Used Adabas Distribution.

The Report details section shows for all selected programs, all Adabas files used.
**Programs-DAL Report**
This report shows for each program, all DAL files that use it.

To generate this report, go to *Explore Projects* view and select *Mainframe Reports* list. Select *Where Used Reports*, then double-click the desired report to display the report wizard.

The Available Programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

The Report summary section presents two charts that show the DAL usage ratio and the Used DAL Distribution.

The Report details section shows for all selected programs, all DAL files used.

**Programs-Datacom Report**
This report shows for each program, all Datacom tables used.

To generate this report, go to *Explore Projects* view and select *Mainframe Reports* list. Select *Where Used Reports*, then double-click the desired report to display the report wizard.

The Available Programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

The Report summary section presents two charts that show the Datacom tables usage ratio and the Used Datacom tables Distribution.

The Report details section shows for all selected programs, all Datacom used.

**Programs-DBI Report**
This report shows for each program, all DBI tables used.

To generate this report, go to *Explore Projects* view and select *Mainframe Reports* list. Select *Where Used Reports*, then double-click the desired report to display the report wizard.

The Available Programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

The Report summary section presents two charts that show the DBI tables usage ratio and the Used DBI tables Distribution.

The Report details section shows for all selected programs, all DBI tables used.

**Programs-Files Report**
Use this report to generate results on all files used for each program.

To generate this report, go to *Explore Projects* view and select *Mainframe Reports* list. Select *Where Used Reports*, then double-click the desired report to display the report wizard.
The Available Programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

The Report summary section presents two charts that show the Files usage ratio and the Used files distribution.

The Report details section shows for all selected programs, the logical names of all files used.

Programs-IDMSX Records Report
This report shows for each program, all IDMSX records accessed.

Note: This report is only available for VME projects.

To generate this report, go to Explore Projects view and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. If you deselect the option hide detailed images, a chart that shows statement occurrences in programs is displayed for each IDMSX record. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

The Report summary section presents two charts that show the IDMSX records usage ratio and the Used IDMSX records distribution.

The Report details section presents for each program: the name of the IDMSX records accessed, the statement type and the occurrences.

Programs-IDMS Records Report
This report shows for each program, all IDMS records accessed.

To generate this report, go to Explore Projects view and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available Programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. If you deselect the option hide detailed images, a chart that shows statement occurrences in programs is displayed for each IDMS record. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

The Report summary section presents two charts that show the IDMS records usage ratio and the Used IDMS records distribution.

The Report details section shows for all selected programs, all records accessed.

Programs-IDMSX Sets Report
This report shows for each program, all IDMSX Sets accessed.

Note: This report is only available for VME projects.
To generate this report, go to **Explore Projects** view and select **Mainframe Reports** list. Select **Where Used Reports**, then double-click the desired report to display the report wizard.

The Available programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the **Name** field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: **show input details in appendix**. If you deselect the option **hide detailed images**, a chart that shows statement occurrences in programs is displayed for each IDMSX set. Use the arrow buttons to move the resources between the Available and Selected lists then click **Finish** to generate the report.

The Report summary section presents two charts that show the IDMSX sets usage ratio and the Used IDMSX sets distribution.

The Report details section presents for each program: the name of the IDMSX sets accessed, the statement type and the occurrences.

**Programs-IDMS Sets Report**
This report shows for each program, all IDMS Sets accessed.

To generate this report, go to **Explore Projects** view and select **Mainframe Reports** list. Select **Where Used Reports**, then double-click the desired report to display the report wizard.

The Available Programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the **Name** field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: **show input details in appendix**. If you deselect the option **hide detailed images**, a chart that shows statement occurrences in programs is displayed for each IDMS set. Use the arrow buttons to move the resources between the Available and Selected lists then click **Finish** to generate the report.

The Report summary section presents two charts that show the IDMS sets usage ratio and the Used IDMS sets distribution.

The Report details section shows for all selected programs, all IDMS sets accessed.

**Programs-IMS DB Report**
This report shows for each program, the name of the IMS/DB accessed.

To generate this report, go to **Explore Projects** view and select **Mainframe Reports** list. Select **Where Used Reports**, then double-click the desired report to display the report wizard.

The Available Programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the **Name** field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: **show input details in appendix**. If you deselect the option **hide detailed images**, a chart that shows statement occurrences in programs is displayed for each IMS/DB. Use the arrow buttons to move the resources between the Available and Selected lists then click **Finish** to generate the report.

The Report summary section presents two charts that show the IMS/DB usage ratio and the Used IMS/DB distribution.

The Report details section presents for each program: the name of the IMS/DB accessed, the segment, the type of statement and the statement occurrences.
**Programs-Includes Report**
This report shows for each program, all Includes accessed.

To generate this report, go to **Explore Projects** view and select **Mainframe Reports** list. Select **Where Used Reports**, then double-click the desired report to display the report wizard.

The Available Programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the **Name** field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: **show input details in appendix**. Use the arrow buttons to move the resources between the Available and Selected lists then click **Finish** to generate the report.

The Report summary section presents the following data: the total number of programs, the number of accessed includes, the maximum number of includes accessed from a program, the minimum number of includes accessed from a program, and the average number of includes accessed from a program. Also, the summary presents two charts that show Programs accessing includes usage ratio and the Include distribution per file.

The Report details section shows for all selected programs, all includes accessed.

**Programs-Literals Report**
This report shows for each program, all string literals.

To generate this report, go to **Explore Projects** view and select **Mainframe Reports** list. Select **Where Used Reports**, then double-click the desired report to display the report wizard.

The Available Programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the **Name** field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: **show input details in appendix**. If you deselect the option **hide detailed images**, a chart that shows literals occurrences is displayed for each program. Use the arrow buttons to move the resources between the Available and Selected lists then click **Next**.

In the second dialog window of the report wizard, a list of search patterns is displayed. Use **Add** to add new search patterns to the list. Each keyword can contain wildcard characters, use **Remove**, or **Remove all** to clear the list of search criteria. Click **Finish** button to start generating the report.

The Report summary section presents two charts that show the Literals usage ratio and the Used literals distribution.

The Report details section shows for all selected programs, all string literals.

**Programs-MQueues Report**
This report shows for each program, all the MQueues accessed.

To generate this report, go to **Explore Projects** view and select **Mainframe Reports** list. Select **Where Used Reports**, then double-click the desired report to display the report wizard.

The Available Programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the **Name** field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: **show input details in appendix**. Use the arrow buttons to move the resources between the Available and Selected lists then click **Next** to generate the report.
The Report summary section presents two charts that show the MQueues usage ratio and the Used MQueues distribution.

The Report details section presents for each program: the MQueue accessed, the type of statement and the statement occurrences.

**Programs-SQL Tables Report**
This report shows for each program the name of the SQL table that is referenced, the type of statement and the statement occurrences.

To generate this report, go to Explore Projects view and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available Programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. Use the arrow buttons to move the resources between the Available and Selected lists then click Next to generate the report.

The Report summary section presents two charts that show the SQL tables usage ratio and the Used SQL tables distribution.

The Report details section presents for each program: the name of the SQL table that are referenced, the type of statement and the statement occurrences.

**Programs-Variables Report**
This report shows for each program, all variables.

To generate this report, go to Explore Projects view and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available Programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. Use the arrow buttons to move the resources between the Available and Selected lists. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. If you deselect the option hide detailed images, a chart that shows variables occurrences is displayed for each program.

Click Next to display the second dialog window of the report wizard: A list of search patterns is displayed. Use Add to add search patterns to the list. Each keyword can contain wildcard characters, use Remove or Remove all to clear the list of search criteria. Click Finish to start generating the report.

The Report summary section presents two charts that show the Variables usage ratio and the Used variables distribution.

The Report details section shows for all selected programs, all variables.

**Record Groups-DDCL Report**
This report shows for each record group, all DDCL elements that use that record group.

**Note:** This report is only available for VME projects.

To generate this report, go to Explore Projects view and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available Record Groups area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. If you
deselect the option hide detailed images, a chart that shows record groups occurrences is displayed for each DDCL. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

The Report summary section presents two charts that show the Access type distribution and the Occurrences per record group.

The Report details section shows for all selected record groups, all programs that use those record groups.

**Records-DDCL Report**
This report shows for each record, all DDCL elements that use that record.

**Note:** This report is only available for VME projects.

To generate this report, go to Explore Projects view and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available records area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. If you deselect the option hide detailed images, a chart that shows records occurrences is displayed for each DDCL. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

The Report summary section presents two charts that show the Access type distribution and the Occurrences per record.

The Report details section shows for all selected records, all programs that use those records.

**SCL-Files Report**

**Note:** This report is only available for VME projects.

To generate this report, in Explore Projects view, go to the Mainframe Reports list in the panel to the right. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

The Report summary section presents two charts that show the Files usage ratio and the Used files distribution.

The report details section presents for each SCL procedure: the name of the files accessed, the statement type, and the occurrences.

**Sets-DDCL Report**
This report shows for each set, all DDCL elements that use it.

**Note:** This report is only available for VME projects.

To generate this report, go to Explore Projects view and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available sets area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. If you deselect the option hide detailed images a chart that shows sets occurrences is displayed for each DDCL. Use the
arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

The Report summary section presents two charts that show the Access type distribution and the Statement occurrences per IDMS set.

The Report details section shows for all selected sets, all programs that use those sets.

**SQL Tables-Jobs Report**
This report shows for each SQL table, all the jobs that access it based on the usage of the related programs for those jobs.

To generate this report, go to Explore Projects view and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available SQL Tables area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

The Report summary section presents two charts that show SQL tables usage ratio and SQL table distribution per jobs.

The Report details section presents for each SQL table, all the jobs based on the usage of the related programs.

**SQL Tables-Programs Report**
This report shows for each SQL Table, all the programs that use it.

To generate this report, go to Explore Projects view and select Mainframe Reports list. Select Where Used Reports, then double-click the desired report to display the report wizard.

The Available SQL Tables area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. In Report generation options area, the selection indicates that the report appendix is displayed by default. Choose what additional data to include in the appendix: show input details in appendix. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

The Report summary section presents two charts that show the SQL tables usage ratio and the SQL tables distribution per programs.

The Report details section shows for all selected SQL Tables, all the programs that use those SQL tables.

**Shared Resources Report**
To generate the Shared Resources Report, in Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects view, select the projects for which you want to generate a Shared Resources Report. For details on how to select a perspective and a description of Application Discovery Browser perspective, see IBM AD Analyze Client Reference.

To generate this report, goto Shared Resources section, and double-click Shared Resources Report to display the Shared Resources Report wizard dialog window.

The Available types area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Use the Name field to filter the contents of the list. Use the arrow buttons to move elements between the Available and Selected lists then click Finish to generate the report.
**Compare Projects Report**

The compare operation can be performed on two or more projects. For mainframe projects, the comparison can be performed only between two projects.

To generate the **Compare Projects Report**, goto **Application Discovery Browser** perspective, and select the projects for which you want to generate a Compare Projects report. For details on how to select a perspective and a description of Application Discovery Browser perspective, see **IBM AD Analyze Client Reference**.

In the Compare Analysis section, to the right of the Explore Projects view, double-click Compare Projects Report to generate the report.

The report summary presents a list with the total numbers of elements that were Added, Changed, and Removed, grouped by category. Then, under the Added, Changed, and Removed sections the report presents the detailed list of resources identified as such.

---

**Java Reports**

**Java Complexity Reports**

**Java Complexity Report**

This report presents complexity measurements developed to measure the complexity of a class directly from source code.

To generate this report, goto **Explore Projects > Java Reports list > Complexity Reports** and double-click the desired report to display the report wizard.

The Available programs area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the **Name** field to filter the contents of the list. Place the cursor over an icon to display a tooltip about the type of resource it displays and click it to display only the selected type of resource. To display the full name of the resource type, click the white arrow button to the left of the dialog window. Use the arrow buttons to move the resources between the Available and Selected lists then click **Finish** to generate the report.

The Report summary section presents two charts that show the Complexity percentage distribution and the Files complexity distribution as well as a Complexity score table for all the selected resources.

The Report details section shows for each selected resource: the resource name, the McCabe value calculated for it, and the corresponding complexity value.

**McCabe Complexity Report**

The McCabe Complexity Report for Java projects presents Cyclomatic complexity (a broad measure of soundness and confidence for a class) for each project entity. Cyclomatic complexity measures the number of linearly-independent paths through a class. This report presents the complexity percentage distribution graph and file complexity distribution graph for the project.

**Note:** The settings for the McCabe complexity report are available in the Preferences dialog window. For details, see McCabe Complexity Report Java.

To generate this report, goto **Explore Projects > Java Reports list > Complexity Reports** and double-click the desired report to display the report wizard.

The Available resources area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the arrow buttons to move the resources between the Available and Selected lists then click **Finish** to generate the report.

The Report summary section presents two charts that show the Complexity percentage distribution and the Files complexity distribution as well as a Complexity score table for all the selected resources.
The Report details section shows for each selected resource: the resource name, the McCabe value calculated for it and the corresponding complexity value.

**Inventory Reports for Java Projects**

**Java Dead Code Report**
This report lists all Java methods that are not referenced by other methods within the project.

These methods must be tested to determine whether they are main methods (and therefore are not referenced) or whether they are not used and can be considered dead code.

To generate this report, goto Explore Projects > Java Reports list > Inventory Reports and double-click the desired report to display the report wizard.

The Report summary section presents the list of unused methods that were found.

**Java Inventory Report**
This report presents a list of all the components in the current project.

To generate this report, goto Explore Projects > Java Reports list > Inventory Reports and double-click the desired report to display the report wizard.

The generated report presents a summary with the total number of resources grouped by type, followed by the detailed list of the resources found in the project.

**Third-Party Usage Report**
The Third-Party Usage Report presents a list of the classes that use third-party entities (classes and packages).

To generate this report, goto Explore Projects > Java Reports list > Inventory Reports and double-click the desired report to display the report wizard.

The Available resources area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

**Java Where Used SQL Table**
This report shows for each SQL Table, all the Java resources that use it.

To generate this report, goto Explore Projects > Java Reports list > Java Where Used SQL Table to display the report wizard.

The Available SQL Tables area displays the resources available for report generation and allows the user to select the resources to be included in the report. Use the Name field to filter the contents of the list. Use the arrow buttons to move the resources between the Available and Selected lists then click Finish to generate the report.

The Report summary section presents two charts that show the SQL tables usage ratio and the SQL tables distribution per Java resource.

The Report details section shows for all selected SQL Tables, all the Java resources that use those SQL tables.
Chapter 8. Usage

Usage in Jobs

Dataset Usage in Jobs

Presents the Dataset Usage in Jobs analysis available in IBM AD Analyze Client.

Dataset Usage in Jobs tab shows defined datasets within project sources.

To display Dataset Usage in Jobs tab, go to Explore Projects tab and select Dataset Usage in Jobs from the Usage in Jobs list of analyses to the right of the screen.

Figure 35: Dataset Usage in Jobs

The central part of the screen displays the list of attribute filters. The breadcrumb displays the selected projects, the selected attributes together with the filters set for each attribute.

Click the Filter field to the right of an attribute name and enter the filter that you want to use for the attributes' names. After you press Apply, only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of attributes of a certain type that are returned by the filtering operation, use the fields in the Limit column. The default limit is 50; the maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see Dataset Usage in Jobs Settings. The Context column displays the context of the filter operation where relevant. The context of the first attribute filter in the list is the project. The context of any other attribute filter in the list is the attribute above it in the list.

To the right of Attribute filters area, the list of projects is displayed. Use Save to save the current filter configuration. Use Load to load a previously saved filter configuration.

By default, Enable levels limit is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press Apply to apply the selected filters. After the filtering operation is finished, you can use the black arrow button in
the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the Dataset Usage in Jobs parameters in a separate tab, use the arrow button in the upper right corner of the Dataset Usage in Jobs tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button, find only annotated to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area the following buttons are available:

- **Expand all**, click this button to expand the tree.
- **Collapse all**, click this button to fold all the tree branches.
- **Export Results to CSV File**, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the Properties view displays the information available for the selected element.

In the tree, double-click an element to open the corresponding file at the occurrence line. The following nodes are available:

<table>
<thead>
<tr>
<th>Table 11: Dataset Usage in Jobs tab nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node name</strong></td>
</tr>
<tr>
<td>Dataset</td>
</tr>
<tr>
<td>Job</td>
</tr>
<tr>
<td>Program/step</td>
</tr>
<tr>
<td>DD Name</td>
</tr>
</tbody>
</table>

**Node pop-up menu**

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. View analysis source and Copy options are available for all nodes. According to the selected node, several Collapse to ... Level options might also be available.

**Job Usage Inventory**

Job Usage Inventory tab shows the structure of the JCL listing the defined datasets, executed procedures, and programs.

To display Job Usage Inventory tab, in Explore Projects tab double-click Job Usage Inventory from the Usage in Jobs list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. The breadcrumb displays the selected projects, the selected attributes together with the filters set for each attribute. Click the Filter field to the right of an attribute name and enter the filter that you want to use for the attributes' names. After you press Apply, only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of attributes of a certain type that are returned by the filtering operation, use the fields in the Limit column. The default limit is 50; the maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see Job Usage Inventory Settings. The Context column displays the context of the filter operation where relevant.

To the right of Attribute filters area, the list of projects is displayed. Use Save to save the current filter configuration. Use Load to load a previously saved filter configuration.
By default, **Enable levels limit** is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press **Apply** to apply the selected filters. After the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the Job Usage Inventory parameters in a separate tab, use the arrow button in the upper right corner of the **Job Usage Inventory** tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button **find only annotated** to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area the following buttons are available:

**Expand all**, click this button to expand the tree.

**Collapse all**, click this button to fold all the tree branches.

**Export Results to CSV File**, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the **Properties** view displays the information available for the selected element.

In the tree, double-click an element to open the corresponding file at the occurrence line. The following nodes are available:

<table>
<thead>
<tr>
<th>Node name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jobs</td>
<td>Shows the list of jobs that were found in the resources of the selected project.</td>
</tr>
<tr>
<td>Datasets</td>
<td>Lists the datasets defined in JCL.</td>
</tr>
<tr>
<td>Procedures</td>
<td>Lists the procedures that were identified in the job.</td>
</tr>
<tr>
<td>Programs</td>
<td>Lists the programs that are executed in JCL.</td>
</tr>
</tbody>
</table>

**Node pop-up menu**

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. **View analysis source** and **Copy** options are available for all nodes. According to the selected node, several **Collapse to ... Level** options might also be available.

**Pgm Usage in Jobs**

The **Pgm Usage in Jobs** tab shows the programs to be executed in jobs.

To display **Pgm Usage in Jobs** tab, in **Explore Projects** tab double-click Pgm Usage in Jobs from the Usage in Jobs list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. The breadcrumb displays the selected projects, the selected attributes together with the filters set for each attribute.

Click the **Filter** field to the right of an attribute name and enter the filter that you want to use for the attributes' names. After you press **Apply**, only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of attributes of a certain type that are returned by the filtering operation, use the fields in the Limit column. The default limit is 50; the maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see **Pgm Usage in Jobs Settings**. The Context column displays the context of the filter.
operation where relevant. The context of the first attribute filter in the list is the project. The context of any other attribute filter in the list is the attribute above it in the list.

To the right of Attribute filters area, the list of projects is displayed. Use Save to save the current filter configuration. Use Load to load a previously saved filter configuration.

By default, Enable levels limit is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press Apply to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the Pgm Usage in Jobs parameters in a separate tab, use the arrow button in the upper right corner of Pgm Usage in Jobs tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button, find only annotated to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area the following buttons are available:

Expand all, click this button to expand the tree.
Collapse all, click this button to fold all the tree branches.
Export Results to CSV File, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. Once you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the Properties view displays the information available for the selected element.

In the tree, double-click an element to open the corresponding file at the occurrence line. The following nodes are available:

<table>
<thead>
<tr>
<th>Table 13: Pgm Usage in Jobs Tab nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node name</strong></td>
</tr>
<tr>
<td>Program</td>
</tr>
<tr>
<td>Job</td>
</tr>
<tr>
<td>Step</td>
</tr>
<tr>
<td>DD Name</td>
</tr>
<tr>
<td>Dataset</td>
</tr>
</tbody>
</table>

**Node pop-up menu**

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. View analysis source and Copy options are available for all nodes. According to the selected node, several Collapse to ... Level options might also be available.

**Procedure Usage in Jobs**

The Procedure Usage in Jobs tab shows the procedures invoked by jobs. To display the Procedure Usage in Jobs tab, in Explore Projects tab double-click Procedure Usage in Jobs from the Usage in Jobs list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. The breadcrumb displays the selected projects, the selected attributes together with the filters set for each attribute. Click the Filter field to the right of an attribute name and enter the filter you want to use for the attributes' names. When you press Apply, only the elements matching the name filter are displayed in the Results area. Special characters
can be used; for example, you can use the special character ‘*’ and add to it either prefixes or suffixes as in "AAA*" or "**AAA". To limit the number of attributes of a certain type that are returned by the filtering operation, use the fields in the Limit column. The default limit is 50; the maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see Procedure Usage in Jobs Settings.

The Context column displays the context of the filter operation where relevant. The context of the first attribute filter in the list is the project. The context of any other attribute filter in the list is the attribute above it in the list.

To the right of Attribute filters area, the list of projects is displayed. Use Save to save the current filter configuration. Use Load to load a previously saved filter configuration.

By default, Enable levels limit is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press Apply to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the Procedure Usage in Jobs parameters in a separate tab, use the arrow button in the top right corner of Procedure Usage in Jobs tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button find only annotated to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area the following buttons are available:

Expand all, click this button to expand the tree.

Collapse all, click this button to fold all the tree branches.

Export Results to CSV File, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip presenting the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the Properties view displays the information available for the selected element.

In the tree, double-click an element to open the corresponding file at the occurrence line. The following nodes are available:

Table 14: Procedure Usage in Jobs nodes

<table>
<thead>
<tr>
<th>Node name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Procedure</td>
<td>Lists the procedures that were identified in the resources of the selected project.</td>
</tr>
<tr>
<td>Job</td>
<td>Shows the job where the procedure is invoked.</td>
</tr>
<tr>
<td>Step</td>
<td>Shows the step where the DD library is mentioned.</td>
</tr>
<tr>
<td>DD Name</td>
<td>Shows the name of the DD library.</td>
</tr>
<tr>
<td>Dataset</td>
<td>Shows the dataset name.</td>
</tr>
</tbody>
</table>

Node pop-up menu

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node that is selected. View analysis source and Copy options are available for all nodes. According to the selected node, several Collapse to ... Level options might also be available.
Usage in Programs

Adabas Usage

The **Adabas Usage** tab presents how the Adabas is being used throughout the programs, such as Natural and Cobol.

To display the **Adabas Usage** tab, in **Explore Projects** tab double-click **Adabas Usage** from the Usage in Programs list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. By default, all attributes are selected; deselect the ones that you do not want to use. The breadcrumb displays the selected project or projects, the selected attributes together with the filters set for each attribute. Click the **Filter** field to the right of an attribute name and enter the filter that you want to use for the attributes' names. When you press **Apply**, only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of attributes of a certain type that are returned by the filtering operation, use the fields in the Limit column. The default limit is 50; the maximum limit can be set in the corresponding **Usage Settings** section from **Preferences**. For details see, **Adabas Usage Settings**. The Context column displays the context of the filter operation where relevant. To modify the attributes' order in the list use the green arrow buttons to the left of the attributes list. When changing the attributes' order, the context of the filtering operation changes accordingly.

To the right of Attribute filters area, the list of projects is displayed. Use **Save** to save the current filter configuration. Use **Load** to load a previously saved filter configuration.

By default, **Enable levels limit** is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press **Apply** to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the **Adabas Usage** parameters in a separate tab, use the arrow button in the upper right corner of **Adabas Usage** tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button, **find only annotated** to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available:

- **Reorder current results**, use this button to reorder the results using a different filter configuration. A dialog window presents the list of filters that were used to perform the initial filtering and you can set them in the desired order.
- **Expand all**, click this button to expand the tree.
- **Collapse all**, click this button to fold all the tree branches.
- **Export Results to CSV File**, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the **Properties** view displays the information available for the selected element.

In the tree, double-click a paragraph, variable, or include to open the corresponding file at the occurrence line.

The available nodes depend on the type of Adabas resource selected. If the Adabas resource is accessed by Natural programs, the following nodes are available:
**Table 15: Adabas Usage Tab nodes - Natural**

<table>
<thead>
<tr>
<th>Node name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adabas DB</td>
<td>Shows the Adabas DB ID.</td>
</tr>
<tr>
<td>Adabas File</td>
<td>Shows the Adabas file number.</td>
</tr>
<tr>
<td>Adabas View</td>
<td>Presents the view that is used to see the statement. This option can be used to check in which view or views each statement is used. The View name is presented as a concatenation of the following elements: the name of Adabas View, the name of Natural DB View, and the resource name (the Data Area name).</td>
</tr>
<tr>
<td>Program</td>
<td>Opens the program file at the Program ID row.</td>
</tr>
<tr>
<td>Statement type</td>
<td>Displays the statement types.</td>
</tr>
<tr>
<td>Statement Source Occurrences</td>
<td>Opens the program at the line that contains the selected statement.</td>
</tr>
</tbody>
</table>

If the Adabas resource is accessed by Cobol programs, the following nodes are available.

**Table 16: Adabas Usage Tab nodes - Cobol**

<table>
<thead>
<tr>
<th>Node name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adabas DB</td>
<td>Shows the Adabas DB ID.</td>
</tr>
<tr>
<td>Adabas File</td>
<td>Shows the Adabas file number.</td>
</tr>
<tr>
<td>Adabas View</td>
<td>Presents the view that is used to see the statement. This option can be used to check in which view or views each statement is used. The View name is presented as N/A (not available) for Cobol programs with Adabas direct call and as Adabas view name for Cobol programs with Adabas Native SQL.</td>
</tr>
<tr>
<td>Program</td>
<td>Opens the program file at the Program ID row.</td>
</tr>
<tr>
<td>Statement type</td>
<td>Displays the statement types.</td>
</tr>
<tr>
<td>Statement Source Occurrences</td>
<td>Opens the program at the line that contains the selected statement.</td>
</tr>
</tbody>
</table>

**Node pop-up menu**

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. **View analysis source** and **Copy** options are available for all nodes. According to the selected node, several **Collapse to ... Level** options might also be available.

**Assembler Program Structure**

The **Assembler Program Structure** tab presents the structure of the Assembler programs in the current project.

To display the **Assembler Program Structure** tab, go to **Explore Projects** tab and select **Assembler Program Structure** from the **Usage in Programs** list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. By default, all attributes are selected; deselect the ones that you do not want to use. The breadcrumb displays the selected projects, the selected attributes together with the filters set for each attribute. Click the **Filter** field to the right of an attribute name and enter the filter that you want to use for the attributes' names. When you press **Apply**, only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character "*" and add to it either prefixes or suffixes as in
"AAA*" or "*AAA". To limit the number of attributes of a certain type that are returned by the filtering operation, use the fields in the Limit column. The default limit is 10; the maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see Assembler Program Structure Settings. The Context column displays the context of the filter operation where relevant. To the right of Attribute filters area, the list of projects is displayed.

Use **Save** to save the current filter configuration. Use **Load** to load a previously saved filter configuration.

By default, **Enable levels limit** is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press **Apply** to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the Assembler Program Structure parameters in a separate tab, use the arrow button in the upper right corner of Assembler Program Structure tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button **find only annotated** to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available:

- **Expand top 4 levels**, click this button to expand the top four levels of the tree.
- **Collapse all**, click this button to fold all the tree branches.
- **Export Results to CSV File**, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the **Properties** view displays the information available for the selected element.

In the tree, double-click an element to open the corresponding file at the occurrence line. The following nodes are available:

<table>
<thead>
<tr>
<th>Table 17: Assembler Program Structure tab nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node name</strong></td>
</tr>
<tr>
<td>Assembler Program</td>
</tr>
<tr>
<td>CSECT</td>
</tr>
<tr>
<td>ENTRY</td>
</tr>
<tr>
<td>Macro</td>
</tr>
<tr>
<td>Includes</td>
</tr>
</tbody>
</table>

**Node pop-up menu**

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. **View analysis source** and **Copy** options are available for all nodes. According to the selected node, several **Collapse to ... Level** options might also be available.

### Assembler Variable Usage

The **Assembler Variable Usage** tab presents the usage of variables in the Assembler programs in the current project.

To display the **Assembler Variable Usage** tab, go to **Explore Projects** tab and select **Assembler Variable Usage** from the **Usage in Programs** list of analyses to the right of the screen.
The central part of the screen displays the list of attribute filters. The breadcrumb displays the selected projects and all attributes together with the filters set for each attribute. Click the Filter field to the right of an attribute name and enter the filter that you want to use for the attributes’ names. When you press Apply, only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character "***" and add to it either prefixes or suffixes as in "AAA***" or "***AAA". To limit the number of attributes of a certain type that are returned by the filtering operation, use the fields in the Limit column. The default limit is 10; the maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see Assembler Variable Usage Settings. The Context column displays the context of the filter operation where relevant. To the right of Attribute filters area, the list of projects is displayed.

Use Save to save the current filter configuration. Use Load to load a previously saved filter configuration.

By default, Enable levels limit is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press Apply to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the Assembler Variable Usage parameters in a separate tab, use the arrow button in the upper right corner of Assembler Variable Usage tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button find only annotated to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available:

Expand top 4 levels, click this button to expand the top four levels of the tree.

Collapse all, click this button to fold all the tree branches.

Export Results to CSV File, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the Properties view displays the information available for the selected element.

In the tree, double-click an element to open the corresponding file at the occurrence line. The following nodes are available:

<table>
<thead>
<tr>
<th>Table 18: Assembler Variable Usage Tab nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node name</strong></td>
</tr>
<tr>
<td>Assembler program</td>
</tr>
<tr>
<td>CSECT</td>
</tr>
<tr>
<td>ENTRY</td>
</tr>
<tr>
<td>Variables</td>
</tr>
</tbody>
</table>

Node pop-up menu

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. View analysis source and Copy options are available for all nodes. According to the selected node, severalCollapse to ... Level options might also be available.
Cobol Program Structure

The Cobol Program Structure tab shows the structure of Cobol programs by paragraph and copybook usage.

To display the Cobol Program Structure tab, go to Explore Projects tab and select Cobol Program Structure from the Usage in Programs list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. By default, all attributes are selected; deselect the ones that you do not want to use. The breadcrumb displays the selected projects, the selected attributes together with the filters set for each attribute. Click the Filter field to the right of an attribute name and enter the filter that you want to use for the attributes’ names. When you press Apply, only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "AAA*" or "**AAA".

To limit the number of attributes of a certain type that are returned by the filtering operation, use the fields in the Limit column. The default limit is 10; the maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see Cobol Program Structure Settings. The Context column displays the context of the filter operation where relevant. To the right of Attribute filters area, the list of projects is displayed.

Use Save to save the current filter configuration. Use Load to load a previously saved filter configuration.

By default, Enable levels limit is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press Apply to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the Cobol Program Structure parameters in a separate tab, use the arrow button in the upper right corner of Cobol Program Structure tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button find only annotated to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available:

Expand top 2 levels, click this button to expand the top two levels of the tree.

Collapse all, click this button to fold all the tree branches.

Export Results to CSV File, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the Properties view displays the information available for the selected element.

In the tree, double-click a paragraph or include to open the corresponding file at the occurrence line. The following nodes are available:

<table>
<thead>
<tr>
<th>Table 19: Cobol Program Structure Tab nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node name</strong></td>
</tr>
<tr>
<td>COBOL file</td>
</tr>
<tr>
<td>Paragraphs</td>
</tr>
<tr>
<td>Includes</td>
</tr>
</tbody>
</table>
Node pop-up menu
Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. View analysis source and Copy options are available for all nodes. According to the selected node, several Collapse to ... Level options might also be available.

Cobol Variable Usage
The Cobol Variable Usage tab shows variable usage in Cobol programs in the current project.s

To display the Cobol Variable Usage tab, go to Explore Projects tab and select Cobol Variable Usage from the Usage in Programs list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. The breadcrumb displays the selected projects and all attributes together with the filters set for each attribute. Click the Filter field to the right of an attribute name and enter the filter you want to use for the attributes' names. When you press Apply, only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of attributes of a certain type that are returned by the filtering operation, use the fields in the Limit column. The default limit is 10; the maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see Cobol Variable Usage Settings. The Context column displays the context of the filter operation where relevant. To the right of Attribute filters area, the list of projects is displayed.

Use Save to save the current filter configuration. Use Load to load a previously saved filter configuration.

By default, Enable levels limit is selected and the number of elements which are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press Apply to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the Cobol Variable Usage parameters in a separate tab, use the arrow button in the top right corner of Cobol Variable Usage tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button find only annotated to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available:

Expand top 2 levels, click this button to expand the top two levels of the tree.

Collapse all, click this button to fold all the tree branches.

Export Results to CSV File, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip presenting the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the Properties view displays the information available for the selected element.

In the tree, double-click a variable to open the corresponding file at the occurrence line. The following nodes are available:

<table>
<thead>
<tr>
<th>Table 20: Cobol Variable Usage Tab nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node name</strong></td>
</tr>
<tr>
<td>COBOL file</td>
</tr>
<tr>
<td>Variables</td>
</tr>
</tbody>
</table>
Cobol Variable Usage pop-up menu

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. View analysis source and Copy options are available for all nodes. According to the selected node, several Collapse to ... Level options might also be available.

DAL Usage

The DAL Usage tab shows the access to the DAL files within the Cobol programs in the current project. For each DAL file, the programs and the statement types that reference the file are shown and for each statement type, the occurrences of the statement (the file and location within the file) are listed.

To display the DAL Usage tab, go to Explore Projects tab and select DAL Usage from the Usage in Programs list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. By default, all attributes are selected; deselect the ones that you do not want to use. The breadcrumb displays the selected projects, the selected attributes together with the filters set for each attribute. Click the Filter field to the right of an attribute name and enter the filter that you want to use for the attributes' names. When you press Apply, only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of attributes of a certain type that are returned by the filtering operation, use the fields in the Limit column. The default limit is 50; the maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see DAL Usage in Program Settings. The Context column displays the context of the filter operation where relevant. To the right of Attribute filters area, the list of projects is displayed.

Use Save to save the current filter configuration. Use Load to load a previously saved filter configuration.

By default, Enable levels limit is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press Apply to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the DAL Usage parameters in a separate tab, use the arrow button in the upper right corner of DAL Usage tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button find only annotated to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available:

Reorder current results, use this button to reorder the results using a different filter configuration. A dialog window presents the list of filters that were used to perform the initial filtering and you can set them in the desired order.

Expand all, click this button to expand tree branches.

Collapse all, click this button to fold all the tree branches.

Export Results to CSV File, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the Properties view displays the information available for the selected element.

The following nodes are available:
Table 21: DAL Usage Tab nodes

<table>
<thead>
<tr>
<th>Node name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DAL file</td>
<td>Presents a list of the DAL files in the project. The information in the sub-tree under the DAL file represents where used information for the DAL file.</td>
</tr>
<tr>
<td>Program</td>
<td>Opens the selected program at the first line.</td>
</tr>
<tr>
<td>Statement type</td>
<td>This node represents the access type that is used to access the DAL file. If the access type is dynamic and cannot be resolved in the analysis stage, the access type “DAL: Dynamic Function” is shown. Child nodes show the name of the source file and the location (line number) of the DAL function.</td>
</tr>
</tbody>
</table>

Node pop-up menu

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. View analysis source and Copy options are available for all nodes. According to the selected node, several Collapse to ... Level options might also be available.

Datacom Table Usage

The Datacom Table Usage tab lists the Datacom tables that are used by the application. Nodes in the Datacom tab represent the different statement types that refer to the tables (ADDIT, LOCKX, UPDAT). For each statement type, the references in the source code (file name and location of the reference) are listed.

To display the Datacom Table Usage tab, go to Explore Projects and select Datacom Table Usage from the Usage in Programs list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. By default, all attributes are selected; deselect the ones that you do not want to use. The breadcrumb displays the selected projects, the selected attributes in the set order together with the filters set for each attribute. Click the Filter field to the right of an attribute name and enter the filter that you want to use for the attributes' names. When you press Apply, only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of elements to be returned by the filtering operation, use the fields in the Limit column. The default limit is 50; the maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see Datacom Table Settings. The Context column displays the context of the filter operation where relevant. The context of the first attribute filter in the list is the project. The context of any other attribute filter in the list is the attribute above it in the list. To modify the attributes' order in the list, use the green arrow buttons to the left of the attributes list. When the attributes' order changes, the context of the filtering operation changes. To the right of Attribute filters area, the list of projects is displayed.

Use Save to save the current filter configuration. Use Load to load a previously saved filter configuration.

By default, Enable levels limit is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press Apply to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the Dataset Usage in Programs parameters in a separate tab, use the arrow button in the upper right corner of Datacom Table Usage tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button find only annotated to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available:
Reorder current results, use this button to reorder the results using a different filter configuration. A dialog window presents the list of filters that were used to perform the initial filtering and you can set them in the desired order.

Expand all, click this button to expand the tree.

Collapse all, click this button to fold all the tree branches.

Export Results to CSV File, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the Properties view displays the information available for the selected element.

In the tree, double-click an element to open the corresponding file at the occurrence line. The following nodes are available:

<table>
<thead>
<tr>
<th>Table 22: Datacom Table Usage Tab nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node name</strong></td>
</tr>
<tr>
<td>Datacom table</td>
</tr>
<tr>
<td>Program</td>
</tr>
<tr>
<td>Statement type</td>
</tr>
<tr>
<td>Statement source info</td>
</tr>
</tbody>
</table>

Node pop-up menu

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. View analysis source and Copy options are available for all nodes. According to the selected node, several Collapse to ... Level options might also be available.

Dataset Usage in Programs

The Dataset Usage in Programs analysis gives a view of the application from the Data Sets point of view. For each physical Data Set used, you can see the places where it is referred to within the JCL jobs, the places where it is used in the COBOL programs, and also the way it is used by different programs.

To display the Dataset Usage in Programs tab, go to Explore Projects and select Dataset Usage in Programs from the Usage in Programs list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. By default, all attributes are selected; deselect the ones that you do not want to use. The breadcrumb displays the selected projects, the selected attributes in the set order together with the filters set for each attribute. Click the Filter field to the right of an attribute name and enter the filter that you want to use for the attributes' names. When you press Apply, only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character "**" and add to it either prefixes or suffixes as in "AAA**" or "**AAA". To limit the number of elements to be returned by the filtering operation, use the fields in the Limit column. The default limit is 50; the maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see Dataset Usage in Programs Settings. The Context column displays the context of the filter operation where relevant. The context of the first attribute filter in the list is the project. The context of any other attribute filter in the list is the attribute above it in the list. To modify the attributes' order in the list, use the green arrow buttons to the left of the attributes list. When the attributes' order changes, the context of the filtering operation changes. To the right of Attribute filters area, the list of projects is displayed.

Use Save to save the current filter configuration. Use Load to load a previously saved filter configuration.
By default, **Enable levels limit** is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press **Apply** to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the Dataset Usage in Programs parameters in a separate tab, use the arrow button in the upper right corner of **Dataset Usage in Programs** tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button **find only annotated** to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available:

- **Reorder current results**, use this button to reorder the results using a different filter configuration. A dialog window presents the list of filters that were used to perform the initial filtering and you can set them in the desired order.
- **Click Expand all** to expand the tree.
- **Click Collapse all** to fold all the tree branches.

Use **Export Results to CSV File** to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the **Properties** view displays the information available for the selected element.

In the tree, double-click an element to open the corresponding file at the occurrence line. The following nodes are available.

<table>
<thead>
<tr>
<th>Table 23: Dataset Usage in Programs Tab nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node name</strong></td>
</tr>
<tr>
<td>Dataset</td>
</tr>
<tr>
<td>DD name</td>
</tr>
<tr>
<td>Logical name</td>
</tr>
<tr>
<td>Program category</td>
</tr>
<tr>
<td>Program</td>
</tr>
<tr>
<td>Statement type</td>
</tr>
<tr>
<td>Statement source info</td>
</tr>
</tbody>
</table>

**Node pop-up menu**

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. **View analysis source** and **Copy** options are available for all nodes. According to the selected node, several **Collapse to ... Level** options might also be available.
**DBI Usage**

The **DBI Usage** tab shows the access to the DBI tables within the Cobol programs in the current project. For each DBI table, the programs and the statement types that reference the table are shown, and for each statement type, the occurrences of the statement (the file and location within the file) are listed.

To display the **DBI Usage** tab, go to **Explore Projects** tab and select **DBI Usage** from the **Usage in Programs** list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. By default, all attributes are selected; deselect the ones that you do not want to use. The breadcrumb displays the selected projects, the selected attributes in the set order together with the filters set for each attribute. Click the **Filter** field to the right of an attribute name and enter the filter that you want to use for the attributes' names. When you press **Apply**, only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of elements to be returned by the filtering operation, use the fields in the Limit column. The default limit is 50; the maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see **DBI Usage in Program Settings**. The Context column displays the context of the filter operation where relevant. The context of the first attribute filter in the list is the project. The context of any other attribute filter in the list is the attribute above it in the list. To modify the attributes' order in the list, use the green arrow buttons to the left of the attributes list. When the attributes' order changes, the context of the filtering operation changes. To the right of Attribute filters area, the list of projects is displayed.

Use **Save** to save the current filter configuration. Use **Load** load a previously saved filter configuration.

By default, **Enable levels limit** is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press **Apply** button to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the Dataset Usage in Programs parameters in a separate tab, use the arrow button in the upper right corner of **DBI Usage** tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button **find only annotated** to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available.

**Reorder current results**, use this button to reorder the results using a different filter configuration. A dialog window presents the list of filters that were used to perform the initial filtering and you can set them in the desired order.

**Expand all**, click this button to expand the tree.

**Collapse all**, click this button to fold all the tree branches.

**Export Results to CSV File**, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the Properties view displays the information available for the selected element.

In the tree, double-click an element to open the corresponding file at the occurrence line. The following nodes are available.

<p>| <strong>Table 24: DBI Usage Tab nodes</strong> |</p>
<table>
<thead>
<tr>
<th><strong>Node name</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>DBI table</td>
<td>Presents a list of the DBI Tables in the project. The information in the sub-tree under the DBI table represents where used information for the table.</td>
</tr>
</tbody>
</table>
Table 24: DBI Usage Tab nodes (continued)

<table>
<thead>
<tr>
<th>Node name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program</td>
<td>Opens the selected program at the first line.</td>
</tr>
<tr>
<td>Statement type</td>
<td>This node represents the access type that is used to access the DBI table. If the access type is dynamic and cannot be resolved in the analysis stage, the access type “DBI: Dynamic_Function” is shown. Child nodes show the name of the source file and the location (line number) of the DBI function.</td>
</tr>
</tbody>
</table>

**Node pop-up Menu**

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. **View analysis source** and **Copy** options are available for all nodes. According to the selected node, several **Collapse to ... Level** options might also be available.

**Dictionary Elements**

The **Dictionary Elements** tab shows what elements are included in Application Master environment, as defined by the DDCL file.

**Note:** This analysis is only available for VME projects.

To display the **Dictionary Elements** tab, go to the **Explore Projects** tab and select **Dictionary Elements** from the **Usage in Mainframe** list of analysis to the right of the screen.

The central part of the screen displays the list of attribute filters. Click the **Filter** field to the right of the Element name attribute and enter the filter that you want to use for the elements’ names. When you press **Apply**, only the elements that match the name filter are displayed in the Results area. Click the **Filter** field of the Element type attribute to display the available filters and select the desired one. Special characters can be used for the filter; for example, you can use the special character “*” and add to it either prefixes or suffixes as in “AAA*” or “*AAA”. To limit the number of elements to be returned by the filtering operation, use the fields in the Limit column. The default limit is 50 elements. The maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see **Dictionary Elements Settings**. To the right of the filters, the list of projects is displayed.

Use **Save** to save the current filter configuration. Use **Load** to load a previously saved filter configuration.

By default, **Enable levels limit** is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press **Apply** to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of the filters area to hide it and maximize the Results area. To see the Dictionary Elements parameters in a separate tab, use the arrow button in the upper right corner of **Dictionary Elements** tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button **find only annotated** to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available.

**Reorder current results**, use this button to reorder the results using a different filter configuration. A dialog window presents the list of filters that were used to perform the initial filtering and you can set them in the desired order.

**Expand all**, click this button to expand the tree.

**Collapse all**, click this button to fold all the tree branches.

**Export Results to CSV File**, use this button to export the results together with the used filter configuration.
Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analysis that can be generated for the selected element. Also, the Properties view displays the information available for the selected element.

In the tree, double-click a node to open the corresponding file at the occurrence line. The following nodes are available.

<table>
<thead>
<tr>
<th>Table 25: Dictionary Elements Tab nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node name</strong></td>
</tr>
<tr>
<td>Element type</td>
</tr>
<tr>
<td>Element name</td>
</tr>
<tr>
<td>Property name</td>
</tr>
</tbody>
</table>

**Node pop-up menu**

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. View analysis source and Copy options are available for all nodes. According to the selected node, several Collapse to ... Level options might also be available.

**Dictionary Usage**

The Dictionary Usage tab shows what elements are used by a DDCL element in Application Master environment, as defined by the DDCL file.

**Note:** This analysis is only available for VME projects.

To display the Dictionary Usage tab, go to Explore Projects tab and select Dictionary Usage from the Usage in Mainframe list of analysis to the right of the screen.

The central part of the screen displays the list of attribute filters. Click the Filter field to the right of an attribute name and enter the filter that you want to use for the attributes’ names. When you press Apply, only the elements that match the name filter are displayed in the search results. Special characters can be used for the filter; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of elements to be returned by the search, use the fields in the Limit column. The default limit is 50 elements. The maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see DDCL Dictionary Usage Settings. To modify the attributes’ order in the list, use the green arrow buttons to the left of the attributes list. To the right of the filters, the list of projects is displayed.

Use Save to save the current filter configuration. Use Load to load a previously saved filter configuration.

By default, Enable levels limit is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press Apply to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of the filters area to hide it and maximize the Results area. To see the Dictionary Usage parameters in a separate tab, use the arrow button in the upper right corner of the Dictionary Usage tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button find only annotated to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available.

Reorder current results, use this button to re-order the results using a different filter configuration. A dialog window presents the list of filters that were used to perform the initial filtering and you can set them in the desired order.
Expand all, click this button to expand all levels of the tree.

Collapse all, click this button to fold all the tree branches.

Export Results to CSV File, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analysis that can be generated for the selected element. Also, the Properties view displays the information available for the selected element.

In the tree, double-click an element to open the corresponding file at the occurrence line. The following nodes are available:

<table>
<thead>
<tr>
<th>Table 26: Dictionary Usage Tab nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node name</strong></td>
</tr>
<tr>
<td>Element name</td>
</tr>
<tr>
<td>DDCL element</td>
</tr>
<tr>
<td>Program</td>
</tr>
</tbody>
</table>

Node pop-up menu

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. View analysis source and Copy options are available for all nodes. According to the selected node, several Collapse to ... Level options might also be available.

Files Usage in Dictionary Elements

The Files Usage in Dictionary Elements tab shows what files are accessed by Dictionary elements, as defined by the DDCL file.

**Note:** This analysis is only available for VME projects.

To display the Files Usage in Dictionary Elements tab, go to Explore Projects tab and select Files Usage in Dictionary Elements from the Usage in Mainframe list of analysis to the right of the screen.

The central part of the screen displays the list of attribute filters. Click the Filter field to the right of an attribute name and enter the filter that you want to use for the attributes' names. When you press Apply, only the elements that match the name filter are displayed in the search results. Special characters can be used for the filter; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of elements to be returned by the search, use the fields in the Limit column. The default limit is 50 elements. The maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see Files in DDCL Elements Settings. To modify the attributes' order in the list, use the arrow buttons to the left of the attributes list. To the right of the filters, the list of projects is displayed.

Use Save to save the current filter configuration. Use Load to load a previously saved filter configuration.

By default, Enable levels limit is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press Apply to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of the filters area to hide it and maximize the Results area. To see the Files Usage in Dictionary Elements parameters in a separate tab, use the arrow button in the upper right corner of Files Usage in Dictionary Elements tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button find only annotated to filter the search
results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available.

**Reorder current results**, use this button to order the results using a different filter configuration. A dialog window presents the list of filters that were used to perform the initial filtering and you can set them in the desired order.

**Expand all**, click this button to expand the tree.

**Collapse all**, click this button to fold all the tree branches.

**Export Results to CSV File**, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analysis that can be generated for the selected element. Also, the **Properties** view displays the information available for the selected element.

In the tree, double-click an element to open the corresponding file at the occurrence line. The following nodes are available:

<table>
<thead>
<tr>
<th>Table 27: Files Usage in Dictionary Elements Tab nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node name</strong></td>
</tr>
<tr>
<td>File name</td>
</tr>
<tr>
<td>Element type</td>
</tr>
<tr>
<td>Element name</td>
</tr>
<tr>
<td>Property name</td>
</tr>
</tbody>
</table>

**Node pop-up menu**

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. **View analysis source** and **Copy** options are available for all nodes. According to the selected node, several **Collapse to ... Level** options might also be available.

**File Usage in Programs**

The **File Usage in Programs** tab shows what files are accessed by what programs.

**Restriction:** This analysis is only available for VME projects.

To display the **File Usage in Programs** tab, go to **Explore Projects** tab and select **File Usage in Programs** from the **Usage in Mainframe** list of analysis to the right of the screen.

The central part of the screen displays the list of attribute filters. Click the **Filter** field to the right of an attribute name and enter the filter that you want to use for the attributes' names. When you press **Apply**, only the elements that match the name filter are displayed in the search results. Special characters can be used for the filter; for example, you can use the special character "**" and add to it either prefixes or suffixes as in "AAA**" or "**AAA". To limit the number of elements to be returned by the search, use the fields in the Limit column. The default limit is 50 elements. The maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see File Usage in Programs Settings. To modify the attributes' order in the list, use the arrow buttons to the left of the attributes list. To the right of the filters, the list of projects is displayed.

Use **Save** to save the current filter configuration. Use **Load** to load a previously saved filter configuration.

By default, **Enable levels limit** is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press **Apply**
to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of the filters area to hide it and maximize the Results area. To see the File Usage in Programs parameters in a separate tab, use the arrow button in the upper right corner of File Usage in Programs tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button find only annotated to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available.

**Reorder current results**, use this button to order the results using a different filter configuration. A dialog window presents the list of filters that were used to perform the initial filtering and you can set them in the desired order.

**Expand all**, click this button to expand the tree.

**Collapse all**, click this button to fold all the tree branches.

**Export Results to CSV File**, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the Properties view displays the information available for the selected element.

In the tree, double-click an element to open the corresponding file at the occurrence line. The following nodes are available:

<table>
<thead>
<tr>
<th>Table 28: File Usage in Programs Tab nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node name</strong></td>
</tr>
<tr>
<td>File name</td>
</tr>
<tr>
<td>Logical name</td>
</tr>
<tr>
<td>Program</td>
</tr>
<tr>
<td>Statement type</td>
</tr>
</tbody>
</table>

**Node pop-up menu**

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. View analysis source and Copy options are available for all nodes. According to the selected node, several Collapse to ... Level options might also be available.

**IDMSX Usage**

The IDMSX Usage tab shows the usage of IDMSX sets and records within the IDMSX Schema that is used by Cobol programs or DDCL resources, or both.

**Restriction:** This analysis is only available for VME projects.

To display the IDMSX Usage tab, go to Explore Projects tab and select IDMSX Usage from the Usage in Mainframe list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. By default, all attributes are selected; deselect the ones that you do not want to use. Click the Filter field to the right of an attribute name and enter the filter that you want to use for the attributes' names. When you press Apply, only the elements that match the name filter are displayed in the Results area. Special characters can be used for the filter; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of elements to be returned by the search, use the fields in the Limit column. The default limit is 50 elements. The maximum limit can be set in the corresponding Usage Settings.
section from the Preferences dialog. For details, see IDMSX Usage Settings. To modify the attributes' order in the list, use the arrow buttons to the left of the attributes list. To the right of the filters, the list of projects is displayed.

Use **Save** to save the current filter configuration. Use **Load** to load a previously saved filter configuration.

By default, **Enable levels limit** is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press **Apply** to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of the filters area to hide it and maximize the Results area. To see the IDMSX Usage parameters in a separate tab, use the arrow button in the upper right corner of **IDMSX Usage** tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button **find only annotated** to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available.

**Reorder current results**, use this button to order the results using a different filter configuration. A dialog window presents the list of filters that were used to perform the initial filtering and you can set them in the desired order.

**Expand top 5 levels**, click this button to expand the top five levels of the tree.

**Collapse all**, click this button to fold all the tree branches.

**Export Results to CSV File**, use this button to export the results together with the used filter configuration. Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the **Properties** view displays the information available for the selected element.

In the tree, double-click an element to open the corresponding file at the occurrence line. The following nodes are available:

<table>
<thead>
<tr>
<th>Table 29: IDMSX Usage Tab nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node name</strong></td>
</tr>
<tr>
<td>IDMSX Schema</td>
</tr>
<tr>
<td>IDMSX Subschema</td>
</tr>
<tr>
<td>Record</td>
</tr>
<tr>
<td>Set</td>
</tr>
<tr>
<td>Program</td>
</tr>
<tr>
<td>DDCL Element</td>
</tr>
<tr>
<td>Statement type</td>
</tr>
</tbody>
</table>

**Node pop-up menu**

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. **View analysis source** and **Copy** options are available for all nodes. According to the selected node, several **Collapse to ... Level** options might also be available.
IDMS Usage

IDMS Usage tab shows the usage of IDMS sets and records within the IDMS Schema that is used by Cobol programs.

To display the IDMS Usage tab, go to Explore Projects tab and select IDMS Usage from the Usage in Programs list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. By default, all attributes are selected; deselect the ones that you do not want to use. The breadcrumb displays the selected projects, the selected attributes in the set order with the filters set for each attribute. Click the Filter field to the right of an attribute name and enter the filter that you want to use for the attributes' names. When you press Apply, only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of elements to be returned by the search, use the fields in the Limit column. The default limit is 50; the maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see IDMS Usage Settings. The Context column displays the context of the filter operation where relevant. The context of the first attribute filter in the list is the project. The context of any other attribute filter in the list is the attribute above it in the list. To modify the attributes' order in the list, use the green arrow buttons to the left of the attributes list. When the attributes' order changes, the context of the filtering operation changes. To the right of Attribute filters area, the list of projects is displayed.

Use Save to save the current filter configuration. Use Load to load a previously saved filter configuration.

By default, Enable levels limit is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press Apply to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the IDMS Usage parameters in a separate tab, use the arrow button in the upper right corner of IDMS Usage tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button find only annotated to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available.

**Reorder current results**, use this button to order the results using a different filter configuration. A dialog window presents the list of filters that were used to perform the initial filtering and you can set them in the desired order.

**Expand top 5 levels**, click this button to expand the top five levels of the tree.

**Collapse all**, click this button to fold all the tree branches.

**Export Results to CSV File**, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the Properties view displays the information available for the selected element.

In the tree, double-click an element to open the corresponding file at the occurrence line. The following nodes are available:

<table>
<thead>
<tr>
<th>Table 30: IDMS Usage Tab nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node name</strong></td>
</tr>
<tr>
<td>Schema</td>
</tr>
<tr>
<td>Subschema</td>
</tr>
</tbody>
</table>
### Table 30: IDMS Usage Tab nodes (continued)

<table>
<thead>
<tr>
<th>Node name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Lists the used records.</td>
</tr>
<tr>
<td>Set</td>
<td>Lists the used sets.</td>
</tr>
<tr>
<td>Program</td>
<td>Displays the name of the Cobol Program where the Record or the Set is used.</td>
</tr>
<tr>
<td>Statement type</td>
<td>Displays the usage statement type.</td>
</tr>
<tr>
<td>Statement source info</td>
<td>Presents the source occurrences of the statement in the selected Program.</td>
</tr>
</tbody>
</table>

#### Node pop-up menu

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. View analysis source and Copy options are available for all nodes. According to the selected node, several Collapse to ... Level options might also be available.

#### IMS/DB Logical Usage

The **IMS/DB Logical Usage** tab shows the way the segments of the Logical IMS database are used across the programs in the project. Also, for each logical segment, the source physical segment and physical database are presented.

IMS/DB is a hierarchical database (unlike a relational or a network one) and it is made out of segments and their relationships. A segment is similar to a record and it is the basic unit of data for IMS/DB. A segment can have many siblings but it can have only one parent segment. This limits the complexity of the physical database. To overcome this limitation, DL/I allows the database administrator to implement logical relationships in which a segment can have both physical and logical parents. Additional relationships can thus be created within one physical database. Once the logical relationships are implemented, the new structure is known as the Logical Database.

To display the **IMS/DB Logical Usage** tab, go to Explore Projects tab and select IMS/DB Logical Usage from the Usage in Programs list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. By default, all attributes are selected; deselect the ones that you do not want to use. The breadcrumb displays the selected project or projects, the selected attributes together with the filters set for each attribute. Click the Filter field to the right of an attribute name and enter the filter that you want to use for the attributes’ names. When you press Apply, only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character “*” and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of attributes of a certain type that are returned by the filtering operation, use the fields in the Limit column. The default limit is 50; the maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see “IMS/DB Logical Usage Settings” on page 17. The Context column displays the context of the filter operation where relevant. To modify the attributes' order in the list, use the green arrow buttons to the left of the attributes list. When the attributes' order changes, the context of the filtering operation changes. To the right of Attribute filters area, the list of projects is displayed.

Use Save to save the current filter configuration. Use Load to load a previously saved filter configuration.

By default, Enable levels limit is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press Apply to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the IMS/DB Logical Usage parameters in a separate tab, use the arrow button in the upper right corner of IMS/DB Logical Usage tab.
The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button **find only annotated** to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available.

**Reorder current results**, use this button to reorder the results using a different filter configuration. A dialog window presents the list of filters that were used to perform the initial filtering and you can set them in the desired order.

**Expand all**, click this button to expand the tree.

**Collapse all**, click this button to fold all the tree branches.

**Export Results to CSV File**, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the **Properties** view displays the information available for the selected element.

In the tree, double-click an entry to open the corresponding file at the occurrence line. The following nodes are available:

<table>
<thead>
<tr>
<th>Table 31: IMS/DB Logical Usage Tab nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node name</strong></td>
</tr>
<tr>
<td>Logical database</td>
</tr>
<tr>
<td>Logical segment</td>
</tr>
<tr>
<td>Physical database name</td>
</tr>
<tr>
<td>Physical segment name</td>
</tr>
<tr>
<td>Program</td>
</tr>
<tr>
<td>Statement type</td>
</tr>
</tbody>
</table>

Physical Database and Physical Segment Name levels are related to Logical Segment level (representing the source database and source segment for logical segment).

Accordingly:

1. Physical Database and Physical Segment will always be under Logical Segment level (even if results level or filters order is changed).

2. If Logical Segment is disabled from filters, those 2 levels will not be displayed in result tree.

**Node pop-up menu**

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. **View analysis source** and **Copy** options are available for all nodes.

**Note:** If you select **View analysis source** for a Logical database node, the occurrence from the *.DBD file is presented in the Editor view.

According to the selected node, several **Collapse to ... Level** options might also be available.
**IMS/DB Structure**

The **IMS/DB Structure** tab presents the relationships among the segments and fields of an IMS database, grouped by access type (Fast path, Logical, Full function, and File access).

To display the **IMS/DB Structure** tab, go to **Explore Projects** tab and select **IMS/DB Structure** from the **Usage in Programs** list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. By default, all attributes are selected; deselect the ones that you do not want to use. The breadcrumb displays the selected project or projects, the selected attributes together with the filters set for each attribute. Click the **Filter** field to the right of an attribute name and enter the filter that you want to use for the attributes' names. When you press **Apply**, only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of attributes of a certain type that are returned by the filtering operation, use the fields in the Limit column. The default limit is 50; the maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see “IMS/DB Structure Settings” on page 17. The Context column displays the context of the filter operation where relevant. To modify the attributes' order in the list, use the green arrow buttons to the left of the attributes list. When the attributes' order changes, the context of the filtering operation changes. To the right of Attribute filters area, the list of projects is displayed.

Use **Save** to save the current filter configuration. Use **Load** to load a previously saved filter configuration.

By default, Enable levels limit is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press **Apply** to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the IMS/DB Usage parameters in a separate tab, use the arrow button in the upper right corner of **IMS/DB Usage** tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button **find only annotated** to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available:

**Expand all**, click this button to expand the tree.

**Collapse all**, click this button to fold all the tree branches.

**Export Results to CSV File**, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the **Properties** view displays the information about the selected element attributes collected from element definition.

The results of the IMS/DB Structure analysis are grouped by IMS/DB access type: Fast path, Logical, Full function, and File access.

In the tree, an entry to open the corresponding file at the occurrence line. The following nodes are available:

<table>
<thead>
<tr>
<th>Node name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database type</td>
<td>Presents the database type, this can be either physical or logical database.</td>
</tr>
<tr>
<td>Database</td>
<td>Presents the database name.</td>
</tr>
<tr>
<td>Segment</td>
<td>Presents the segment name, this can be either a physical or a logical segment.</td>
</tr>
<tr>
<td>Field</td>
<td>Presents the IMS/DB fields.</td>
</tr>
</tbody>
</table>
Node pop-up menu

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. **View analysis source** and **Copy** options are available for all nodes.

**Note:** **View analysis source** for all the nodes of this analysis will show occurrences in the *.DBD file.

According to the selected node, several **Collapse to ... Level** options might also be available.

**IMS/DB Usage**

The **IMS/DB Usage** tab shows the way the segments of an IMS database are used across the programs in the project.

To display the **IMS/DB Usage** tab, go to **Explore Projects** tab and select **IMS/DB Usage** from the **Usage in Programs** list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. By default, all attributes are selected; deselect the ones that you do not want to use. The breadcrumb displays the selected project or projects, the selected attributes together with the filters set for each attribute. Click the **Filter** field to the right of an attribute name and enter the filter that you want to use for the attributes' names. When you press **Apply**, only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of attributes of a certain type that are returned by the filtering operation, use the fields in the Limit column. The default limit is 50; the maximum limit can be set in the corresponding **Usage Settings** section from the **Preferences** dialog. For details, see “**IMS/DB Usage Settings**” on page 17. The Context column displays the context of the filter operation where relevant. To modify the attributes' order in the list, use the green arrow buttons to the left of the attributes list. When the attributes' order changes, the context of the filtering operation changes. To the right of **Attribute filters** area, the list of projects is displayed.

Use **Save** to save the current filter configuration. Use **Load** to load a previously saved filter configuration.

By default, **Enable levels limit** is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press **Apply** to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the IMS/DB Usage parameters in a separate tab, use the arrow button in the upper right corner of **IMS/DB Usage** tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button **find only annotated** to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available.

**Reorder current results**, use this button to reorder the results using a different filter configuration. A dialog window presents the list of filters that were used to perform the initial filtering and you can set them in the desired order.

**Expand all**, click this button to expand the tree.

**Collapse all**, click this button to fold all the tree branches.

**Export Results to CSV File**, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the **Properties** view displays the information available for the selected element. The information regarding the logical database and logical segment name is displayed in the **Properties** view.

In the tree, an entry to open the corresponding file at the occurrence line. The following nodes are available:
**Table 33: IMS/DB Usage Tab nodes**

<table>
<thead>
<tr>
<th>Node name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database type</td>
<td>Presents the database type, this can be either physical or logical database.</td>
</tr>
<tr>
<td>Database name</td>
<td>Presents the name of the database.</td>
</tr>
<tr>
<td>Segment name</td>
<td>Presents the IMS/DB segments.</td>
</tr>
<tr>
<td>Program</td>
<td>Presents the programs which contain the referred statement.</td>
</tr>
<tr>
<td>Statement type</td>
<td>Presents the statement type and source occurrences of the statement in selected program.</td>
</tr>
<tr>
<td>Statement source info</td>
<td>Presents the name of the resource where the statement was found.</td>
</tr>
</tbody>
</table>

**Node pop-up menu**

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. View analysis source and Copy options are available for all nodes. According to the selected node, several Collapse to ... Level options might also be available.

**Include Usage**

The Include tab displays information on the usage of Includes in the project. The nodes represent the Includes in the project. Expanding an include node displays a list of nodes that represent Include statements in COBOL files that refer to the copybook. The name of the file that contains the Include statement and the statement's location (line and column numbers) are shown.

To display the Include Usage tab, go to Explore Projects tab and select Include Usage from the Usage in Programs list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. By default, all attributes are selected; deselect the ones that you do not want to use. The breadcrumb displays the selected projects, the selected attributes in the set order with the filters set for each attribute. Click the Filter field to the right of an attribute name and enter the filter that you want to use for the attributes' names. When you click Apply, only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of elements to be returned by the filtering operation, use the fields in the Limit column. The default limit is 50; the maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see Include Usage Settings. The Context column displays the context of the filter operation where relevant. The context of the first attribute filter in the list is the project. The context of any other attribute filter in the list is the attribute above it in the list. To modify the attributes' order in the list, use the green arrow buttons to the left of the attributes list. When the attributes' order changes, the context of the filtering operation changes. To the right of Attribute filters area, the list of projects is displayed.

Use Save to save the current filter configuration. Use Load to load a previously saved filter configuration.

By default, Enable levels limit is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press Apply to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the Include Usage parameters in a separate tab, use the arrow button in the upper right corner of Include Usage tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button find only annotated to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available.
Reorder current results, use this button to order the results using a different filter configuration. A dialog window presents the list of filters that were used to perform the initial filtering and you can set them in the desired order.

Expand top 5 levels, click this button to expand the top five levels of the tree.

Collapse all, click this button to fold all the tree branches.

Export Results to CSV File, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the Properties view displays the information available for the selected element.

In the tree, double-click an element to open the corresponding file at the occurrence line. The following nodes are available.

<table>
<thead>
<tr>
<th>Table 34: Include Usage Tab nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node name</strong></td>
</tr>
<tr>
<td>Include</td>
</tr>
<tr>
<td>Program category</td>
</tr>
<tr>
<td>Program</td>
</tr>
<tr>
<td>Statement type</td>
</tr>
</tbody>
</table>

Node pop-up menu

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. View analysis source and Copy options are available for all nodes. According to the selected node, several Collapse to ... Level options might also be available.

MQueue Usage

The MQueue Usage tab presents how the MQ Series is being used throughout the programs. When you send or receive a message using MQ, you need to specify the queue manager you are working with and the queue you are using. Therefore this tab has the following levels: queue manager, queue, program, statement type, source occurrences.

To display the MQueue Usage tab, go to Explore Projects tab and select MQueue Usage from the Usage in Programs list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. By default, all attributes are selected; deselect the ones that you do not want to use. The breadcrumb displays the selected project or projects, the selected attributes together with the filters set for each attribute. Click the Filter field to the right of an attribute name and enter the filter that you want to use for the attributes' names: only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of attributes of a certain type that are returned by the filtering operation, use the fields in the Limit column. The default limit is 50; the maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see MQueue Usage Settings. The Context column displays the context of the filter operation where relevant. To modify the attributes' order in the list, use the green arrow buttons to the left of the attributes list. When the attributes' order changes, the context of the filtering operation changes. To the right of Attribute filters area, the list of projects is displayed.
Use **Save** to save the current filter configuration. Use **Load** to load a previously saved filter configuration.

By default, **Enable levels limit** is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press **Apply** to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the MQ Queue Usage parameters in a separate tab, use the arrow button in the upper right corner of the **MQ Queue Usage** tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button **find only annotated** to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area the following buttons are available.

**Reorder current results**, use this button to reorder the results using a different filter configuration. A dialog window presents the list of filters that were used to perform the initial filtering and you can set them in the desired order.

**Expand all**, click this button to expand the tree.

**Collapse all**, click this button to fold all the tree branches.

**Export Results to CSV File**, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the **Properties** view displays the information available for the selected element.

In the tree, double-click a paragraph, variable, or include to open the corresponding file at the occurrence line. The following nodes are available.

<table>
<thead>
<tr>
<th>Node name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Queue</td>
<td>Presents a list of queues that are used in this project.</td>
</tr>
<tr>
<td>Queue Manager</td>
<td>Presents the name of Queue Manager.</td>
</tr>
<tr>
<td>Program</td>
<td>Presents the programs that contain the referred statement.</td>
</tr>
<tr>
<td>Statement type</td>
<td>Presents the statement type and source occurrences of the statement in selected program.</td>
</tr>
</tbody>
</table>

**Node pop-up menu**

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. **View analysis source** and **Copy** options are available for all nodes. According to the selected node several **Collapse to ... Level** options might also be available.

**Open TP Usage**

The **Open TP** tab presents the COBOL files that contain Open TP statements.

**Restriction:** This analysis is only available for VME projects.

To display the **Open TP Usage** tab, go to **Explore Projects** tab and select **Open TP Usage** from the **Usage in Mainframe** list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. By default, all attributes are selected; de-select the ones that you do not want to use. Click the **Filter** field to the right of an attribute name and enter the filter that you want to use for the attributes' names. When you press **Apply**, only the elements
that match the name filter are displayed in the Results area. Special characters can be used for the filter; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of elements to be returned by the filtering operation, use the fields in the Limit column. The default limit is 50 elements. The maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see OpenTP Usage Settings. To modify the attributes' order in the list, use the green arrow buttons to the left of the attributes list. To the right of the filters, the list of projects is displayed.

Use Save to save the current filter configuration. Use Load to load a previously saved filter configuration.

By default, Enable levels limit is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press Apply to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of the filters area to hide it and maximize the Results area. To see the Open TP Usage parameters in a separate tab, use the arrow button in the upper right corner of the Open TP Usage tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button find only annotated to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available.

Reorder current results, use this button to order the results using a different filter configuration. A dialog window presents the list of filters that were used to perform the initial filtering and you can set them in the desired order.

Expand all, click this button to expand all branches of the tree.

Collapse all, click this button to fold all the tree branches.

Export Results to CSV File, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. Once you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the Properties view displays the information available for the selected element.

In the tree, double-click an element to open the corresponding file at the occurrence line. The following nodes are available.

<table>
<thead>
<tr>
<th>Node name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program</td>
<td>Lists the Cobol programs.</td>
</tr>
<tr>
<td>Statement type node</td>
<td>Displays the statement types.</td>
</tr>
<tr>
<td>COBOL Statement Source</td>
<td>The label on these nodes is the name of the associated source file and the location (line number) of the statement.</td>
</tr>
<tr>
<td>Occurrences</td>
<td></td>
</tr>
</tbody>
</table>

Node pop-up menu

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. View analysis source and Copy options are available for all nodes. According to the selected node, several Collapse to ... Level options might also be available.

SCL Usage

The SCL Usage tab presents the SCL procedures.

Restriction: This analysis is only available for VME projects.
To display **SCL Usage** tab, go to **Explore Projects** tab and select **SCL Usage** from the **Usage in Mainframe** list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. By default, all attributes are selected; deselect the ones that you do not want to use. Click the **Filter** field to the right of an attribute name and enter the filter that you want to use for the attributes' names. When you press **Apply**, only the elements that match the name filter are displayed in the Results area. Special characters can be used for the filter; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of elements to be returned by the filtering operation, use the fields in the Limit column. The default limit is 10 elements. The maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see **SCL Usage Settings**. To the right of the filters, the list of projects is displayed.

Use **Save** to save the current filter configuration. Use **Load** to load a previously saved filter configuration.

By default, **Enable levels limit** is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press **Apply** to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of the filters area to hide it and maximize the Results area. To see the SCL Usage parameters in a separate tab, use the arrow button in the upper right corner of the **SCL Usage** tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button **find only annotated** to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available.

- **Expand top 2 levels**, click this button to expand the top two levels of the tree.
- **Collapse all**, click this button to fold all the tree branches.
- **Export Results to CSV File**, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the **Properties** view displays the information available for the selected element.

In the tree, double-click a paragraph, variable, or include to open the corresponding file at the occurrence line. The following nodes are available.

<table>
<thead>
<tr>
<th>Node name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program</td>
<td>Displays the SCL file name.</td>
</tr>
<tr>
<td>Procedure</td>
<td>Displays the SCL procedures that are defined in the SCL file.</td>
</tr>
<tr>
<td>Aliases</td>
<td>Presents the procedure aliases.</td>
</tr>
<tr>
<td>Local variables</td>
<td>Presents all the variables in the SCL file.</td>
</tr>
<tr>
<td>Parameters</td>
<td>Presents all the parameters in the SCL file.</td>
</tr>
</tbody>
</table>

**Node pop-up menu**

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. **View analysis source** and **Copy** options are available for all nodes. According to the selected node, several **Collapse to ... Level** options might also be available.
TPMSX Usage

The TPMSX Usage tab shows the usage of TPMSX statements in COBOL files.

Restriction: This analysis is only available for VME projects.

To display the TPMSX Usage tab, go to Explore Projects tab and select TPMSX Usage from the Usage in Mainframe list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. By default, all attributes are selected; deselect the ones that you do not want to use. Click the Filter field to the right of an attribute name and enter the filter that you want to use for the attributes' names. When you press Apply, only the elements that match the name filter are displayed in the Results area. Special characters can be used for the filter; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of elements to be returned by the filtering operation, use the fields in the Limit column. The default limit is 50 elements. The maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see TPMSX Usage Settings. To modify the attributes' order in the list, use the green arrow buttons to the left of the attributes list. To the right of the filters, the list of projects is displayed.

Use Save to save the current filter configuration. Use Load to load a previously saved filter configuration.

By default, Enable levels limit is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press Apply to apply the selected filters.

When the filtering operation is finished, you can use the black arrow button in the upper left corner of the filters area to hide it and maximize the Results area. To see the TPMSX Usage parameters in a separate tab, use the arrow button in the upper right corner of the TPMSX Usage tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button find only annotated to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available.

Reorder current results, use this button to order the results using a different filter configuration. A dialog window presents the list of filters that were used to perform the initial filtering and you can set them in the desired order.

Expand all, click this button to expand all tree branches.

Collapse all, click this button to fold all the tree branches.

Export Results to CSV File, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the Properties view displays the information available for the selected element.

In the tree, double-click an element to open the corresponding file at the occurrence line. The following nodes are available.

<table>
<thead>
<tr>
<th>Table 38: TPMSX Usage Tab nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node name</strong></td>
</tr>
<tr>
<td>Screen</td>
</tr>
<tr>
<td>Program</td>
</tr>
<tr>
<td>Statement type</td>
</tr>
<tr>
<td>Statement Source Info</td>
</tr>
</tbody>
</table>
**Node pop-up menu**

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. View analysis source and Copy options are available for all nodes. According to the selected node, several Collapse to ... Level options might also be available.

**Natural Program Structure**

The Natural Program Structure tab shows the subroutines and includes found in the Natural programs in the current project.

To display the Natural Program Structure tab, go to Explore Projects tab and select Natural Program Structure from the Usage in Programs list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. By default, all attributes are selected; deselect the ones that you do not want to use. The breadcrumb displays the selected projects, the selected attributes together with the filters set for each attribute. Click the Filter field to the right of an attribute name and enter the filter that you want to use for the attributes' names. When you press Apply, only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of attributes of a certain type that are returned by the filtering operation, use the fields in the Limit column. The default limit is 10; the maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see Natural Program Structure Settings. The Context column displays the context of the filter operation where relevant. To the right of Attribute filters area, the list of projects is displayed.

Use Save to save the current filter configuration. Use Load to load a previously saved filter configuration.

By default, Enable levels limit is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press Apply to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the Natural Program Structure parameters in a separate tab, use the arrow button in the upper right corner of the Natural Program Structure tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button find only annotated to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available.

Expand top 2 levels, click this button to expand the top two levels of the tree.

Collapse all, click this button to fold all the tree branches.

Export Results to CSV File, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the Properties view displays the information available for the selected element.

In the tree, double-click an element to open the corresponding file at the occurrence line. The following nodes are available.

<table>
<thead>
<tr>
<th>Table 39: Natural Program Structure Tab nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node name</strong></td>
</tr>
<tr>
<td>Program</td>
</tr>
<tr>
<td>Subroutines</td>
</tr>
</tbody>
</table>
Table 39: Natural Program Structure Tab nodes (continued)

<table>
<thead>
<tr>
<th>Node name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Includes</td>
<td>Opens the source file at the include statement.</td>
</tr>
</tbody>
</table>

**Node pop-up menu**

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. View analysis source and Copy options are available for all nodes. According to the selected node, several Collapse to ... Level options might also be available.

**Natural Variable Usage**

The Natural Variable Usage tab shows the variable usage for the Natural programs in the current project.

To display the Natural Variable Usage tab, go to Explore Projects tab and select Natural Variable Usage from the Usage in Programs list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. The breadcrumb displays the selected projects and all attributes together with the filters set for each attribute. Click the Filter field to the right of an attribute name and enter the filter you want to use for the attributes' names. When you press Apply, only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of attributes of a certain type that are returned by the filtering operation, use the fields in the Limit column. The default limit is 10; the maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see Natural Variable Usage Settings. The Context column displays the context of the filter operation where relevant. To the right of Attribute filters area, the list of projects is displayed.

Use Save to save the current filter configuration. Use Load to load a previously saved filter configuration.

By default, Enable levels limit is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press Apply to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the Natural Variable Usage parameters in a separate tab, use the arrow button in the upper right corner of the Natural Variable Usage tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button find only annotated to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available.

Expand top 1 level, click this button to expand the first level of the tree.

Collapse all, click this button to fold all the tree branches.

Export Results to CSV File, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the Properties view displays the information available for the selected element.

In the tree, double-click an element to open the corresponding file at the occurrence line. The following nodes are available.
<table>
<thead>
<tr>
<th>Node name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program</td>
<td>Shows the tree for a Natural source file. The tree contains nodes for variables.</td>
</tr>
<tr>
<td>Variables</td>
<td>Opens the source file at the relevant Variable declaration. Expands the Variable node to show how a variable is used, divided into Read (where the variable value is read) and Write (where the variable value is written).</td>
</tr>
</tbody>
</table>

**Node pop-up menu**

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. **View analysis source** and **Copy** options are available for all nodes. According to the selected node, several **Collapse to ... Level** options might also be available.

**PL/I Program Structure**

The **PL1 Program Structure** tab shows the procedures and include files for the PL/I programs in the current project.

To display the **PL1 Program Structure** tab, go to **Explore Projects** tab and select **PL1 Program Structure** from the **Usage in Programs** list of analyses to the right of the screen.

**Important:** In AD Analyze, external procedures from a PL/I file are treated as programs for the following cases:

- In case **package exports** statement exists in the PL/I file only, the procedures listed in this statement are seen as external procedures, namely programs.
- In case **package exports** statement doesn’t exist in the PL/I file, all the procedures defined on the first level in the file are seen as external procedures, namely programs.

Therefore the PL1 Program Structure tab shows the procedure name prefixed with the member name (example: **member:procedure**).

The central part of the screen displays the list of attribute filters. By default, all attributes are selected; deselect the ones that you do not want to use. The breadcrumb displays the selected projects, the selected attributes together with the filters set for each attribute. Click the **Filter** field to the right of an attribute name and enter the filter that you want to use for the attributes’ names. When you press **Apply**, only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character "*" and add to it either prefixes or suffixes as in **Member* or *Procedure**. In order to filter right after the name displayed in the list, you can use the **member:procedure** notation.

To limit the number of attributes of a certain type that are returned by the filtering operation, use the fields in the Limit column. The default limit is 10; the maximum limit can be set in the corresponding **Usage Settings** section from the **Preferences** dialog. For details, see **PL/I Program Structure Settings**.

The Context column displays the context of the filter operation where relevant. To the right of Attribute filters area, the list of projects is displayed.

Use **Save** to save the current filter configuration. Use **Load** to load a previously saved filter configuration.

By default, **Enable levels limit** is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press **Apply** to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the PL/I Program Structure parameters in a separate tab, use the arrow button in the top right corner of the **PL1 Program Structure** tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button **find only annotated** to filter the search.
results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available.

**Expand top 2 levels**, click this button to expand the top two levels of the tree.

**Collapse all**, click this button to fold all the tree branches.

**Export Results to CSV File**, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the **Properties** view displays the information available for the selected element.

In the tree, double-click an element to open the corresponding file at the occurrence line. The following nodes are available.

<table>
<thead>
<tr>
<th>Table 41: PL/I Program Structure Tab nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node name</strong></td>
</tr>
<tr>
<td>Program</td>
</tr>
<tr>
<td>Procedure</td>
</tr>
<tr>
<td>Includes</td>
</tr>
</tbody>
</table>

**Note**: For a copybook that is included outside of any PL/I program in the source file, the copybook is displayed in the result tree of every PL/I program from that file.

**Node pop-up menu**

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. **View analysis source** and **Copy** options are available for all nodes. According to the selected node, several **Collapse to ... Level** options might also be available.

**PL/I Variable Usage**

The **PL1 Variable Usage** tab shows the variable usage for the PL/I programs in the current project.

To display the **PL1 Variable Usage** tab, go to the **Explore Projects** tab and select **PL1 Variable Usage** from the **Usage in Programs** list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. The breadcrumb displays the selected projects and all attributes together with the filters set for each attribute. Click the **Filter** field to the right of an attribute name and enter the filter that you want to use for the attributes' names. When you press **Apply**, only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character “*” and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of attributes of a certain type that are returned by the filtering operation, use the fields in the Limit column. The default limit is 10; the maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see **PL/I Variable Usage Settings**. The Context column displays the context of the filter operation where relevant. To the right of Attribute filters area, the list of projects is displayed.

Use **Save** to save the current filter configuration. Use **Load** to load a previously saved filter configuration.

By default, **Enable levels limit** is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press **Apply** to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the PL/I
Variable Usage parameters in a separate tab, use the arrow button in the upper right corner of the PL/I Variable Usage tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button find only annotated to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available:

**Expand top 2 levels**, click this button to expand the top two levels of the tree.

**Collapse all**, click this button to fold all the tree branches.

**Export Results to CSV File**, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the Properties view displays the information available for the selected element.

In the tree, double-click an element to open the corresponding file at the occurrence line. The following nodes are available.

<table>
<thead>
<tr>
<th>Table 42: PL/I Variable Usage Tab nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node name</strong></td>
</tr>
<tr>
<td>Program</td>
</tr>
<tr>
<td>Variables</td>
</tr>
<tr>
<td><strong>Note</strong>: For a global variable, only if it is used in a PL/I program, the global variable is displayed in the result tree of the corresponding program.</td>
</tr>
</tbody>
</table>

**Node pop-up menu**

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. **View analysis source** and **Copy** options are available for all nodes. According to the selected node, several **Collapse to ... Level** options might also be available.

**SQL Table Field Usage**

The SQL Table Field Usage tab shows the usage of table fields of the SQL tables, within the programs in the current project.

To display the SQL Table Field Usage tab, go to Explore Projects tab and select SQL Table Field Usage from the Usage in Programs list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. By default, all attributes are selected; deselect the ones that you do not want to use. The breadcrumb displays the selected projects, the selected attributes in the set order with the filters set for each attribute. Click the Filter field to the right of an attribute name and enter the filter that you want to use for the attributes' names. When you press **Apply**, only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of elements to be returned by the filtering operation, use the fields in the Limit column. The default limit is 50; the maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see SQL Table Field Usage Settings. The Context column displays the context of the filter operation where relevant. The context of the first attribute filter in the list is the project. The context of any other attribute filter in the list is the attribute above it in the list. To modify the attributes' order in the list, use the green arrow buttons to the left of the
attributes list. When the attributes' order changes, the context of the filtering operation changes. To the right of Attribute filters area, the list of projects is displayed.

Use **Save** to save the current filter configuration. Use **Load** to load a previously saved filter configuration.

By default, **Enable levels limit** is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press **Apply** to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the SQL Table Field Usage parameters in a separate tab, use the arrow button in the upper right corner of **SQL Table Field Usage** tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button **find only annotated** to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available.

**Reorder current results**, use this button to order the results using a different filter configuration. A dialog window presents the list of filters that were used to perform the initial filtering and you can set them in the desired order.

**Expand all**, click this button to expand the tree.

**Collapse all**, click this button to fold all the tree branches.

**Export Results to CSV File**, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the **Properties** view displays the information available for the selected element.

In the tree, double-click an element to open the corresponding file at the occurrence line. The following nodes are available.

<table>
<thead>
<tr>
<th><strong>Table 43: SQL Table Field Usage Tab nodes</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node name</strong></td>
</tr>
<tr>
<td>SQL table</td>
</tr>
<tr>
<td>SQL table field</td>
</tr>
<tr>
<td>Program</td>
</tr>
<tr>
<td>Statement type</td>
</tr>
</tbody>
</table>

**Node pop-up menu**

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. **View analysis source** and **Copy** options are available for all nodes. According to the selected node, several **Collapse to ... Level** options might also be available.

**SQL Table Usage**

The **SQL Table Usage** tab lists the database tables that are used by the project. For each table, nodes represent the different statement types that refer to the tables (select, update, delete, insert), and for
each statement-type, the references in the source code (file name and location of the reference) are listed.

To display the SQL Table Usage tab, go to Explore Projects tab and select SQL Table Usage from the Usage in Programs list of analyses to the right of the screen.

The central part of the screen displays the list of attribute filters. By default, all attributes are selected; deselect the ones that you do not want to use. The breadcrumb displays the selected projects, the selected attributes in the set order with the filters set for each attribute. Click the Filter field to the right of an attribute name and enter the filter that you want to use for the attributes' names. When you press Apply, only the elements that match the name filter are displayed in the Results area. Special characters can be used; for example, you can use the special character "*" and add to it either prefixes or suffixes as in "AAA*" or "*AAA". To limit the number of elements to be returned by the filtering operation, use the fields in the Limit column. The default limit is 50; the maximum limit can be set in the corresponding Usage Settings section from the Preferences dialog. For details, see SQL Table Usage Settings. The Context column displays the context of the filter operation where relevant. The context of the first attribute filter in the list is the project. The context of any other attribute filter in the list is the attribute above it in the list. To modify the attributes' order in the list, use the green arrow buttons to the left of the attributes list. When the attributes' order changes, the context of the filtering operation changes. To the right of Attribute filters area, the list of projects is displayed.

Use Save to save the current filter configuration. Use Load to load a previously saved filter configuration.

By default, Enable levels limit is selected and the number of elements that are presented in the Results area is limited by the values set in the Limit column. If you deselect this option, the Limit column from the Attribute filters area disappears and the Results area displays all the results of the analysis. Press Apply to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area. To see the SQL Table Usage parameters in a separate tab, use the arrow button in the top right corner of SQL Table Usage tab.

The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. Click the adjacent button find only annotated to filter the search results so that only the annotated elements are shown. In the upper right corner of the Results area, the following buttons are available:

Reorder current results, use this button to order the results using a different filter configuration. A dialog window presents the list of filters that were used to perform the initial filtering and you can set them in the desired order.

Collapse all, click this button to fold all the tree branches.

Export Results to CSV File, use this button to export the results together with the used filter configuration.

Place the mouse cursor over a node in the tree to display a tooltip that presents the element category and name. When you select a tree node, the area to the right of the screen is updated to display the graphs, reports, and usage analyses that can be generated for the selected element. Also, the Properties view displays the information available for the selected element.

In the tree, double-click an element to open the corresponding file at the occurrence line. The following nodes are available.

<table>
<thead>
<tr>
<th>Table 44: SQL Table Usage Tab nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node name</strong></td>
</tr>
<tr>
<td>SQL table</td>
</tr>
<tr>
<td>Program</td>
</tr>
</tbody>
</table>
Table 44: SQL Table Usage Tab nodes (continued)

<table>
<thead>
<tr>
<th>Node name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Statement type</td>
<td>Statement type nodes represent the SQL statement types that are used to refer to the table. Child nodes show the name of the source file and the location (line number) of the SQL statement.</td>
</tr>
</tbody>
</table>

**Node pop-up menu**

Select a node from the tree in the Results area then right-click to display the pop-up menu. The number of options available depends on the type of node selected. View analysis source and Copy options are available for all nodes. According to the selected node, several Collapse to ... Level options might also be available.

**API Usage**

The API Usage tab shows the API and services used in the selected project(s). To display the API Usage tab, go to Explore APIs > select API or service > double click API Usage.

The information presented in this screen is split as follows:

- the central part of the screen displays the list of attribute filters.
- the breadcrumb displays the selected projects and all attributes additional to the filters set for each attribute.

Click the Filter field to the right of an attribute name and enter the filter you want to use for the attributes names. After pressing Apply, only the elements matching the name filter are displayed in the Results area. Filtering can be applied by API full name and Service only.

Use Save to save the current filter configuration. Use Load to load a previously saved filter configuration.

Press Apply to apply the selected filters. When the filtering operation is finished, you can use the black arrow button in the upper left corner of Attribute filters area to hide it and maximize the Results area.

**Note:** The results of the filtering operation are displayed in the Results area. Use the search field to locate a specific element in the Results tree. In the upper right corner of the Results area, the following buttons are available:

- Expand all: click this button to expand all levels of the tree.
- Collapse all: click this button to fold all the tree branches.
- Export Results to CSV File: use this button to export the results and the used filter configuration.

The Reorder current results button is used to order the results using a different filter configuration. A dialog window presents the list of filters that were used to perform the initial filtering and you can set them in the desired order.

API Usage pop-up menu: select a node from the tree in the Results area then right-click to display the pop-up menu. Depending on the selected node, several options are available.
Chapter 9. Compare Analysis

The following analyses can be generated in this category:

- Compare Applications.
- Compare Projects in Editor.
- Compare Projects Report - for details, see Compare Projects Report in Reports chapter.
- Shared Resources Graph - for details, see Shared Resources Graph in Graphs chapter.
- Shared Resources Report - for details, see Shared Resources Report in Reports chapter.

### Compare Applications

The Compare Applications analysis detects the differences between source components of the selected applications. Detected differences are sources that exist in one application but not in the other, or sources that exist in both applications but differ in content.

To compare two applications, in Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects tab, select the projects that contain the applications you want to compare. For details on perspectives and their components, see IBM AD Analyze Client Reference.

When you select two projects from the Explore Projects tab, the available graphs, reports, and usage analyses are displayed to the right of your screen.

In the Compare Analysis section, to the right of the Explore Projects tab double-click Compare Applications to display the Compare Action wizard.

For each selected project, the available applications are presented. Select from the lists the applications that you want to compare then click Finish to display the compare analysis.

When you compare two applications, the results of the structure comparison are displayed in the upper part of the screen. Navigation tools are available. You can navigate to the next or to the previous difference or change.

The results of the compare operation can also be presented in a report. Click Generate Report in the upper right corner of the compare results window. For details, see Compare Projects Report in Reports chapter.

### Compare Projects in Editor

The Compare Projects analysis detects the differences between source components of the selected projects. Detected differences are sources that exist in one project but not in the other or sources that exist in both projects but differ in content.

The compare operation can be performed between two projects.

To compare two projects, in Application Discovery Browser perspective, from the Projects list in the central part of the Explore Projects tab, select the projects that you want to compare. For details on perspectives and their components, see IBM AD Analyze Client Reference.

When you select two or more projects from the Explore Projects tab, the available graphs, reports, and usage analyses are displayed to the right of your screen. When you compare two projects, the results of the structure compare are displayed in the upper part of the screen. Navigation tools are available. You can navigate to the next or to the previous difference or change.

The results of the compare operation can also be presented in a report. Click Generate Report in the upper right corner of the compare results window. For details, see Compare Projects Report in Reports chapter.
Chapter 10. Server Manager

After you installed **IBM AD Analyze Server**, select **Start > Programs > IBM Application Discovery Analyze Server > IBM Application Discovery Analyze Server Manager**. The Server Manager dialog window is displayed.

![Server Manager Main Window](image)

**Figure 36: Server Manager Main Window**

The traffic light icon in upper left corner presents the status of the server. You can use the available buttons to start or stop it. In the pane below, a list of messages details the actions currently taking place on the server. Use the button in the toolbar to **Clear status list**.

To the right of the dialog window, the following tabs are available and allow the user to set up and customize the settings of **IBM AD Analyze Server**.

- Server Settings tab
- Database Settings tab
- Access Settings tab
- Project Details tab
- Update Rights tab
- Server Requests tab
- Project Database tab

**Server Settings Tab**

**CAUTION:** The server must be stopped before any changes can be made in the current server settings.

The following Server properties are available:
• **IP: IBM AD Analyze Server** automatically detects all the IP addresses configured on the computer where it is installed. From the available choices, select the IP of the server that you want to use for server-client communication.

The communication between clients and server is based on RMI. RMI requires two ports to be assigned, one for the registry and one for the communication itself. Two ports must be allocated on the server and specified both on the server side at installation time (see Server Settings in Preferences chapter) and on the client sides at server connection time.

By default, the following ports are assigned.

RMI registry port – 1099
Communication port – 1900

These ports must be allowed by the server firewall.

• The **Service name** field is automatically filled in by the application with the service name provided when the server was installed.

In the Server Arguments area, the following data must be entered.

• **Remote Path**, enter the correct shared network folder in the **Remote Path** field.

• **Shared folder**, for a multi-user installation, a shared folder must be created for the shared projects and *read* and *write* access must be granted to all users that operate IBM AD Analyze.

• **Minimum/Maximum Heap Size (MB)**, use the default values displayed in these fields or enter your own values according to optimized memory consumption.

After you selected the desired parameters, click **Save** to apply them and then start the server.

---

**Database Settings Tab**

The options available in this tab allow the user to create new databases and to modify settings for existing ones.

**Important:** First, verify that SQL Server authentication mode is set to SQL Server and Windows. Then, choose or add a standard user that is used to access the repository.

From the Server Settings dialog window, select the **Database Settings** tab. In the Location area, enter the following parameters.

• **Server type**, this field is filled in by default with “SQL server”.

• **Server IP**, in this field enter the IP of the computer where the server was installed.

• **Server port**, server port is the access port, usually and the default port 1433 is used.

• **Database instance**, instance name must be used in case the default database named was not chosen at SQL Server installation time.

In the Authorization area, enter the following parameters.

• **Database name**, enter a name for the database.

• **User** and **password** must match the user that was chosen in the first step.

After you entered the details of the database, click **Create database** button to create the database with the selected parameters. Use **Test database** to verify that the newly created database is functional. Click **Save** to apply the settings or changes and select the database as the working database. Use **Drop database** to delete the current database. To “select” one of the databases that were created, enter its name in the **Database name** field, and press **Test database**.
Access Settings Tab

The options available in this tab allow the user to specify allowed IBM AD Analyze clients, regardless of whether the server is running or stopped.

Select the Access Settings tab from Server Manager dialog window.

IBM AD Analyze clients can be of two types: manager and user. An IBM AD Analyze client with a manager role, can create shared projects, build shared projects, and delete shared projects. An IBM AD Analyze client with user role is a client that can import projects that are published on the server and can perform analysis. Manager and user roles are server-related attributes, which means that a server determines the type of client that is connecting to that server by looking up the client IP in the configuration files. This means that a client can be a manager on one server and a user on another server.

To add a Manager to the Managers list, click Add in the upper right corner of the Access Settings tab. The New Access Data dialog window is displayed. Enter the IP of the computer of the user who is to access the projects as a Manager (the type of owner is selected by default) then press OK to add the new manager to the list of Managers.

To delete one of the Managers from the list, select it then press Delete.

If you want to allow access to all the projects on the server to all potential users, do not add any users to the List of Users. If you want to limit the access to the projects to a number of specific users, select restrict user IP then add all of them to the List of Users. Only the users in the List of Users and List of Managers have access to the projects shared on the server.

To add a user to the list of users, click Add from the List of Users area of the Access Settings tab. The New Access Data Add User dialog window is displayed. Enter the IP of the computer of the user who is to access the projects as a User (the type of owner is selected by default) then press OK to add the new user to the list of Users.

Project Details Tab

This tab presents a list of projects that are published on the server and allows the user to delete a project or change the owner of any project in the list.

Note: Changes can be operated in this tab only after the server is started.

This tab presents a list of projects that are published on the server and allows the user to delete a project or change the owner of any project in the list.

To delete a project, select it from the list and press Delete.

To change the owner of a project, select it from the list then press Change owner. In the Change Owner dialog window, in the Client settings fields, enter the IP of the computer of the new owner and the workspace that is to be used. Alternatively you can select Use active client and select one of the existing clients already defined. After you defined or selected the new owner, click Change owner.

Update Rights Tab

This tab allows the user to select the user that has update rights for the projects that are published on the server.

Select the Update Rights tab from the Server Manager dialog window.

A user with update rights has access to the Update project function from IBM AD Analyze Client. If a user does not have update rights, the Update project function is not visible in the pop-up menu of the project.

Note that there can be only one user with update rights.
**Server Requests Tab**

This tab presents lists of requests that are sent by the clients to the server.

Select the **Server requests** tab from the Server Manager dialog window.

A list of requests that are sent by the clients to the server is displayed, grouped into Active, Blocked, and Not Started requests. It allows the user to select a request and then use **Stop** to display information in the output window about the selected active request, but NOT to stop processing the request. Also, information about a request from output window can be obtained by double-clicking the active request.

**Project Database Tab**

This tab presents a list of project databases for projects that are shared on server.

Select the **Project Database Access** tab from Server Manager dialog window.

From this tab, you can either restrict access to the databases that are public, or you can make public the databases with restricted access. To restrict access to a database, put a mark in the corresponding checkbox. To make a database public, remove the check mark.

Double-click a database from the list to select it. The Projects from database and Details for database windows are populated with the corresponding data. You can view the projects that share the selected database and also the database details entered when the database was created.
Appendix 1 - Log Files Location

IBM AD Analyze Server

The log files for IBM AD Analyze Server are available at the locations that are listed below and have the following name format.

<Installation Path>\Log\log_service\  
- ezservice-daemon.<date>.log  
- ibmapplicationdiscoveryanalyzeservice-stderr.<date>.log  
- ibmapplicationdiscoveryanalyzeservice-stdout.<date>.log

<Installation Path>\Log\manager  
- .log  
- .log.<date>.log

IBM AD Analyze Client

The log files for IBM AD Analyze Client are available at the locations that are listed below and have the following name format.

<Local Workspace>\.metadata\.ez\log  
- ez.log  
- ez.log.<date>.log

<Local Workspace>\.metadata  
- .log

To change the default location of the log files, use the Log folder option in the General settings tab from the Preferences dialog window. For details, see General Settings.
Following is an example of how a file that contains rules for Rule Based Analysis must look like.

```plaintext
##for comments, use # at the beginning of the line. Lines with comments are ignored
##<number>: positive integer
##<identifier>: alphanumeric_text_with_0_spaces
##<path>: absolute path to a file on disk
##<class>: qualified class name for a rule
##<text>: any string of characters on one line. Line continuation (single backslash at the end of line) can be used for multiple lines
##{key}: the value of the key as found in the file.
##[] in key names means optional

#include.id = <number : larger than 0>
#include.key = <identifier>
#include.path = <path : an include file>

##input definition
##inputs are optional

#<input.id>.input.key = <identifier>
#<input.id>.input.name = <text : param name in gui>
#<input.id>.input.query = <path : to query file>
#<input.id>.input.firstColumnType = <numeric|string>
1.input.key = CobolPrograms
1.input.name = Cobol Programs
1.input.query = C:\Rules\CobolPrograms.txt
1.input.firstColumnType = numeric

##param definition
##parameters are optional
##if .query exists, .pattern is not used
##if .pattern not exists, default is unbound text

#<param.id>.param.key = <identifier>
#<param.id>.param.name = <text : param name in gui>
#<param.id>.param.default.value = <value>
#<param.id>.param.[pattern] = <pattern>
#<param.id>.param.[length] = <number>
#<param.id>.param.[value.greaterThan] = <number>
#<param.id>.param.[prefix] = <text : prefix for the chosen value>
#<param.id>.param.[suffix] = <text : suffix for the chosen value>
1.param.key = MaxINITIALIZESize
1.param.name = Max INITIALIZE record size
1.param.default.value = 3000

##group definition
##groups are optional

#<group.id>.group.name = <text : group name in gui>
#<group.id>.group.[parent] = [0|{include.key}]:{group.id}
#<group.id>.group.[description] = <text : group description in gui>

##rule definition
##at least one of .class or .query must exist
##.query and .selectiveQuery can be used together for efficiency reasons.
## Only one is executed depending on user selection

#<rule.id>.rule.name = <identifier: rule name>
#<rule.id>.rule.[sourceBased] = true|false (default true)
#<rule.id>.rule.[weight] = <number> (default 1)
#<rule.id>.rule.[query] = <path : to query file> (default none)
#<rule.id>.rule.[selectiveQuery] = <path : to selective query file> (default none)
#<rule.id>.rule.[class] = <class> (default none)
#<rule.id>.rule.[groups] = [0|{include.key}]:{group.id}[, [0|{include.key}]:{group.id}]* (default none)
#<rule.id>.rule.[description] = <text: rule description> (default none)
#<rule.id>.rule.[params] = [0|{include.key}]:{param.key}[, [0|{include.key}]:{param.key}]* (default none)
```
# Groups

10.group.name=Performance Rules
10.group.description=These rules look up potential performance issues in the code

100.rule.groups=10
100.rule.name=INITIALIZE of large records
100.rule.description=INITIALIZE of very large records consumes a lot of CPU, consider the alternative of using a direct MOVE
100.rule.sourceBased=true
100.rule.query=C:\Rules\InitializeRule.txt
100.rule.weight=1
100.rule.inputs=CobolPrograms
100.rule.params=MaxINITIALIZESize

Following are two examples of how the files that contain SQL queries must look like.

The query in the following example brings data for the rule "INITIALIZE of large records" from previous the example.

**SQL Query Example:**

```
SELECT DISTINCT TOP (100) PERCENT dbo.Programs.ProgramID, dbo.Programs.ProgramName,
          dbo.Paths.PathStr,
          dbo.OccurrencesStmt.StartRow, ISNULL
          ((SELECT     0 AS Expr1
             WHERE     (dbo.OccurrencesStmt.SourceType < 4)), - 1) AS IsCopy
FROM         dbo.StatementReference INNER JOIN
             dbo.OccurrencesStmt ON dbo.StatementReference.OccurID =
             dbo.OccurrencesStmt.OccurID INNER JOIN
             dbo.Programs ON dbo.OccurrencesStmt.ProgID = dbo.Programs.ProgramID INNER
             JOIN
             INNER JOIN
             = 4) AND
(dbo.Variables.VarSize > {MaxINITIALIZESize}) AND
(dbo.Programs.ProgramID in ({CobolPrograms:-1}))
```

Following is an example of an input query for AllPrograms, as it is defined in the .properties file.

**Input query for AllPrograms Example.**

```
SELECT     TOP (100) PERCENT ProgramID, ProgramName
FROM         dbo.Programs
WHERE     (OccurID > 0) AND (ProgramTypeID = 1)
ORDER BY ProgramName
```
## Appendix 3 - Log Configuration Files Example

LogConfigurator.properties allows the user to customize the amount of details that is generated about errors. LogConfigurator.properties is created by the user, is fully configurable, and must be placed in Eclipse's workspace folder as in: `<Local Workspace>\.metadata\.ez`.

Following is an example of a LogConfigurator.properties file.

<table>
<thead>
<tr>
<th>com.ez=info</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.ez.graphs.viewer.odb=debug</td>
</tr>
</tbody>
</table>

Following is an example of a Log4j.properties file.

```properties
log4j.rootLogger=info, stdout, R
log4j.appenders.stdout=org.apache.log4j.ConsoleAppender
log4j.appenders.stdout.layout=org.apache.log4j.PatternLayout
log4j.appenders.stdout.layout.ConversionPattern=%-5p %d [%t] %c - %m
log4j.appenders.R=com.ez.log4j.appenders.EZRollingFileAppender
log4j.appenders.R.FileName=/log/ez.log
log4j.appenders.R.MaxFileSize=100MB
log4j.appenders.R.MaxBackupIndex=10
log4j.appenders.R.layout=org.apache.log4j.PatternLayout
log4j.appenders.R.layout.ConversionPattern=%-5p %d [%t] %c - %m
log4j.logger.com.googlecode.protobuf.pro=info
log4j.logger.EZSourceConnectionService=error
log4j.logger.Unknown=error
log4j.logger.org.apache.zookeeper=error
log4j.logger.com.ez=info
```
Documentation Notices for IBM Application Discovery for IBM Z

This edition applies to version 5.1.0 of IBM Application Discovery for IBM Z with the corresponding fix packs.


This information was developed for products and services offered in the US. This material might be available from IBM in other languages. However, you may be required to own a copy of the product or product version in that language in order to access it.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service. IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8919, Japan

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM websites are provided for convenience only and do not in any manner serve as an endorsement of those websites. The materials at those websites are not part of the materials for this IBM product and use of those websites is at your own risk.

IBM may use or distribute any of the information you provide in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

Statements regarding IBM’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM’s suggested retail prices, are current and are subject to change without notice. Dealer prices may vary. This information is for planning purposes only.

The information herein is subject to change before the products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to actual people or business enterprises is entirely coincidental.

COPYRIGHT LICENSE: This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work must include a copyright notice as follows: © (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs. © Copyright IBM Corp. _enter the year or years_.

**Trademarks**

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the web at "Copyright and trademark information" at http://www.ibm.com/legal/copytrade.shtml.